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Allgemeine Informationen 1
Das Benutzerhandbuch für Fortgeschrittene stellt Informationen über die Funktionen der
Analyst MD Software zur Verfügung.

Analyst MD Software-Ereignisse
Das Systemprotokoll enthält Berichte über Systemereignisse wie Fehlermeldungen,
Warnhinweise und Benachrichtigungen. Verwenden Sie den „Windows Event Viewer“,
um Informationen anzuzeigen, die bei der Fehlersuche und bei der Durchführung einer
Systemdiagnose hilfreich sein könnten. Um die Informationen aus dem Systemprotokoll
wirksam einzusetzen, filtern Sie diese Informationen so, dass nur die softwarerelevanten
Elemente angezeigt werden.

Filtern des Systemprotokolls nach
Informationen, die für die Analyst MD Software
relevant sind
1. Klicken Sie auf View > Event Log.

Das Dialogfeld „Event Viewer“ wird geöffnet.

2. Doppelklicken Sie auf den Ordner Windows Logs.

3. Klicken Sie auf Application.

4. Klicken Sie auf Action > Filter Current Log.
Das Dialogfeld „Filter Current Log“ wird geöffnet.

5. Wählen Sie Analyst im Feld Event Sources aus.

6. Klicken Sie auf OK.
Das Dialogfeld „Event Viewer“ zeigt jetzt nur die gefilterten Analyst MD Software-
Ereignisse an.
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Analyst MD Software-Fenster
Abbildung 1-1: Analyst MD Software-Fenster

Element Beschreibung

1 Navigationsleiste: Die Navigationsleiste ermöglicht den Zugriff auf die
verschiedenen Software-Modi. Benutzer können einige Elemente der
Navigationsleiste entsprechend ihren Vorlieben anpassen. Benutzer
können zum Beispiel die Größe und Position verändern. Um die
Navigationsleiste auszublenden, klicken Sie auf das X rechts oben. Um
die Navigationsleiste anzuzeigen, klicken Sie auf View > Navigation
Bar.

Auf oberster Ebene des Navigationsbaums befindet sich ein Symbol,
das für die Software-Modi steht. Doppelklicken Sie auf das Symbol
eines bestimmten Modus, um die Baumansicht ein- oder auszublenden.
Dadurch werden die Symbole der verfügbaren Funktion im ausgewählten
Modus ein- oder ausgeblendet.

2 Menüleiste: Ändert sich abhängig vom Modus. Einige Optionen wie
Ausschneiden Kopieren und Einfügen, sind in jedem Modus identisch.
Andere Optionen sind dagegen nur in bestimmten Modi verfügbar.

3 Modusliste: Anklicken, um zwischen Modi umzuschalten. Die
verschiedenen Modi verfügen über unterschiedliche Symbole in der
Werkzeugleiste.
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Element Beschreibung

4 Projektliste: Anklicken, um das Projekt zu ändern, in dem die Daten
gespeichert sind.

5 Status von Instrumenten und Peripheriegeräten: Die Statusleiste
enthält Informationen über die aktuellen Aktivitäten. Sie gibt den
Instrumentenzustand mit Farbkennung an: grün (bereit), gelb (Leerlauf),
rot (Fehler) oder weiß (keine lokale Instrumenten-Workstation). Das
Symbol zeigt den Status eines Remote-Instruments an. Doppelklicken
Sie auf ein Symbol, um das Gerätestatus-Fenster zu öffnen.

6 Companion-Software: Umfasst jede installierte Companion-Software, die
mit der Software geöffnet wird.

Analyst MD Software-Modi
Die Software ist in Modi unterteilt. Dies sind eigenständige Funktionsbereiche, die Benutzer
zur Durchführung einer Vielzahl an Aktivitäten, die Teil einer Hauptaufgabe sind, nutzen
können. Benutzer können über die Navigationsleiste oder über die Modusliste in der
Werkzeugleiste auf die Modi zugreifen sowie von einem Modus zum anderen wechseln,
ohne Arbeitsergebnisse zu verlieren.

Tabelle 1-1: Modi in der Analyst MD-Software

Name Beschreibung

Configure (Konfigurieren) Verwenden Sie diesen Modus zum Konfigurieren
von Geräten und Systemeinstellungen. Legen Sie verschiedene
Softwareoptionen und -parameter fest, einschließlich der
Hardwarekonfiguration und Berichtsvorlageneinstellungen.

Tune and
Calibrate

(Abstimmen und Kalibrieren) Verwenden Sie diesen Modus zum Festlegen
von Abstimmungsoptionen für die Instrumente, um optimale Ergebnisse
sicherzustellen. In diesem Modus können Benutzer Folgendes tun:

• Instrumentenoptimierung durchführen

• manuelle Abstimmung durchführen

• das Erscheinungsbild der graphischen Ansichten ändern, die
Informationsarten auswählen, die angezeigt werden, wenn
Dateiinformationen geöffnet werden und Verbindungs- und andere
Ansichtsoptionen festlegen.

• Verarbeitungsoptionen ändern
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Tabelle 1-1: Modi in der Analyst MD-Software (Fortsetzung)

Name Beschreibung

Acquire (Erfassen) Verwenden Sie diesen Modus, um zu entscheiden, wie Proben
erfasst werden sollen. In diesem Modus können Benutzer Folgendes tun:

• eine IDA-Erfassungsmethode mit dem „IDA Method Wizard“ erstellen.

• eine Erfassungsmethode mit dem „Acquisition Method Editor“ erstellen

• eine Charge mit dem Batch Editor erstellen

• die Warteschlange mit dem „Queue Manager“ anzeigen

• den Erfassungsstatus überwachen

Explore (Durchsuchen) Verwenden Sie diesen Modus zum Durchführen qualitativer
Analysen an Proben. In diesem Modus können Benutzer Folgendes tun:

• ein Diagramm anzeigen lassen

• eine Chromatogramm anzeigen lassen

• ein Spektrum anzeigen lassen

• Daten in Echtzeit während der Chargen-Erfassung anzeigen lassen

Quantitate (Quantifizieren) Verwenden Sie diesen Modus, um die erfassten Daten zu
analysieren, und erstellen Sie eine quantitative Methode zur Erzeugung
einer „Results Table“. Verwenden Sie die „Results Table“, um alle Peaks für
jeden Analyten und internen Standard innerhalb einer Charge zu überprüfen
und um sich Kalibrierungskurven, Probenstatistiken und metrische Kurven
anzusehen.

AnalystService
Der AnalystService ist der Kommunikationspfad zwischen dem Massenspektrometer und den
angeschlossenen Geräten. AnalystService wird jedes Mal gestartet, wenn die Analyst MD
Software gestartet wird. Der AnalystService startet automatisch, wenn sich der Benutzer bei
Windows anmeldet. Wenn der Dienst bei Start der Analyst MD Software nicht ausgeführt
wird, dann startet AnalystService automatisch.

Starten des AnalystService
Wenn „Startup Type“ für den AnalystService auf Manual eingestellt ist, muss AnalystService
manuell gestartet werden, bevor die Analyst MD Software gestartet wird. Ändern Sie nicht
den Startup Type.

1. Öffnen Sie die Administrative Tools.

2. Doppelklicken Sie auf Services und dann auf AnalystService.

3. Klicken Sie auf Start.
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Beenden des AnalystService
Beenden Sie den AnalystService, wenn Kommunikationsstörungen im Gerät oder zwischen
Gerät und Peripheriegeräten auftreten.

1. Öffnen Sie die Administrative Tools.

2. Doppelklicken Sie auf Services und dann auf AnalystService.

3. Klicken Sie auf Stop.

API-Instrument-Projektordner
Nachstehend sind einige Ordner des API-Instrument-Projekts aufgeführt:

• Bundler: Enthält ein Programm, das alle Aspekte einer Datendatei (wiff-Datei) aufnimmt
und diese automatisch verbindet, wenn die Probe abgeschlossen ist.

• Configuration: Enthält alle Hardware-Profile (hwpf-Dateien).

• Instrument Data: Enthält eine Datei mit dem Namen InstrumentData.ins. In der
Datei werden alle kritischen Kalibrierungsinformationen und Weiteres gespeichert.

• Method Tables: Enthält alle Instrumentenparameter, die die erweiterten Scan-Funktionen
definieren. Nehmen Sie keine Änderungen an den Dateien in diesem Ordner vor.
Eine Änderung des Inhalts dieses Ordners hat eine Auswirkung auf die Leistung der
erweiterten Scan-Modi.

• Parameter Settings: Enthält alle Instrumentenparameter und -verbindungen. Die
Instrumentenparameter werden in ParamSettingsdef.psf-Dateien gespeichert.

• Preferences: Enthält die Tunedata.tun-Datei. Alle Einstellungen (einschließlich
Parameter, Abstimmung, Instrument, Verarbeitung, Anzeige und Warteschlange) werden
als Tunedata.tun in diesem Ordner gespeichert.

• Processing Scripts: Enthält die Skripte für die Datenverarbeitung im Modus „Explore“.
Skripte sind im Script-Menü zu finden.

• Queue Data: Enthält Informationen aus der Warteschlange.

• Tuning Cache: Enthält alle Daten, die in „Manual Tuning“ durch Klicken auf Start anstatt
auf Acquire erstellt wurden. Die Dateien werden mit einem Zeit- und Datumsstempel
für ihre Namen gespeichert. Der Ordner „Tuning Cache“ enthält eine begrenzte Anzahl
an Dateien und wird Dateien bei Bedarf überschreiben. Speichern Sie die Dateien unter
einem neuen Namen und verschieben Sie die Dateien, sobald diese gespeichert werden
müssen.

Programmdateien
Die folgenden Ordner befinden sich im Ordner Program Files\Analyst beim
Betriebssystem Windows 7, 32-Bit-Version, oder im Ordner Program Files
(x86)\Analyst beim Betriebssystem Windows 7, 64-Bit-Version, bzw. Windows 10, 64-Bit-
Version.
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• bin: Enthält die Analyst MD Software-Programm-Dateien. Der Inhalt dieses Ordners sollte
nicht geändert werden, da sonst die Funktionalität der Software beeinträchtigt wird.

• binEx2: Enthält die Komponenten, die zur Steuerung von ExionLC 2.0-Geräten
erforderlich sind.

• binEx: Enthält die Komponenten, die erforderlich sind zur Steuerung von ExionLC, Jasper
und Shimadzu LC20/30-Geräten, die mit dem Integrated System Shimadzu LC-20/30
Controller gesteuert werden und Shimadzu LC40-Geräten. beeinträchtigt wird.

• Firmware: Enthält die Firmware- und Konfigurationstabellen-Dateien des Geräte-Systems
und die Firmware-Dateien des Geräts. Weitere Informationen finden Sie im Software-
Installationshandbuch, das der Software beiliegt.

• Hilfe: Enthält die Hilfedatei, Handbücher, Tutorials, Versionshinweise und das Software-
Installationshandbuch.

• Scripts: Enthält die Skripte, die der Benutzer gegebenenfalls installieren kann. Diese
Skripte sind nicht automatisch installiert, wenn die Analyst MD-Software installiert ist.
Weitere Informationen finden Sie im Dokument: Skripthandbuch.

• Simulation: Enthält die Geräte-Datendateien, die erforderlich sind, um die Software im
Simulationsmodus auszuführen.

Projekte und Teilprojekte
Entscheiden Sie, bevor Sie ein Experiment beginnen, wo die Dateien für das Experiment
gespeichert werden sollen. Verwenden Sie Projekte und Teilprojekte für jedes Experiment,
um die Daten besser zu verwalten und Ergebnisse miteinander zu vergleichen. Zum Beispiel
können Ergebnisse für bestimmte Daten in Teilprojekten gespeichert werden.

Hinweis: Um eine Teilprojekt-Struktur in einem Projekt zu verwenden, muss bei der
Erstellung des Projekts mindestens ein Teilprojekt angelegt werden. Benutzer können ein
Teilprojekt nur in einem bestehenden Projekt anlegen, wenn dieses bereits eine Teilprojekt-
Struktur hat.

Teilprojekte
Ein Teilprojekt enthält eine Teilmenge der Ordner in einem Projekt. Alle Teilprojekte müssen
die gleichen Ordner enthalten. Teilprojekte dienen der Organisation von Daten.

Wenn Sie z. B. Proben verschiedener Verbindungen aus verschiedenen Laboratorien mit
der gleichen Erfassungsmethode verarbeiten, dann legen Sie Teilprojekte zum Speichern
der Ergebnisse für jedes Labor an, ohne den Erfassungsmethoden-Ordner aus dem Projekt
zu entfernen. Die Erfassungsmethode ist dann zur Verwendung für das Teilprojekt oder im
Labor verfügbar. Oder es können die Ergebnisse für jeden Tag in einem separaten Teilprojekt
gespeichert werden, wenn die Proben über einen Zeitraum von mehreren Wochen analysiert
werden. Siehe die folgende Abbildung.
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Abbildung 1-2: Beispiel für eine Projekt- und Teilprojekt-Ordner-Struktur

Projektorganisation
Ein Projekt ist eine Ordnerstruktur zur Organisation und Speicherung von
Probeninformationen, Daten, Quantifizierungsinformationen usw. Innerhalb jedes Projektes
gibt es Ordner, die verschiedene Arten von Dateien enthalten können. Zum Beispiel
enthält der Ordner Dateien mit Erfassungsdaten. In der folgenden Tabelle finden Sie eine
Beschreibung der Inhalte der verschiedenen Ordner.

Die Software kann auf ein Projekt nur dann zugreifen, wenn es in einem Stammordner
gespeichert ist. Benutzer können Projekte nur in Ordnern erstellen, die als Stammordner
definiert wurden.

Der voreingestellte Stammordner heißt „Analyst Data“ auf dem Laufwerk, auf dem die
Software installiert wurde. Wenn Sie Projekte an anderen Speicherplätzen speichern
möchten, müssen Sie neue Stammordner erstellen. Weitere Informationen über
Stammordner finden Sie im Dokument: Hilfe.
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Tabelle 1-2: Projektordner

Ordner Inhalt
\Acquisition
Methods

Enthält alle verfügbaren Erfassungsmethoden. Die
Erfassungsmethoden-Dateien haben die .dam-Erweiterung.

\Acquisition
Scripts

Erfassungsskripte sind in der Analyst MD Software nicht
verfügbar. Dieser Ordner ist leer.

Das Analyst MD „Software Scripting“, mit dem
benutzerdefinierte Skripte (benutzerdefinierte Sequenzen für
den Analyst-Betrieb) erstellt werden können, sollte nicht
als Teil eines In-Vitro-Diagnostik-Systems verwendet werden.
Inhärente Software-Prüfungen, die bei der Arbeit mit der
Analyst MD Software durchgeführt werden, werden bei
benutzerdefinierten Skripten nicht ausgeführt und können dazu
führen, dass Ergebnisse mit Proben-IDs fehlerhaft verknüpft
werden.

\Batch Enthält alle verfügbaren Erfassungschargendateien.
Erfassungschargendateien haben die .dab-Erweiterung.
Dieser Ordner enthält außerdem einen Unterordner
namens „Templates“ mit Erfassungschargen-Vorlagen.
Chargenvorlagendateien haben die .dat-Erweiterung.

\Data Enthält die Dateien der Erfassungsdaten mit der .wiff-
Erweiterung.

\Log Enthält die Ergebnisse von Quantifizierungen und
Verbindungsoptimierungen.

\Processing Methods Enthält alle verwendeten qualitativen
Datenverarbeitungsmethoden.

\Processing Scripts Enthält die Datenverarbeitungsskripte. Die Verarbeitung von
im „API Instrument“-Projekt gespeicherten werden im Menü
ScriptsScripts angezeigt.

\Project
Information

Enthält alle Projektinformationen und -einstellungen. Dieser
Ordner kann nicht in einem Teilprojekt gespeichert werden.

\Quantitation
Methods

Enthält alle verwendeten Quantifizierungsmethoden mit
der .qmf-Erweiterung.

\Results Enthält alle Dateien mit Quantifizierungs-„Results Tables“ mit
der .rdb-Erweiterung.

\Templates Enthält Berichtsvorlagendateien mit der .rpt-Erweiterung.
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Zugriff und Sicherheit
Die Analyst MD-Software arbeitet mit den Sicherheits-, Anwendungs- und System-
Ereignisüberüberprüfungskomponenten der Administrative Tools von Windows zusammen.

Zusätzlich verfügt die Software über eine Vielzahl an Funktionen zum Konfigurieren und
Verwalten der Sicherheit. Der Softwareadministrator kann:

• den Sicherheitsmodus wählen, der am besten für die Arbeitsumgebung geeignet ist

• Benutzer und Funktionen hinzufügen und löschen

• bei Bedarf Zugriffsrechte für Benutzer und Funktionen einstellen

• den Zugriff auf Remote-Massenspektrometer kontrollieren

• den Zugriff auf Projektdateien kontrollieren.

Weitere Informationen über die Sicherheit der Software finden Sie im Dokument: Handbuch
für Laborleiter.

Hinweis: Änderungen der Software-Sicherheitskonfiguration werden nach dem Neustart der
Software wirksam.

Arbeitsbereiche
Ein Arbeitsbereich ist eine bestimmte Anordnung von Fenstern und Feldern, die alle
zugehörigen Dateien umfasst. Beispiel: Bei der Arbeit an einem bestimmten Datensatz
können Benutzer verschiedene Fenster öffnen und deren Größe ändern, um die Analyse
zu erleichtern. Diese Anordnung bzw. dieser Arbeitsbereich kann gespeichert werden, damit
die Fensteranordnung das nächste Mal, wenn der Benutzer die Daten betrachtet, identisch
ist.

Benutzer können einen Arbeitsbereich individuell anpassen, indem sie die gewünschten
Fenster und Teilfenster für einen Arbeitsbereich auswählen. Benutzer können die Größe
und Position der Fenster und Teilfenster ändern, Teilfenster zusammenfügen und bestimmte
Teilfenster und Fenster ausblenden oder einblenden. Auf diese Weise können Benutzer
einen Arbeitsbereich so anpassen, dass dieser sich für die gestellten Aufgaben eignet.

In Quantitate and Explore modes stehen den Benutzern mehrere Arbeitsbereiche pro Sitzung
zur Verfügung. Der Benutzer kann einen Arbeitsbereich speichern, der auch die zugehörigen
Daten enthält. In einem dieser beiden Modi kann ein bestimmter Arbeitsbereich geöffnet
werden, ohne den jeweiligen Modus zu verlassen. Um eine bestimmte Anordnung von
Fenstern und Teilfenstern für andere Datensätze wiederzuverwenden, können Benutzer
einen Arbeitsbereich als Vorlage speichern. In den Modi „Tune and Calibrate“ oder „Acquire“
speichert die Software den Arbeitsbereich automatisch.

Allgemeine Informationen
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Ziel Aufgabe

Einen
Arbeitsbereich
erstellen

1. Klicken Sie auf der Navigationsleiste auf den Modus, in dem der
Arbeitsbereich erstellt werden soll.

2. Öffnen Sie die Fenster und Teilfenster, die in den Arbeitsbereich
einbezogen werden sollen, und ordnen Sie sie dann auf dem
Bildschirm an, indem Sie Fenster verbinden und die Größe der
Fenster und Teilfenster entsprechend anpassen.

3. Klicken Sie auf File > Save Workspace.

4. Geben Sie in das Feld File name einen Dateinamen für den
Arbeitsbereich ein.

Hinweis: Arbeitsbereichname und -pfad dürfen zusammen 255
Zeichen nicht überschreiten. Dem Arbeitsbereichnamen folgt ein
Punkt und die Erweiterung .wws, um anzugeben, dass es sich um
eine Workstation-Datei handelt.

5. Klicken Sie auf Save.

Die Arbeitsbereich-Informationen werden in einer Datei mit der
Erweiterung .wws im angegebenen Verzeichnis gespeichert.

Öffnen eines
Arbeitsbereichs

In den Modi „Quantitate“ und „Explore“ können verschiedene
Arbeitsbereiche geöffnet werden, ohne den aktuellen Modus zu
verlassen.

1. Klicken Sie auf File > Open Workspace.

2. Wählen Sie die entsprechende Arbeitsbereich-Datei aus der Liste
aus und klicken Sie dann auf OK.

Speichern eines
Arbeitsbereichs

1. Stellen Sie im Modus „Quantitate“ oder „Explore“ sicher, dass der
Arbeitsbereich aktiv ist.

2. Klicken Sie auf File > Save Workspace As.

Tipp! Klicken Sie auf Save Workspace, um die Arbeitsbereich-
Informationen mit dem aktuellen Dateinamen und Speicherort zu
speichern.

3. Geben Sie einen Namen für die Arbeitsbereich-Datei ein und klicken
Sie auf Save.

Die Software speichert die Fenster- und Teilfenster-Informationen
automatisch als Teil des mit dem aktuellen Modus verbundenen
Arbeitsbereichs. In Modi „Configure“, „Tune and Calibrate“ oder
„Acquire“ speichert die Software den Arbeitsbereich automatisch,
wenn der Benutzer den aktuellen Modus schließt.
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Ziel Aufgabe

Sperren der
Software 1. Klicken Sie auf der Werkzeugleiste auf Lock Application .
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Modus „Tune and Calibrate“ 2
Durch die Abstimmung und Kalibrierung des Massenspektrometers wird die Auflösung und
Intensitätsleistung maximiert.

Die folgenden Aufgaben können während der Abstimmung ausgeführt werden:

• Passen Sie die Offset-Werte der Auflösung an, um die Intensität und Auflösung der
Kalibriermassen (nur für den Quadrupol-Modus) einzustellen.

• Wählen Sie die zu kalibrierenden Massen. Bei Bedarf können Massen zu und aus der
Kalibrierliste hinzugefügt bzw. entfernt werden.

• Erstellen Sie einen oder mehrere eindeutige Kalibrierstandard-Sets. Ein Kalibrierstandard-
Set sollte mindestens zwei Verbindungen für die niedrigen und hohen Werte des
relevanten Massenbereichs haben.

Ein abgestimmtes und kalibriertes Instrument kann die angegebene Peak-Auflösung
und Masse-Zuordnung der Probe feststellen. Zu diesem Zweck wird ein bekannter
Kalibrierungsstandard verwendet, z. B. PPG (Polypropylenglykol). Ein Kalibrierungsstandard
wird verwendet, um die Massenskala zu kalibrieren, um die Ziel-Ionen so nah wie
möglich an ihrem exakten Masse-zu-Ladungs-Verhältnis innerhalb einer akzeptablen
Masseverschiebung zu ermitteln. Benutzer können nicht nur den exakten Peak identifizieren,
sondern auch die Auflösung anpassen, um die optimale Peak-Breite und -Form zu erhalten.

Ein ordnungsgemäß abgestimmtes und kalibriertes Massenspektrometer liefert das beste
Ergebnis für alle im Massenspektrometer analysierten Proben oder Verbindungen.
Abstimmung und Kalibrierung werden zusammen durchgeführt, unabhängig von der
Optimierung. Bei der Abstimmung und Kalibrierung liegt der Fokus auf der Auflösung und
Massenkalibrierung. Bei der Optimierung liegt der Fokus auf der Empfindlichkeit.

Änderungen an der Konfiguration des Massenspektrometers während der Abstimmung
und Kalibrierung werden in Datendateien im Ordner „API Instrument“ gespeichert. Die
voreingestellten Parameter im Ordner „API Instrument Method“ sollten verwendet werden,
da sie vom SCIEX Außendienstmitarbeiter (FSE) während der Installation optimiert wurden.

Nach der Abstimmung und Kalibrierung wird die Systemleistung maximiert und die
angegebenen Parameter werden die Standardparameter für alle Experimente. Benutzer
können Experimente mit den optimierten Quellen- und Verbindungs-abhängigen Parametern
durchführen, um die Reaktion aller Analyten maximieren.

Tipp! Reinigen Sie den Q0-Bereich regelmäßig, um die Auswirkungen von Aufladungen
(erheblicher Verlust der Empfindlichkeit der betreffenden Ionen über einen kurzen Zeitraum)
an den Quadrupolen zu minimieren. Siehe das Dokument: Handbuch für qualifizierte
Wartungstechniker.

Benutzer können das Instrument entweder automatisch oder manuell abstimmen und
kalibrieren.
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Automatische Abstimmung: Die Software führt mit dem Instrument Optimization-
Assistenten eine Auflösungsoptimierung und Massenkalibrierung durch. Für Instrumente mit
linearer Ionenfalle (LIT-Instrumente) werden auch MS3-Optimierungen durchgeführt.

Manuelle Abstimmung: Benutzer können viele der Optimierungen und Kalibrierungen der
Instrumentenauflösung manuell durchführen.

Tuning
Durch die Abstimmung des Massenspektrometers werden die Auflösung und
Geräteparameter optimiert, um die beste Sensitivität und Leistung des Massenspektrometers
zu erzielen. Das Massenspektrometer sollte in regelmäßigen Abständen abgestimmt
und kalibriert werden, oder, wenn die Systemleistung nachlässt. Optimieren Sie das
Massenspektrometer, um die Reaktion einer neuen Probe oder Verbindung zu maximieren.
Durch die Optimierung der Auflösung werden Peak-Breite und Peak-Form angepasst.

Kalibrierung
Massenkalibrierung ist das Verfahren, bei dem Massenpeaks die richtigen Masse-zu-
Ladung-Werte (m/z) zugeordnet werden. Wenn eine Massenkalibrierung mithilfe eines
Kalibrierungsstandards, z. B. Polypropylenglykol (PPG), durchgeführt wird, dann können die
Ergebnisse mit einer vorhergehenden Kalibrierung verglichen werden, um zu bestimmen,
wie nahe die m/z-Werte der beobachteten Peaks an den theoretischen Werten liegen.
Die vorhergehende Kalibrierung kann aktualisiert, oder, noch typischer, durch die neue
Kalibrierung ersetzt werden.

Wählen Sie mehrere Massen beim Kalibrieren von Q1, Q3 und bei allen LIT-Scans
für jede Polarität. Die Ergebnisse werden in einer Kalibriertabelle gespeichert. Wenn
eine Massenkalibrierung durchgeführt wird, dann wird die Kalibriertabelle mit neuen DAC
(Digital-Analog-Wandler)-Werten aus der neuen Kalibrierung oder Massen aktualisiert, die
bereits in der Kalibrierungstabelle vorhanden sind. Alle Daten für diejenigen Massen,
die in der aktuellen Kalibrierung nicht kalibriert werden, werden beibehalten. Wenn die
Massenkalibrierung ersetzt wird, werden alle vorherigen Kalibrierwerte für alle Massen
ersetzt. Führen Sie eine Massenkalibrierung mit einem neu erfassten Spektrum durch oder
verwenden Sie ein Spektrum aus einer gespeicherten Datei.

Automatische Abstimmung und Kalibrierung
„Instrument Optimization“ ist eine automatische Instrument Tuning-Software, die sowohl
Quadrupol- als auch LIT-Modi abstimmt und Massenkalibrierungen durchführt. Für den
Quadrupol-Modus passt sie die Auflösungs-Offsets an. Für den LIT-Modus optimiert sie AF3
und EXB. Für MS3 passt sie die Anregungs- und Isolations-Koeffizienten an. Wählen Sie
eine der folgenden Instrument-Performance-Optionen:

• Verify instrument performance: Testet die Leistung des Geräts, lässt aber die
Geräteeinstellungen unverändert. Ein Bericht wird am Ende des Tests erzeugt.
Verwenden Sie diese Option wöchentlich, um zu überprüfen, wie gut das Gerät
funktioniert.
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• Adjust mass calibration only: Überprüft und passt die Massenkalibrierung automatisch
an. Wurde die Massenkalibrierung geändert, dann wird durch die Software eine Korrektur
vorgenommen.. Verwenden Sie diese Option für LIT-Instrumente wöchentlich oder
monatlich, um die Massenkalibrierung zu überprüfen und gegebenenfalls anzupassen.

• Adjust instrument settings: Prüft die Geräteeinstellungen und Massenkalibrierung
und passt diese an. Die Geräteeinstellungen werden aus den aktuellen Einstellungen
auf die optimalen Einstellungen aktualisiert. Verwenden Sie diese Option, wenn
die Geräteleistung oder die Peakform schlecht ist. Nur erfahrene Benutzer sollten
Geräteeinstellungen anpassen.

Hinweis: Alte LIT-Methoden müssen mit den neuen Einstellungen aktualisiert werden.
Schalten Sie die LIT-Geschwindigkeit in der „Advanced MS“-Registerkarte um und
speichern dann diese Methode.

• Reset selected scan modes to default values and adjust instrument settings: Setzt
die Instrumenten-Werte auf die Werkseinstellungen zurück. Wählen Sie diese Option,
wenn ein wichtiger Bestandteil des Gerätes ausgewechselt wurde, oder nach der ersten
Installation. Nur Außendienstmitarbeiter sollten diese Funktion verwenden.

Manuelles Sichern der Geräteparameter
(optional)
Sichern Sie die aktuellen Geräteparameter, um diese gegebenenfalls wiederherzustellen.
Der voreingestellte Speicherort für die manuell gesicherten Geräteparameter
ist <drive>:\Analyst Data\Projects\API Instrument\Instrument
Optimization\Instrument Settings Backups\User Created Backups.

1. Doppelklicken Sie in der Navigationsleiste unter Tune and Calibrate auf Instrument
Optimization.

2. Klicken Sie auf File > Backup Instrument Settings.

3. Geben Sie einen Dateinamen ein.

4. Klicken Sie auf Save.

Wiederherstellen der Geräteparameter
(optional)
1. Doppelklicken Sie in der Navigationsleiste unter Tune and Calibrate auf Instrument

Optimization.

2. Klicken Sie auf File > Restore Instrument Settings File.

3. Navigieren Sie zu den Geräteeinstellungen, um diese wiederherzustellen.

4. Klicken Sie auf Open.
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Verbindungsoptimierung
Der Software-Assistent für die Verbindungsoptimierung führt eine automatische Optimierung
der Analyten durch. Proben können mittels Infusion oder FIA (Flussinjektionsanalyse)
eingefügt werden. Die Software prüft zunächst das Vorhandensein der Verbindungen.
Die Spannungen der verschiedenen Ionenbahn-Parameter werden allmählich erhöht oder
verringert, um die maximale Signalstärke (Q1 Scan) für jedes Ion zu bestimmen. Eine
Textdatei wird erzeugt und anschließend während des Optimierungsprozesses angezeigt.
Diese Datei speichert die verschiedenen Experimente und die optimalen Werte für die
einzelnen Ionenoptik-Parameter. Ein Ordner mit allen durchgeführten Experimenten wird
ebenfalls erzeugt und kann im „Explore“-Modus angezeigt werden. Für jedes durchgeführte
Experiment wird ebenfalls eine Erfassungsmethode erzeugt und im Ordner „Acquisition
Method“ gespeichert.

Flussinjektionsanalyse
Die Flussinjektionsanalyse (Flow Injection Analysis, FIA) ist die Injektion einer
geringen Probenmenge durch einen Probengeber in den LC-Strom. Während
des FIA-Optimierungsprozesses werden mehrere Probeninjektionen für verschiedene
quellenabhängige und/oder substanzspezifische Parametertypen durchgeführt, die zwischen
den Injektionen verändert werden. FIA optimiert Parameter für das Auflösungspotenzial
von Ionenclustern, die Stoßenergie und das Stoßkammeraustrittspotenzial durch
aufeinanderfolgende, schleifenförmige Experimente, d. h. zunächst mit einem
substanzspezifischen Parameter und dann mit dem nächsten substanzspezifischen
Parameter. Der Prozess optimiert die quellenabhängigen Parameter, indem eine Injektion
für jeden Parameter vorgenommen wird.

Mit der FIA-Optimierung können sowohl die verbindungsspezifischen als auch die
quellenspezifischen Parameter unter Verwendung der LC bei höherem Volumenstrom
optimiert werden.

Infusion
Infusion ist das kontinuierliche Fließen einer Probe in die Ionenquelle bei
niedrigen Strömungsgeschwindigkeiten mittels einer Spritzenpumpe. Während des
Infusionsoptimierungsprozesses können Vorläufer- und Produkt-Ionen von der Software
ausgewählt und entsprechend dem Auflösungspotenzial von Ionenclustern, der
Kollisionsenergie und dem Stoßzellen-Austrittspotenzial für beide optimiert werden. Die
Spannungen dieser verschiedenen Ionenpfad-Parameter werden allmählich erhöht oder
verringert, um die maximale Signalstärke für Vorläufer- und Produkt-Ionen zu bestimmen.

Verwenden Sie die Infusionsoptimierung zur Optimierung von substanzspezifischen
Parametern nur bei Flussgeschwindigkeiten, die niedriger sind als die bei LC/MS-Analysen
verwendeten.

T-Infusion
T-Infusion (oder Split-Infusion) ist das kontinuierliche Fließen einer Probe in die Ionenquelle
bei niedrigen Flussgeschwindigkeit durch einen Drei-Wege-Erdungsanschluss an der
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Ionenquelle. Der Drei-Wege-Erdungsanschluss ist mit einer Spritzenpumpe mit einer PEEK-
Kapillare und einer LC-Pumpe verbunden.
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Acquisition Methods 3
Bei der Erstellung einer Erfassungsmethoden-Datei aus einer vorhandenen Datei kann
der Benutzer einige oder alle Geräte-Methoden in der Erfassungsmethode verwenden.
Verwenden Sie den Acquisition Method Editor, um die Erfassungsmethode durch Hinzufügen
oder Entfernen von Geräte-Methoden anzupassen. Wenn das gewünschte Geräte-Symbol
im Teilfenster „Acquisition Method Browser“ nicht angezeigt wird, können Benutzer das Gerät
nur dann hinzufügen, wenn es im aktiven Hardware-Profil enthalten ist.

Es wird empfohlen, dass nur diejenigen Benutzer Erfassungs- und Quantifizierungsmethoden
erstellen oder ändern, die mit der Methodenentwicklung vertraut sind. Weitere Informationen
über Rollen und Sicherheit finden Sie im Abschnitt „Über Benutzer und Rollen“ im Dokument
Handbuch für Laborleiter.

Erfassungsmethoden für Geräte
Erstellen Sie eine Erfassungsmethode für ein Peripheriegerät, indem Sie die
Betriebsparameter für dieses Gerät auswählen. Erfassungsmethoden können für jedes der
folgenden Geräte erstellt werden, wenn sie im aktiven Hardware-Profil konfiguriert sind:

• Pumpen

• Autosampler

• Spritzenpumpen

• Säulenöfen

• Umschaltventile

• Diodenanordnungsdetektor

• Analog-Digital-Umwandler

• Integrierte Systeme

Weitere Informationen über die Einstellung von Geräteeigenschaften finden Sie im
Dokument: Handbuch für das Einrichten von Peripheriegeräten.

Hinweis: Die für die LC-Geräte verfügbaren Parameter variieren je nach Hersteller.

Hinzufügen oder Entfernen eines Peripheriegeräts
1. Mit einer im Acquisition Method Editor geöffneten Methodendatei klicken Sie mit der

rechten Maustaste im Teilfenster „Acquisition Method“ auf Acquisition Method und
dann auf Add/Remove Device Method.
Der Dialog „Add/Remove Device Method“ öffnet sich und zeigt die im aktiven Hardware-
Profil konfigurierten Geräte.
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Abbildung 3-1: Dialog „Add/Remove Device Method“

2. Aktivieren oder deaktivieren Sie die Kontrollkästchen neben einer Geräte-Methode, um
eine Geräte-Methode hinzuzufügen oder zu entfernen.

3. Klicken Sie auf OK.

Festlegen der LC-Pumpeneigenschaften
1. Führen Sie mit einer im „Acquisition Method Editor“ geöffneten Erfassungsmethoden-

Datei im Teilfenster „Acquisition Method“ eine der folgenden Aktionen aus:

• Um die Agilent-Pumpe zu aktivieren, klicken Sie auf das Symbol Pump.

• Klicken Sie bei Shimadzu LC 20/30-Geräten, die mithilfe des Integrated System
Shimadzu LC Controller aktiviert wurden, auf Shimadzu LC System.

• Klicken Sie bei Shimadzu LC 20/30-Geräten, die mithilfe des Integrated System
Shimadzu LC-20/30 Controller, Shimadzu LC 40-Geräten, ExionLC-Geräten, ExionLC
2.0-Geräten oder Jasper LC-Geräten aktiviert wurden, auf LC System.

2. Wählen Sie im rechten Teilfenster die Registerkarte „LC pump“, wenn diese nicht bereits
ausgewählt ist. Bearbeiten Sie dann nach Bedarf die Eigenschaften oder Einstellungen.

3. Speichern Sie die Datei.

Festlegen der Autosampler-Eigenschaften
1. Stellen Sie sicher, dass auf der Registerkarte „Acquisition Properties“ das Feld

Synchronization Mode auf LC Sync eingestellt ist. Das Gerät, die Probeninjektion und
die Instrumentenerfassung starten gleichzeitig.

2. Führen Sie mit einer im „Acquisition Method Editor“ geöffneten Methoden-Datei im
Teilfenster „Acquisition Method“ eine der folgenden Aktionen aus:
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• Klicken Sie auf das Symbol Agilent Autosampler, um den Agilent-Probengeber
auszuführen.

• Klicken Sie auf das Symbol CTC PAL Autosampler, um den CTC PAL-Probengeber
auszuführen.

• Klicken Sie bei Shimadzu LC 20/30-Geräten, die mithilfe des Integrated System
Shimadzu LC Controller aktiviert wurden, auf Shimadzu LC System.

• Klicken Sie bei Shimadzu LC 20/30-Geräten, die mithilfe des Integrated System
Shimadzu LC-20/30 Controller, Shimadzu LC 40-Geräten, ExionLC-Geräten, ExionLC
2.0-Geräten oder Jasper LC-Geräten aktiviert wurden, auf LC System.

3. Öffnen Sie die Registerkarte „Autosampler“ im rechten Teilfenster und bearbeiten Sie
dann die Eigenschaften oder Einstellungen nach Bedarf.

4. Speichern Sie die Datei.

Festlegen der Eigenschaften der integrierten
Spritzenpumpe
Dieses Verfahren gilt für Systeme mit eingebauten Spritzenpumpen.

1. Mit einer im „Acquisition Method Editor“ geöffneten Erfassungsmethoden-Datei klicken
Sie im Teilfenster „Acquisition Method Browser“ auf das Symbol „Syringe Pump“.
Die Registerkarte „Syringe Pump Method Properties“ wird im Teilfenster „Acquisition
Method Editor“ angezeigt.

2. Bearbeiten Sie die Felder nach Bedarf.

3. Speichern Sie die Datei.

Festlegen der Säulenofen-Eigenschaften
1. Führen Sie mit einer im „Acquisition Method Editor“ geöffneten Erfassungsmethoden-

Datei im Teilfenster „Acquisition Method“ eine der folgenden Aktionen aus:

• Klicken Sie bei Agilent-Säulenofen auf das Symbol Agilent Column Compartment.

• Klicken Sie bei Shimadzu LC 20/30-Geräten, die mithilfe des Integrated System
Shimadzu LC Controller aktiviert wurden, auf Shimadzu LC System.

• Klicken Sie bei Shimadzu LC 20/30-Geräten, die mithilfe des Integrated System
Shimadzu LC-20/30 Controller, Shimadzu LC 40-Geräten, ExionLC-Geräten, ExionLC
2.0-Geräten oder Jasper LC-Geräten aktiviert wurden, auf LC System.

2. Wählen Sie im rechten Teilfenster die Registerkarte „Column Oven“, wenn diese nicht
bereits ausgewählt ist. Bearbeiten Sie dann nach Bedarf die Eigenschaften oder
Einstellungen.

3. Speichern Sie die Datei.

Festlegen der Eigenschaften des Umschaltventils
Das Umschaltventil kann als Umleit- oder Einspritzventil verwendet werden. Wählen Sie den
Synchronisationsmodus Manual Sync with Valve, wenn das Ventil als Injektor verwendet
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wird. Wählen Sie einen beliebigen anderen Modus, wenn das Ventil als Umleitventil
verwendet wird.

1. Mit einer im „Acquisition Method Editor“ geöffneten Methoden-Datei klicken Sie im
Teilfenster „Acquisition Method“ auf das Symbol Valve.
Die Registerkarte „Valve Properties“ öffnet sich im Fensterausschnitt „Acquisition Method
Editor“.

2. Ändern Sie gegebenenfalls die voreingestellten Positionsnamen.
Das Umschaltventil wird manchmal dazu verwendet, Lösungsmittel zu den Abfallstoffen
oder zu einer anderen Säule zu leiten. Die voreingestellten Positionsnamen sind A und
B.

• Wählen Sie in der Liste Change Position Names eine Position aus.

• Ändern Sie in der Liste Change Position Names die voreingestellten
Positionsnamen entsprechend den Ventilanschlüssen. Wenn das Ventil als Injektor
verwendet wird, dann ändern Sie A und B zu „Inject and Divert“ oder „Column and
Waste“. Wenn das Ventil als Umleitventil verwendet wird, dann ändern Sie A und B zu
„Divert“ and „Inject“ oder „Waste and Column“.

3. Klicken Sie in der Spalte Total Time (min) auf eine Zelle und geben Sie dann die
Gesamtzeit ein, für die das Ventil in dieser Position bleiben wird.

4. In der Spalte Position klicken Sie auf eine Zelle und wählen dann in der Liste Position
die Ventilstellung.

5. Wiederholen Sie die Schritte 3 und 4 für jeden Schalter des Ventils, den Sie während der
Erfassung benötigen.

6. Speichern Sie die Datei.

Festlegen der Diodenanordnungsdetektor-Parameter
(Agilent)
1. Mit einer im „Acquisition Method Editor“ geöffneten Erfassungsmethoden-Datei klicken

Sie im Teilfenster „Acquisition Method“ auf das Symbol Agilent Diode Array Detector.
Die Registerkarte „Agilent DAD Method Editor“ öffnet sich im Fensterausschnitt
„Acquisition Method Editor“.

2. Bearbeiten Sie die Eigenschaften, falls erforderlich.

3. Speichern Sie die Datei.

Festlegen der Analog/Digital-Wandler-Eigenschaften
1. Mit einer im „Acquisition Method Editor“ geöffneten Methoden-Datei klicken Sie im

Teilfenster „Acquisition Method“ auf das Symbol Analog to Digital Converter (ADC).
Die Registerkarte „Analog/Digital Converter Properties“ wird im Teilfenster „Acquisition
Method Editor“ geöffnet.

2. Geben Sie im Abschnitt „Sample“ im Feld Rate (pts/sec) die Geschwindigkeit ein.
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Hinweis: Intervall und Geschwindigkeit sind zueinander proportional. Wenn die
Geschwindigkeit geändert wird, berechnet die Software automatisch das Intervall neu.

3. Gehen Sie folgendermaßen vor, um die Kanal-Details festzulegen:

a. Im Feld Channels klicken Sie auf den Namen des Kanals und aktivieren dann das
Kontrollkästchen neben dem Namen, um den Kanal in die Methode aufzunehmen.

b. Im Feld Interpreted Value @ Full Scale geben Sie den entsprechenden Wert ein.

c. Im Feld Interpreted Unit geben Sie den entsprechenden Wert ein.

Die Anzahl der verfügbaren Kanäle wird festgelegt, wenn der ADC im Hardware-
Profil eingerichtet wird.

4. Speichern Sie die Datei.

Dynamic Fill Time (Dynamische Füllzeit)
„Dynamic Fill Time“ (DFT) ist eine Funktion, die speziell dafür entwickelt wurde, um in einem
Spektrum erfasste Daten für die Scan-Funktionen der linearen Ionenfalle zu optimieren.
DFT passt die zum Füllen der Ionenfalle verwendete Füllzeit automatisch entsprechend
dem Ionenfluss aus der Ionenquelle an. Für intensivere Ionen wird die Füllzeit automatisch
verringert, um sicherzustellen, dass die Falle nicht mit Ionen überfüllt wird.

Für weniger intensive Ionen wird die Füllzeit automatisch erhöht, um sicherzustellen, dass
man im Spektrum eine gute Ionen-Statistik erhält. DFT ist für die folgenden Scan-Typen
möglich:

• Erweiterte MS (EMS)

• Enhanced Resolution (ER)

• Enhanced Product Ion (EPI)

• MS/MS/MS (MS3)

Passen Sie die DFT-Einstellungen an, indem Sie Tools > Settings > Method Options in der
Software auswählen.

Experimente und Zeiträume
Die Erfassungsmethode des Massenspektrometers besteht aus Experimenten und
Zeiträumen. Erstellen Sie im Fensterbereich „Acquisition Method Browser“ eine Abfolge von
Erfassungszeiträumen und Experimenten für das Massenspektrometer. Öffnen Sie alternativ
eine zuvor im Tune Method Editor erstellte Methode.

Experimente
Ein Experiment umfasst die Einstellungen des Massenspektrometers und die Scan-Methode
während eines MS-Scans. Ein Satz durchgeführter MS-Scans für eine bestimmte zeitliche
Dauer wird als Zeitraum bezeichnet. Eine Erfassungsmethode, in der die MS-Parameter
und Aktionen über die gesamte Dauer gleich bleiben, wird als Methode mit einem einzigen
Zeitraum und einem einzigen Experiment bezeichnet.
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Bei schleifenförmigen Experimenten werden die MS-Einstellungen für jeden Scan geändert.
Beispiel: Wenn die Probe zwei Verbindungen, A und B, enthält, können Benutzer ein
MS/MS-Experiment mit Verbindung A mit einem MS/MS-Experiment mit Verbindung B in
eine Schleife legen, um im gleichen Durchlauf Informationen über beide Verbindungen zu
erhalten. Die Massenspektrometer-Methode wechselt zwischen den beiden Scan-Typen.
Weitere Beispiele für schleifenförmige Experimente sind die abwechselnde Verwendung von
positiven und negativen Modi in einem Durchlauf und „Information Dependent Acquisition“-
(IDA-)Methoden.

Zeiträume
Ein Zeitraum kann ein oder mehrere schleifenförmige Experimente enthalten. In einer
Erfassungsmethode mit mehreren Zeiträumen werden Experimente für eine bestimmte
Dauer durchgeführt und dann wechselt die Software auf einen anderen Satz von
Experimenten. Zeiträume sind dann hilfreich, wenn die Elutionszeit der Verbindungen in
einem LC-Durchlauf bekannt ist. Das Massenspektrometer ist so einstellbar, dass es je
nach Elutionszeitpunkt der Verbindungen verschiedene Experimente durchführt, um in einem
Durchlauf so viele Informationen wie möglich zu erhalten.

Die folgende Abbildung zeigt eine Methode mit drei Zeiträumen.

Abbildung 3-2: Beispiel für ein Experiment mit mehreren Zeiträumen

Informationsabhängige Erfassungsmethoden
Eine IDA-Methode verarbeitet Experimente automatisch basierend auf den Ergebnissen
aus vorhergehenden Zyklen. Verwenden Sie die IDA-Kriterien zur Optimierung der
Datenerfassungseinstellungen während der Datenerfassung und zur Verkürzung der
Probenerfassungsdauer bei einer einzigen Injektion. Durch IDA können Benutzer sowohl die
Anzahl der benötigten Proben als auch wertvolle Arbeitszeit sparen.

Sie können eine IDA-Methode mit bis zu zwei Vorläuferscans und abhängigen Scans
für bis zu acht der intensivsten Peaks in einem einzigen Zeitabschnitt erstellen. Ein
Vorläuferscan löst bei IDA weitere Experimente aus. Die folgenden Scan-Methoden können
als Vorläuferscans verwendet werden:

• Enhanced Product Ion (EPI) (zweiter Vorläuferscan)
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• Erweiterte MS (EMS)

• Multiple Reaction Monitoring (MRM) oder Scheduled MRM Algorithmus

• Neutralverlust (NL)

• Vorläufer-Ion (Prec)

• Q3 MS

Die folgenden Scan-Methoden können als abhängige Scans verwendet werden:

• EPI

• MS/MS

Während der Erfassung einer IDA-Methode variieren die Aktionen im Massenspektrometer
von Scan zu Scan aufgrund der in einem vorhergehenden Zyklus erfassten Daten. Die
Software analysiert die Daten bei der Erfassung und bestimmt dann die Massen, mit denen
abhängige Scans durchzuführen sind. Benutzer können die Kriterien für die Auslösung eines
IDA-Experiments und die zu verwendenden Methoden-Parameter festlegen.

Die Erfassung mittels IDA-Methode verbessert die Ergebnisse, indem die abhängigen Scans
mit den folgenden benutzerdefinierten Kriterien ausgeführt werden:

• Ionen-Intensität und Ladungszustand

• Liste mit Einschluss- und Ausschlusskriterien

• Isotopenmuster

• Dynamischer Ausschluss

• Änderungsrate der Ionenintensität (siehe Abschnitt: Dynamic Background Subtraction-
Algorithmus.)

Geplante Ionisation
Mithilfe der Funktion „Scheduled Ionization“ kann die Ausfallzeit des Massenspektrometers
reduziert werden, indem das Risiko einer Kontamination verringert wird. Sie ist verfügbar
im „Acquisition Method Editor“ und kann für die Chargenerfassung mithilfe einer
Erfassungsmethode für einen Zeitraum verwendet werden. Siehe die folgende Abbildung.
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Abbildung 3-3: Funktion „Geplante Ionisation“ im Acquisition Method Editor

Wenn Scheduled Ionization ausgewählt ist, und die Start Time und Stop Time für
Scheduled Ionization festgelegt sind, dann wird die IonSpray Voltage (ISV) auf den ISV-
Wert eingestellt, der in der Erfassungsmethode nur zwischen der Start Time und der Stop
Time angegeben ist, bei der die relevanten Peaks eluieren. Die ISV wird vor der Start time
und nach der Stop time auf 0 gesetzt. Die LC-Methode sollte wie gewöhnlich eingestellt
werden. Wenn die LC-Dauer beispielsweise auf 5 Min. eingestellt ist, und die Scheduled
Ionization bei 1,5 Min. startet und bei 3,5 Min. stoppt, dann startet die LC bei 0 Min.
und stoppt bei 5 Min. Die Massenspektrometer-Datensammlung startet bei 1,5 Min. und
stoppt bei 3,5 Min. Die Scheduled Ionization kann auch für den Nebulizer Current (NC)
verwendet werden, wenn eine Turbo V- oder IonDrive Turbo V-Ionenquelle im APCI-Modus
verwendet wird.

Die Start Time und Stop Time für eine Erfassungsmethode mit ausgewählter Funktion
Scheduled Ionization sollte basierend auf den mithilfe derselben Erfassungsmethode
erfassten Daten entwickelt werden, jedoch ohne ausgewählter Scheduled Ionization.

Hinweis: Die Stop Time muss größer als die Start Time sein.
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Hinweis: Wenn das Kontrollkästchen Scheduled Ionization aktiviert ist, ist die Mass Spec-
Zeit die Stop Time (die geplante Zeit für das Ende der Ionisation). Die im „Acquisition
Method Editor“ neben der Period angezeigte Zeit ist der Wert, der im Feld Duration
angezeigt wird. siehe die folgende Abbildung.

Abbildung 3-4: Massenspektrometerzeit wenn Scheduled Ionization ausgewählt ist

Lösungsmittel-Kompressibilitätswerte
Tabelle 3-1: Lösungsmittel-Kompressibilitätswerte

Lösungsmittel Kompressibilität 10-6/bar)

Aceton 126

Acetonitril 115

Benzol 95

Kohlenstoffte-
trachlorid

110

Chloroform 100

Cyclohexan 118

Ethanol 114

Ethylacetat 104

Heptan 120

Hexan 150

Isobutanol 100

Isopropanol 100

Methanol 120

1-Propanol 100

Toluol 87

Wasser 46
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Vergleich von Spritzengröße und Flussrate
Die Flussrate einer Spritzenpumpe hängt von der in der Pumpe installierten Spritze ab. Die
folgenden Tabellen zeigen das Verhältnis von Flussrate und Spritzengröße.

Tabelle 3-2: Spritzengröße und Flussrate bei l/Std.

Spritzengröße
(µl)

Minimum (l/Std.) Maximum (l/Std.)

0,5 0,002 23,8

1,0 0,003 47,8

2,0 0,006 95,2

5,0 0,015 238,0

10,0 0,029 474,0

25,0 0,073 1193,0

Tabelle 3-3: Spritzengröße und Flussrate bei µl/Min.

Spritzengröße
(µl)

Minimum (µl/Min.) Maximum (µl/Min.)

50 0,002 39,7

100 0,005 79,7

250 0,012 197,8

500 0,024 397,0

1000 0,048 795,0

1,0 0,049 805,0

Tabelle 3-4: Spritzengröße und Flussrate bei ml/Std.

Spritzengröße
(ml)

Minimum (ml/Std.) Maximum (ml/Std.)

2,0 0,011 186,8

2,5 0,010 168,2

3,0 0,011 181,4

5,0 0,019 317,0

10,0 0,028 461,0

20,0 0,050 821,0

30,0 0,074 1208,0
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Tabelle 3-5: Spritzengröße und Flussrate bei ml/Min.

Spritzengröße
(ml)

Minimum (ml/Min.) Maximum (ml/Min.)

50,0 0,002 28,40

100,0 0,003 47,60

140,0 0,004 55,10
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Chargen 4
Eine Charge ist eine Sammlung von Informationen über eine zu analysierende Probe.
Proben werden für gewöhnlich in Sätzen zusammengefasst, um die Übermittlung zu
vereinfachen. Durch die Gruppierung der Proben in Sätzen wird außerdem die Menge der
manuell einzugebenden Daten reduziert. Ein Satz kann aus einer einzelnen Probe oder
mehreren Proben bestehen. Alle Sätze in einer Charge verwenden das gleiche Hardware-
Profil. Proben in einem Satz können jedoch unterschiedliche Erfassungsmethoden haben.
Eine Charge kann nur von einer Erfassungsstation übergeben werden.

Chargen beinhalten folgende Informationen:

• Probeninformationen wie z. B. Name, ID, Datendatei-Name und Kommentar

• Autosampler-Position (Rack-Informationen), Fläschchenposition

• Erfassungsmethoden und Injektionsvolumen

• Quantifizierungsmethode (optional)

• Quantifizierungsinformation (optional)

• Benutzerdefinierte Probendaten (optional)

• Satzinformationen.

Batch Editor
Verwenden Sie den Batch Editor zum Erstellen und Bearbeiten von Chargen und zum
Erstellen von Chargen-Vorlagen. Bei der Bearbeitung von Proben, die jeweils eine
unterschiedliche Erfassungsmethode verwenden, wählen Sie mehrere Erfassungsmethoden
im gleichen Satz aus.

Eine Erfassungsmethode kann auch als Vorlage verwendet werden. In diesem Fall wird
für jede Probe die gleiche Methode verwendet, der Benutzer kann jedoch für jede Probe
unterschiedliche Massen oder Massenbereiche wählen. Mithilfe des Batch Editors können
außerdem Probenlisten importiert werden, die mit externen Programmen, wie z. B. Microsoft
Excel, erstellt wurden.

Der Benutzer kann jedes Detail der Charge verändern, bevor er sie zur Verarbeitung
übermittelt. Wenn eine Charge zur Analyse übermittelt wird, kann der Benutzer entweder die
gesamte Charge, bestimmte Sätze innerhalb der Charge oder bestimmte Proben innerhalb
eines Satzes übermitteln.

Beispiel: Um zehn Proben zu analysieren, fünf mit einer Erfassungsmethode und fünf mit
einer anderen Erfassungsmethode, erstellen Sie eine Charge mit zwei Sätzen, einen für jede
verwendete Methode.
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Hinweis: Wir empfehlen, dass Benutzer alle Chargen-Parameter vor der Chargen-
Übermittlung überprüfen, um sicherzustellen, dass die Rack-, Platten- und
Fläschchenpositionen mit den Hardwareeinstellungen des Probengebers übereinstimmen.
Außerdem kann geprüft werden, ob die Rackeinstelloption „Specify rack“ für die
Erfassungsmethode verfügbar und für den verwendeten Probengeber ausgewählt ist.

Hinweis: Wir empfehlen Benutzern zu prüfen, ob Rack und Platte mit den richtigen
Probenpositionen in den Probengeber geladen wurden, bevor die Charge übermittelt wird.

Tabelle 4-1: Registerkarten des Batch Editors

Registerkarte Beschreibung

Probe Wird verwendet, um die Probenliste zu erstellen und Probendetails
auszuwählen, wie Probenname und Erfassungsmethode, die für die
Erfassung der Probe verwendet werden sollen.

Locations Wird verwendet, um die Positionen der Proben im Autosampler
auszuwählen. Proben-Speicherplätze können numerisch auf der
Registerkarte „Sample“ angegeben werden. Die Registerkarte
„Locations“ bietet jedoch eine graphische Oberfläche für die Auswahl
der Proben-Speicherplätze.

Quantifizierung Wird verwendet, um die Probentypen und
Konzentrationen für Quantifizierungs-Chargen auszuwählen. Da
Quantifizierungsinformationen nach der Erfassung in der Ergebnistabelle
der Quantifizierung angegeben werden können, müssen Benutzer
die Registerkarte „Quantitation“ im Batch Editor nicht verwenden.
Stattdessen kann der „Quantitation Wizard“ verwendet werden.

Submit Wird verwendet, um die Probeninformation zu überprüfen und Proben
an die Erfassungswarteschlange zu übermitteln. Der „Queue Manager“
zeigt den Status von Warteschlange, Charge und Probe und ermöglicht
den Benutzern, Proben in der Warteschlange zu verwalten.

Importieren von Chargen-Dateien
Sie können eine Textdatei mit Chargen-Informationen importieren, anstatt eine Charge im
„Batch Editor“ zu erstellen. Wenn Sie alle Probendetails in einer Tabellenkalkulation haben,
ist es schneller, diese in der Tabellenkalkulation neu zu ordnen und zu importieren, als die
Daten im „Batch Editor“ manuell einzugeben.

Bevor Sie Chargen-Informationen aus einer Textdatei importieren, stellen Sie sicher, dass
die Daten in der Datei korrekt organisiert und formatiert sind. Insbesondere müssen die
Spaltenüberschriften in der Tabelle den Spaltenüberschriften im „Batch Editor“ entsprechen.
Um sicherzustellen, dass die Textdatei die richtigen Überschriften enthält, erstellen Sie
eine Charge mit dem Batch Editor, exportieren Sie diesen als Textdatei, geben Sie die
entsprechenden Werte in einem Tabellenkalkulationsprogramm ein und importieren Sie die
Datei dann wieder in den Batch Editor.
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Beispiele für korrekt formatierte Dateien entnehmen Sie bitte dem Batch-Ordner im
Beispielprojekt.

Die Informationen in einer Chargen-Datei können auch zur Verwendung mit anderen
Anwendungen exportiert werden, z. B. mit Microsoft Excel, Microsoft Access und bestimmten
LIMS-Softwareanwendungen (Labor-Informations- und Management-System).

Festlegen von Quantifizierungsdetails im Batch
Editor (optional)
Wenn eine Quantifizierungsmethode bei einer Charge verwendet wird und der Benutzer
Quantifizierungsdetails nicht nach der Erfassung auswählen will, definieren Sie die
Quantifizierungsdetails (Probentyp, Probenkonzentration) vor der Übergabe der Charge.

Die entsprechenden Spalten Internal Standard und Standard werden in der
Registerkarte „Quantitation“ entsprechend der auf der Registerkarte „Sample“ ausgewählten
Quantifizierungsmethode angezeigt.

1. Öffnen Sie mit einer im Batch Editor-Fenster geöffneten Chargendatei die Registerkarte
„Quantitation“.

2. Wählen Sie das Set mit den Proben.

3. Wählen Sie einen Quant Type, Dilution Factor und Weight/Volume für alle Proben aus
der Liste in der Zelle aus.

4. Geben Sie (falls erforderlich) in die Spalte Analyte die Analyt-Konzentration ein.

5. Geben Sie (falls erforderlich) in die Spalte Internal Standard die Konzentration des
internen Standards ein.

6. Wiederholen Sie diesen Vorgang für jedes Set in der Charge.

Chargen

Handbuch für fortgeschrittene Benutzer
IVD-IDV-05-1320-DE-C

Analyst MD Software
37/124



Qualitative Datenanalyse 5
Benutzer können die in einer Datei enthaltenen Informationen als Tabelle oder Diagramm
anzeigen. Grafische Daten werden entweder als Chromatogramm oder als Spektrum
dargestellt. Die Daten in jedem dieser Formulare können als Tabelle aus Datenpunkten
angezeigt und es können verschiedene Sortiervorgänge mit den Daten durchführt werden.

Die Software speichert das TIC und die Methodendaten in wiff-Dateien und die Spektraldaten
in wiff.scan-Dateien. Zum Öffnen der Datendatei erfordert die Software sowohl .wiff- als
auch .wiff.scan-Dateien. Zudem kann die Software .txt-Dateien öffnen, die Daten einer
einzigen Probe enthalten. Wenn eine Datendatei in der Software geöffnet wird, werden
in Abhängigkeit von der Art des durchgeführten Experiments verschiedene Teilfenster
angezeigt.

Wird das Kontrollkästchen „MCA“ im Tune Method Editor aktiviert, dann öffnet die Datendatei
ein Massenspektrum. Wird das Kontrollkästchen „MCA“ nicht aktiviert, dann wird ein „Total
Ion Chromatogramm“ (TIC) durch die Datendatei geöffnet. Benutzer können zunächst einen
Bereich auswählen und dann im TIC-Fenster auf eine bestimmte Zeit doppelklicken, um das
Spektrum für diesen Bereich zu zeigen.

Chromatogramme
Ein Chromatogramm zeigt die Mengenvariation im Verhältnis zur Zeit in einem wiederholten
Experiment. Beispielsweise, wenn die Programmierung des Massenspektrometers vorgibt,
dass ein bestimmter Satz von spektrometrischen Scans mehrmals zu wiederholen ist. Die
Chromatographiedaten sind fortlaufend, selbst wenn die Intensität der Daten Null beträgt.
Chromatogramme werden nicht direkt vom Massenspektrometer, sondern aus Spektren
generiert.

Im Chromatogramm wird die Intensität in Zählimpulsen pro Sekunde (Counts per Second –
cps) auf der Y-Achse gegenüber der Zeit auf der X-Achse angezeigt. Peaks werden
automatisch gekennzeichnet.

Im Falle von LC/MS wird ein Chromatogramm oft als zeitabhängige Funktion dargestellt.
Der Zeitpunkt, zu der ein bestimmter Scan erstellt wurde, lässt sich von der Scan-Nummer
ableiten.

Ein Chromatogramm liefert bei Verwendung einer LC-Säule in der Regel einen
zeitabhängigen allgemeinen Überblick über die Daten. Es liefert jedoch keine Informationen
über die Komponenten eines Peaks. Während zum Beispiel ein Chromatogramm nur
einen Peak anzeigen könnte, kann dieser Peak mehr als nur eine Verbindung, d. h.
unterschiedliche Massen, repräsentieren.

Die chromatographischen Daten können sich sowohl hinsichtlich der Zeit als auch der
Intensität ändern, wenn sich die chromatographischen Bedingungen in einer bestimmten
Probe ändern.
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Spektren
Ein Spektrum besteht aus den Daten, die direkt vom Massenspektrometer erfasst werden,
und repräsentiert normalerweise die Zahl der mit einem bestimmten Masse-zu-Ladung-
Verhältnis (m/z) erkannten Ionen. Es wird als Diagramm mit den m/z-Werten auf der X-Achse
und der Intensität (cps) auf der Y-Achse dargestellt.

Bei MRM-Spektren wird die Intensität mit zwei Massen in Beziehung gesetzt, der
Vorläuferionen-Masse (Q1) und der Produktionen-Masse oder -Massen (Q3).

Wenn die Daten als Spektrum dargestellt werden, erhält man massenspezifische
Informationen zu einer Verbindung. Ein Spektrum liefert die m/z-Werte für die Ionen, die
einem bestimmten chromatographischen Peak entsprechen. Diese Ionen können verwendet
werden, um weitere spezifische Informationen zu gewinnen. Beispiel: Ein Spektrum zeigt
alle Massen, aus denen ein Peak zusammengesetzt ist, einschließlich der Intensität der
einzelnen Massen.

Die spektralen Intensitäten könnten sich ändern, aber der m/z-Wert bleibt gleich, weil sich die
Masse einer Verbindung nicht ändert.

Mann kann Spektraldaten auf zwei Arten erzeugen:

• Wenn nur ein Scan erfasst oder MCA zur Erfassung verwendet wird, werden die Daten als
Spektrum dargestellt.

• Aus einem Chromatogramm.

Hintergrundsubtraktion
Hintergrundsubtraktionen reduzieren die Menge an Rauschen in einem Spektrum, indem
entweder ein oder zwei Bereiche mit Rauschen von dem Bereich, der einen Peak enthält,
subtrahiert werden. Benutzer können die Bereiche unabhängig voneinander verschieben
oder miteinander verkoppeln und als eine Einheit innerhalb des Diagramms verschieben,
um die Peak-Isolierung zu optimieren oder einen anderen Peak zu isolieren. „Locked
Background Subtract“ ist die Voreinstellung. Die Software bietet verschiedene Methoden der
Hintergrundsubstraktion.

Background Subtract: Mithilfe der Hintergrundsubtraktion können Benutzer relevante
Peaks isolieren. Benutzer können bis zu zwei ausgewählte Bereiche des Peaks markieren
und subtrahieren. Benutzer können ihre Bereiche auch sperren und im Diagramm
verschieben, um die Peak-Isolierung zu optimieren oder einen weiteren Peak zu isolieren.

Durchführen einer Hintergrundsubtraktion für ein
Chromatogramm
1. Öffnen Sie eine Datei.

2. Wählen Sie einen Hintergrundbereich im Chromatogramm.

3. Drücken Sie Shift und wählen Sie dann einen anderen Hintergrundbereich.
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Abbildung 5-1: Extrahierter Ionenstrom

Element Beschreibung

1 Interessierender Peak

2 Hintergrund

4. Klicken Sie zum Festlegen des Subtraktionsbereichs auf Explore > Background
Subtract > Set Subtract range.

5. Wählen Sie den relevanten Peak.

6. Klicken Sie auf Explore > Background Subtract > Perform Background Subtract.
Der Hintergrund wird vom Peak subtrahiert und ein neues Spektrum wird erzeugt.

7. Um einen weiteren Peak zu isolieren, ziehen Sie die gesperrten Bereiche im
Chromatogramm und wiederholen Sie dann die Hintergrundsubstraktion.

Tipp! Um den Hintergrundsubstraktionsbereich zu löschen, klicken Sie auf Explore >
Background Subtract > Clear Subtract Range.

8. Zum Speichern des Spektrums nach Hintergrundsubtraktion als verarbeitete Datei
klicken Sie auf File > Save Processed Data File.
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Entsperren der Bereiche
Voraussetzung

• Der ausgewählte Subtraktionsbereich ist gesperrt.

Klicken Sie auf Explore > Background Subtract > Subtract Range Locked.
Die Bereiche werden entsperrt und können unabhängig voneinander verschoben werden.

Basisliniensubtraktion
Bei der Basisliniensubtraktion wird eine Konstante oder ein langsam variierender Versatz
aus einem Datensatz entfernt. Diese Funktion ist hilfreich zum Auffinden kleiner Peaks, die
durch Rauschen verdeckt werden. Die Software nutzt den folgenden Algorithmus bei der
Durchführung einer Basisliniensubtraktion.

• Jeder Datenpunkt in dem Datensatz wird als Mittelpunkt eines Fensters (in Masse oder
Zeit) mit benutzerdefinierbarer Breite betrachtet, gemessen in AME oder Minuten.

• Die Mindestwerte auf beiden Seiten des aktuellen Datenpunktes (Minimum) innerhalb des
Fensters werden ermittelt.

• Eine gerade Linie wird zwischen die zwei Minima eingefügt und die Höhe (Intensität)
des aktuellen Datenpunktes oberhalb der Linie wird berechnet. Die Endpunkte der Daten
werden als Minima betrachtet.

• Der Datenpunkt wird durch den neuen berechneten Wert ersetzt.

Rechner
Verwenden Sie einen Rechner, um Berechnungen anhand erfasster Daten durchzuführen.
Obwohl es sich bei dem Rechner um ein separates Fenster handelt, wird er mit der aktiven
Grafik der Software verbunden.

Die folgenden Rechner sind verfügbar:

• Rechner „Elemental Composition“

• Rechner „Hypermass“

• Rechner „Elemental Targeting“

• Rechner „Mass Property“

• Rechner „Isotopic Distribution“

Zwischen den verschiedenen Fenstern der Rechner besteht die Möglichkeit, etwas aus
einem Textfeld auszuschneiden und in ein anderes Textfeld einzufügen. Daten können
ebenfalls von jedem Rechner ausdruckt werden, indem man auf das Print-Symbol in der
linken oberen Ecke des Fensters klickt. Klicken Sie auf Hilfe, um weitere Informationen über
die Verwendung von Rechnern zu erhalten.
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Die Daten der Rechner „Elemental Composition“, „Mass Property“ und „Isotopic Distribution“
können in eine separate Datei exportiert werden. Verwenden Sie den Rechner „Elemental
Targeting“, um die Daten im aktiven Diagramm zu verändern. Die Daten der Rechner
„Hypermass“ und „Isotopic Distribution“ können ein aktives Spektrum überlagern.

Tipp! Stellen Sie die Präzision der Rechnerdaten auf der Registerkarte „Calculators“ des
Dialogfeldes „Appearance Options“ ein. Klicken Sie auf Tools > Settings > Appearance
Options, um das Dialogfeld zu öffnen.

Rechner „Elemental Composition“
Basierend auf einem gewünschten Masse-zu-Ladung-Verhältnis bestimmt der Rechner
„Elemental Composition“ potenzielle Molekül- oder Aminosäurezusammensetzungen.
Geben Sie dieses Verhältnis manuell ein oder wählen Sie es aus einem aktiven
Spektrum aus. Dieser Rechner erstellt eine Tabelle mit den möglichen Element- oder
Aminosäurezusammensetzungen, die die relevante Masse und die entsprechenden
Eigenschaften ergeben.

Geben Sie Parameter wie Toleranz, Elektronenzustand und Anzahl der Ladungen ein bzw.
wählen Sie diese aus. Benutzer können ebenfalls eine Liste der möglichen Elemente
eingeben und die Anzahl für jedes einzelne Element begrenzen.

Rechner „Hypermass“
Der Rechner „Hypermass“ bestimmt die Verteilung einer mehrfach geladenen Hülle
basierend auf einer ungeladenen Masse. Benutzer können die ungeladene Masse
auswählen, einschließlich des Addukts und dessen Polarität.

Der Rechner zeigt eine grafische Darstellung der „Hypermass“-Serie, die das aktive
Spektrum überlagern kann. Eine Liste der „Hypermass“-Daten ist ebenfalls verfügbar.

Rechner „Elemental Targeting“
Der Rechner „Elemental Targeting“ reduziert das Datenspektrum basierend auf einer
bestimmten Vorlage, insbesondere basierend auf einer den Isotopenverteilungen
entsprechenden Vorlage. Er kann ebenfalls ein MS-Datenspektrum nach einem bestimmten
Peak-Muster durchsuchen, das entweder als Formel oder als Isotopenverteilung eingegeben
werden kann.

Wenn der Rechner eine Entsprechung findet, erstellt er eine reduzierte Abbildung, die
ausschließlich Daten des vorgegebenen Musters enthält. Für ein Spektrum entfernt der
Rechner alle Daten, die nicht dem Muster entsprechen. Für ein Chromatogramm berechnet
der Rechner das Elementenziel für jedes der zugrunde liegenden Spektren und erstellt jeden
Punkt im Chromatogramm auf Grundlage dieser neuen Spektren neu.

Rechner „Mass Property“
Der Rechner „Mass Property“ bestimmt verschiedene Eigenschaften, z. B. genaue Masse,
durchschnittliche Masse, Massengenauigkeit und Massendefekt der relevanten Masse. Die
von diesem Rechner generierten Ergebnisse sind abhängig von der Anzahl der ausgefüllten
Eingabefelder.
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Rechner „Isotopic Distribution“
Der Rechner „Isotopic Distribution“ bestimmt die Isotopenverteilung basierend auf der
eingegebenen Formel. Dies gibt Benutzern die Möglichkeit, zwischen Verbindungen mit den
gleichen Massen zu unterscheiden, basierend auf relativen Isotopenintensitäten.

Die berechnete Isotopenverteilung kann als Grafik oder in Textform im Fensterbereich
„Isotopic Distribution“ angezeigt werden, das aktive Spektrum überlagern oder in eine
separate Datei exportiert werden.

Zugriff auf die Rechner
Klicken Sie auf Tools > Calculators.

Abbildung 5-2: Dialogfeld „Calculators“

Das Dialogfeld „Calculators“ öffnet sich.

Zentrierte Peaks
Die Berechnung des Strichspektrums eines Peaks wandelt Peak-Verteilungswerte in einen
einzigen Wert von m/z und Intensität um und repräsentiert den Peak. Die Zentrierung von
im Profil-Modus gesammelten Daten vereinfacht die Daten und verringert die Dateigröße.
Die Zentrierung von Daten liefert genauere Peak-Zuordnungen und reduziert die Menge von
Daten, entfernt aber auch Informationen über die Peak-Form.

Der Strichspektrum-Algorithmus wandelt Peaks in Einzelwerte unter Verwendung eines
intensitätsgewichteten Durchschnittswertes um, um so den Schwerpunkt eines Peaks zu
berechnen. Der Algorithmus erzeugt eine Liste von Peaks mit Parametern, wie in der
folgenden Tabelle dargestellt.
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Tabelle 5-1: Peak-Parameter

Parameter Definition

Strichspek-
trumwert

Der Wert zentrierter Daten als Masse- oder Zeiteinheiten.

Intensität Die Intensität eines jeden Peaks in cps (Zählimpulsen pro Sekunde).

Breite Die Breite eines zentrierten Peaks in Da.

Die Daten werden automatisch als Strichspektrum berechnet, wenn diese zu einer Bibliothek
hinzugefügt werden oder eine Suche durchgeführt wird.

Berechnen des Strichspektrums eines Peaks
1. Wählen Sie einen Bereich mit einem Spektrum.

Durch die Berechnung des Strichspektrums des Peaks wird die Darstellung des
vorhandenen Diagramms geändert. Um das Ergebnis mit den ursprünglichen Daten
vergleichen zu können, erstellen Sie vor der Berechnung des Strichspektrums eine
Kopie des Diagramms.

2. Klicken Sie auf Explore > Centroid.
Die Daten werden zentriert.

Abbildung 5-3: Zentroidierte Lage des Analyten

Datenanalyse
Benutzer können Dateien öffnen, die vorhandene Daten enthalten oder Daten, die derzeit
erfasst werden. Alle experimentbezogenen Daten können außerdem in tabellarischer
Form angezeigt werden. Das Tabellen-Teilfenster besteht aus zwei Registerkarten, der
Registerkarte „Data List“ und der Registerkarte „Peak List“. Die Registerkarte „Data List“
enthält experimentbezogene Informationen, z. B. Erfassungsdauer und Scan-Intensität. Die
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Registerkarte „Peak List“ enthält Peak-bezogene Informationen z. B. Peakhöhe, Peakfläche
und Basislinientyp.

Gesamtionenchromatogramm
Ein Gesamtionenchromatogramm (TIC) wird erstellt, indem der Intensitätsbeitrag aller Ionen
einer Serie von Massen-Scans summiert wird. Benutzer können das TIC verwenden,
um den gesamten Datensatz in einem einzigen Fenster zu sehen. Er besteht aus den
summierten Intensitäten aller Ionen in einem Scan, die als Funktion der Zeit in einem
chromatographischen Bereich abgebildet werden. Wenn die Daten Ergebnisse aus mehreren
Experimenten enthalten, kann der Benutzer für jedes Experiment einen separaten TIC und
einen weiteren TIC erstellen, der die Summe aller Experimente darstellt. Das voreingestellte
TIC, das die Summe aller Versuche darstellt, wird mit einem Splitter-Tool unterhalb der Mitte
der x-Achse angezeigt.

Extrahiertes Ionenchromatogramm
Ein extrahiertes Ionenchromatogramm (XIC) wird erstellt, indem Intensitätswerte bei einem
diskreten Massenwert oder Massenbereich aus einer Reihe von massenspektrometrischen
Scans verwendet werden. Es zeigt das Verhalten einer bestimmten Masse oder eines
bestimmten Massenbereiches als Funktion der Zeit. Die Intensität der Ionen oder die
summierten Intensitäten aller Ionen in einem bestimmten Bereich werden in einem
chromatographischen Teilfenster angezeigt.

Basispeak-Chromatogramm
Ein Basispeak-Chromatogramm (BPC) zeigt die Intensität des intensivsten Ions in jedem
Zyklus als eine Funktion der Scan-Anzahl oder Retentionszeit. Es ist in den Fällen nützlich,
in denen ein TIC von Rauschen so stark überlagert wird, dass es zu einem großen Versatz
kommt und chromatographische Peaks nur schwer zu unterscheiden sind. Es ist auch
hilfreich, zwischen gleichzeitig eluierenden Komponenten zu unterscheiden. BPCs kann man
nur mit den Daten für eine bestimmte Periode und ein bestimmtes Experiment generieren.

Das Diagramm verwendet jedes Mal, wenn sich der Basispeak ändert, abwechselnd zwei
Farben. Der Farbenwechsel bleibt erhalten, wenn die Daten durch Scrollen oder Zoomen
bearbeitet werden. Informationen über die Auswahl der Farben in der Grafik finden Sie unter
Hilfe.

Extrahiertes Wellenlängen-Chromatogramm
Ein extrahiertes Wellenlängen-Chromatogramm (XWC) ist ein Wellenlängen-
Chromatogramm, das erzeugt wird, indem die Intensität einer bestimmten Wellenlänge oder
die Summe der Absorption für mehrere Wellenlängenbereiche verwendet wird.

Diodenanordnungsdetektor
Benutzer können das Spektrum des Diodenanordnungsdetektors (Diode Array Detektor,
DAD) für einen bestimmten Zeitpunkt oder eine Zeitspanne als Gesamtwellenlängen-
Chromatogramm (Total Wavelength Chromatogram, TWC) anzeigen.
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Gesamtwellenlängen-Chromatogramm
Ein Gesamtwellenlängen-Chromatogramm (TWC) ist ein weniger gebräuchliches
Chromatogramm. Es zeigt die gesamte Absorption (mAU) als eine Funktion der Zeit. Ein
TWC zeigt einen ganzen Datensatz in einem einzigen Fenster an. Es besteht aus den
summierten Absorptionen aller Ionen in einem Scan, die für einen chromatographischen
Bereich als zeitabhängige Funktion dargestellt werden. Wenn die Daten Ergebnisse aus
mehreren Experimenten enthalten, kann der Benutzer für jedes Experiment ein separates
TWC und ein weiteres TWC erstellen, das die Summe aller Experimente darstellt.

Überlagern von Diagrammen
Es können zwei oder mehrere Datensätze visuell verglichen werden, indem durch ähnliche
Verfahren erstellte Diagramme überlagert werden. Jedes Spektrum unterscheidet sich
durch die Farbe seiner Linien. Bei vollständigen Scan-Daten können Benutzer damit die
Unterschiede zwischen mehreren Probenspektren visualisieren.

Wenn ein oder mehrere Teilfenster ausgewählt werden, wird jeder XIC in einem eigenen
Teilfenster geöffnet.

Tipp! Um weniger als vier Diagramme im gleichen Teilfenster zu überlagern, drücken
Sie auf Ctrl, klicken Sie mit der rechten Maustaste in ein Teilfenster und dann auf
Appearance Options. Im Dialogfeld „Appearance Options“ auf der Registerkarte „Multiple
Graph Options“ wählen Sie Yes bei den Overlay Multiple Panes-Feldern für Spectrum und
Chromatogram.

1. Wählen Sie das erste Teilfenster, das überlagert werden soll.

2. Klicken Sie auf Explore > Overlay.

3. Klicken Sie in das zweite Teilfenster.

Die Diagramme werden überlagert und zeigen die beiden Linien in unterschiedlichen
Farben.

Tipp! Zur Anzeige der Farbcodierung der überlagerten Diagramme klicken Sie mit der
rechten Maustaste auf die Titelleiste des Fensters.

Wechseln des Zyklus zwischen überlagerten Diagrammen
1. Wählen Sie ein Teilfenster mit überlagerten Kurven.

2. Klicken Sie auf Explore > Cycle Overlays.
Die Ansicht ändert sich, so dass die nächste Kurve in der Reihe im Vordergrund
angezeigt wird.

Überlagerungen addieren
Wenn sich mindestens zwei Kurven überlagern, können Benutzer diese zusammenfassen
und eine neue Kurve erzeugen. Jeder Punkt auf der neuen Kurve ist die Summe der
Punkte aus den Diagrammen. Die Zusammenfassung mehrerer Überlagerungen eines
ähnlichen Datentyps kann die nachfolgende Verarbeitung einfacher und schneller machen.
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Zum Beispiel können Benutzer mehrere XICs überlagern, zusammenfassen und dann die
zusammengefasste Überlagerung glätten, um Rauschen zu entfernen.

Die Zusammenfassung von Überlagerungen ist dem Erstellen eines TICs ähnlich, bietet aber
den Vorteil, dass man bestimmen kann, welche Diagramme überlagert werden. Wenn z. B.
10 Versuche anzeigt werden, dann wird das TIC alle 10 Experimente aufaddieren. Nach
dem Summieren der Überlagerungen haben Benutzer die Möglichkeit, nur neun der zehn
überlagerten Diagramme hinzuzufügen. Dieses Verfahren kann verwendet werden, wenn die
Daten in einem Experiment nur aus Rauschen bestehen.

1. Überlagern Sie die zusammenzufassenden Diagramme.

2. Klicken Sie auf Explore > Sum Overlays.
Die überlagerten Graphen werden addiert.

Anpassen von Diagrammen
Diagramme können anhand eines voreingestellten Stils für Beschriftungen, Bildunterschriften
oder Texten auf Diagrammen und Chromatogrammen angepasst werden. Benutzer können
die Schriftarten für die Beschriftung von Peaks und Achsen und die Farben für die Linien
wählen. Benutzer können außerdem Achsenbeschriftungen, Beschriftungsarten und die
Präzision für Peaks hinzufügen.

Hinzufügen von Bildunterschriften zu einem Graph
Verwenden Sie Bildunterschriften zum Kennzeichnen von relevanten Peaks oder wichtigen
Punkten auf dem Diagramm. Wenn eine Beschriftung neben einen Peak platziert wird, dann
bleibt die Beschriftung bei diesem Peak, wenn das Diagramm vergrößert oder verkleinert
wird. Bildunterschriften bleiben bei der ursprünglichen Probe, wenn Benutzer zwischen den
Proben in einer Datei navigieren. Eine Beschriftung enthält eine Zeile mit Text mit maximal
128 Zeichen.

1. Klicken Sie mit der rechten Maustaste auf ein Spektrum und klicken dann auf Add
Caption.
Das Dialogfeld „Add Caption“ wird geöffnet.

2. Geben Sie im Feld Caption den Text ein.

3. Um die Größe und den Stil der Beschriftung zu ändern, klicken Sie auf Font.

4. Um die Beschriftung zu platzieren, klicken Sie auf OK.

Tipp! Wenn die Position der Beschriftung nicht zufriedenstellend ist, ziehen Sie diese
zu einer anderen Position. Die Beschriftung bleibt beim Vergrößern oder Verkleinern des
Diagramms an der gleichen Stelle in Bezug auf die X- und Y-Achse. Wenn Sie eine
Bildunterschrift bearbeiten oder löschen wollen, klicken Sie mit der rechten Maustaste
auf die Bildunterschrift und dann auf den entsprechenden Befehl.

Hinzufügen von Text zu einem Diagramm
Verwenden Sie die Textfunktion, um mehrere Zeilen mit Informationen zu einem Diagramm
hinzufügen. Anders als bei Beschriftungen, die einem bestimmten Peak zugeordnet sind
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und sich beim Vergrößern oder Verkleinern mit bewegen, bleiben Textbeschriftungen beim
Ändern der Ansicht auf den Diagrammen an ihrer ursprünglichen Position. Sie bleiben nicht
bei der ursprünglichen Probe, wenn Benutzer zwischen den Proben in einer Datei navigieren.

1. Klicken Sie mit der rechten Maustaste auf das Diagramm und klicken dann auf Add
User Text.
Der Dialog „Add User Text “ wird geöffnet.

2. Im Feld User Text geben Sie den Text ein.

3. Aktivieren Sie das Kontrollkästchen Center Text, um den Text zu zentrieren.

4. Um die Größe und den Stil der Beschriftung zu ändern, klicken Sie auf Font.

5. Um den Text einzufügen, klicken Sie auf OK.

Tipp! Wenn die Position des Textes nicht zufriedenstellend ist, ziehen Sie diesen zu
einer anderen Position. Wenn Sie einen Text bearbeiten oder löschen wollen, klicken
Sie mit der rechten Maustaste auf den Text und wählen Sie dann den entsprechenden
Befehl.

Compound Database (Datenbank für
chemische Verbindungen)
Die Datenbank für chemische Verbindungen speichert Informationen über Verbindungen,
einschließlich der Optimierungsspezifikationen. Verwenden Sie die Datenbank für chemische
Verbindungen, wenn viele Proben vorhanden sind und eine große Anzahl an Verbindungen
schnell optimiert werden muss. Das Fenster der Datenbank für chemische Verbindungen
speichert optimierte Bedingungen für Verbindungen, die für die Verarbeitung von Proben
abgerufen werden können. Weitere Informationen finden Sie im Dokument: Hilfe.

Konturdiagramm
Ein Konturdiagramm ist eine farbkodierte Darstellung eines kompletten Datensatzes, das mit
Hilfe von Farben eine dritte Dimension im Diagramm darstellt. In einem Konturdiagramm
eines TICs stellt die X-Achse die Retentionszeit oder Scannummer dar, die Y-Achse
repräsentiert die Masse und die Farbe die Intensität der Daten an diesem Punkt. In einem
Konturdiagramm eines TWCs für DAD-Daten repräsentiert die X-Achse die Retentionszeit
oder Scannummer, die Y-Achse repräsentiert die Wellenlänge und die Farbe repräsentiert
den Absorptionsgrad. „Contour Plot“ ist ein Tool, das nach der Erfassung eingesetzt wird und
funktioniert bei der Echtzeit-Scan-Erfassung nicht.

Hinweis: „Contour Plot“ unterstützt MI- oder MRM-Scans nicht, DAD-Scans werden jedoch
unterstützt.

Farbe ist die dritte Achse in einem Konturdiagramm und repräsentiert die Intensität
oder den Absorptionsgrad. Benutzer können die hohen und niedrigen Intensitäts- oder
Absorptionswerte in einem Konturdiagramm über Reglerdreiecke auf dem Farbbalken über
dem Konturdiagramm ändern. Die Prozent-Parameter über dem Konturdiagramm-Fenster
zeigen die Werte an, die in den niedrigen und hohen Schiebereglern eingestellt sind.
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Die tatsächlichen Werte basieren auf einem Prozentsatz der maximalen Intensität oder
Absorption im ausgewählten Bereich. Der Wert wird in der oberen rechten Ecke des Fensters
„Contour Plot“ angezeigt.

Die Steuerelemente, die in der folgenden Abbildung gezeigt werden, ändern die Farben in
einem Konturdiagramm.

Abbildung 5-4: Schaltflächen, die die Farben in einem Konturdiagramm regeln

Element Beschreibung

1 Keine Daten

2 Unter niedrigen Daten

3 Niedrige Daten

4 Hohe Daten

5 Über hohen Daten

Benutzer können die Farben in einer „Contour Plot“-Darstellung definieren, um einen
besseren Kontrast zu erzielen und Datenspezifikationen entsprechend ihren Bedürfnissen
anzuzeigen. Zum Beispiel kann die Einstellung der Intensität/Wellenlänge und das Ändern
der Farbe für die Werte Below Low Data und Above High Data Hintergrundrauschen in
einem Konturdiagramm eliminieren.

Die Below Low Data- und Above High Data-Schaltflächen verkleinern und erweitern sich
auf dem Farbbalken, wenn die Schieberegler bewegt werden. Wenn die Farben in einem
Konturdiagramm geändert werden, dienen die neuen Farben als voreingestellte Farben für
alle nachfolgenden Diagramme.

Tabelle 5-2: Rechtsklick-Menü für „Contour Plot Panes“

Befehl Funktion

Show DAD
Spectrum

(DAD-Spektrum anzeigen) Öffnet ein neues Teilfenster mit dem DAD-
Spektrum.

Extract
Wavelengths
(Use Range)

(Wellenlängen extrahieren (Bereich verwenden)) Extrahiert bis zu drei
Wellenlängenbereiche von einem DAD-Spektrum und zeigt ein XWC.
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Tabelle 5-2: Rechtsklick-Menü für „Contour Plot Panes“ (Fortsetzung)

Befehl Funktion

Extract
Wavelengths
(Use Maximum)

(Wellenlängen extrahieren (Maximum verwenden)) Extrahiert
Wellenlängenbereiche mit maximalen Wellenlängen.

Zoom to
selection

(Zoom auf Auswahl) Vergrößert den ausgewählten Bereich.

Add User Text (Benutzertext hinzufügen) Fügt ein Textfeld an der Position des
Mauszeigers ein.

Undo Zoom (Vergrößern oder verkleinern rückgängig machen) Setzt das Diagramm
wieder auf den ursprünglichen Maßstab.

Delete Pane (Teilfenster löschen) Löscht das ausgewählte Teilfenster.

Show Cross-
Hair

(Fadenkreuz anzeigen) Zeigt das Fadenkreuz (nm/min).

Anzeigen eines Konturdiagramms
Das Konturdiagramm kann erst nach der Erfassung angezeigt werden. Benutzer können ein
Konturdiagramm aus TIC-, XIC-, TWC- oder XWC-Diagrammen anzeigen. TICs und XICs
sind für alle wiff-Datendateien verfügbar. TWCs und XWCs sind nur für Daten verfügbar, die
durch DAD oder PDA erfasst wurden.

1. Im „Explore“-Modus öffnen Sie eine Datei als TIC-, XIC-, TWC- oder XWC-Grafik.

2. Markieren Sie den Bereich, der im Konturdiagramm angezeigt werden soll. Wenn keine
Auswahl getroffen wird, wird der gesamte Bereich angezeigt.

3. Klicken Sie auf Explore > Show > Show Contour Plot.
Ein Konturdiagramm des ausgewählten Bereichs wird in einem separaten Fenster
geöffnet.

Tipp! Um ein Teilfenster „Contour Plot“ zu schließen, klicken Sie mit der rechten
Maustaste in das Teilfenster „Contour Plot“ und anschließend auf Delete Pane.

Auswählen eines Bereichs in einem Konturdiagramm
Zum Vergrößern der Ansicht einer bestimmten Auswahl oder zum Anzeigen des
entsprechenden Massenspektrums für diese Auswahl wählen Sie eine der folgenden
Vorgehensweisen:

• Um einen Standardbereich in einer Box auszuwählen, ziehen Sie den Mauszeiger und
erzeugen Sie ein Rechteck um einen Bereich im Konturdiagramm.

• Um eine vertikale Auswahl zu treffen, drücken Sie Ctrl und ziehen Sie dann den
Mauszeiger vertikal.
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• Um eine horizontale Auswahl zu treffen, drücken Sie die Leertaste und ziehen Sie den
Mauszeiger horizontal.

Festlegen der Intensität und des Absorptionsgrads in
einem Konturdiagramm
Führen Sie einen der folgenden Schritte aus:

• Um die Werte für eine niedrige Intensität/Absorptionsgrad in einem Konturdiagramm
einzustellen, ziehen Sie den linken dreieckigen Regler aus der Farbleiste über dem
Konturdiagramm in die gewünschte Position.

Das Konturdiagramm passt die Farbe der Werte unterhalb der Einstellung automatisch an
und zeigt an, dass sie sich außerhalb des Bereichs befinden.

• Um die Werte für eine hohe Intensität/Absorptionsgrad in einem Konturdiagramm
einzustellen, ziehen Sie den rechten dreieckigen Regler aus der Farbleiste über dem
Konturdiagramm in die gewünschte Position.

Das Konturdiagramm passt die Farbe der Werte oberhalb der Einstellung automatisch an
und zeigt an, dass sie sich außerhalb des Bereichs befinden.

Ändern der Farben in einem Konturdiagramm
Tipp! Mit der Palette „Define Custom Colors“ können Benutzer benutzerdefinierte Farben
erstellen, um diese in einem Konturdiagramm zu verwenden.

1. Klicken Sie im Teilfenster „Contour Plot“ auf eine der Farbschaltflächen.
Das Dialogfeld „Color“ wird geöffnet.

Hinweis: Es gibt fünf Schaltflächen, die die Farbe im Konturdiagramm steuern. Bei jeder
dieser Schaltflächen wird der Name angezeigt, wenn der Cursor auf der Schaltfläche
verbleibt. Dadurch wird sichergestellt, dass die korrekte Funktion geändert wird.
Zusätzlich verkleinern und erweitern sich die „Below Low Data“- und „Above High Data“-
Tasten auf dem Farbbalken, wenn der Benutzer die Schieberegler bewegt. Nachdem der
Benutzer die Konturdiagrammfarben geändert hat, werden diese die Standardfarben für
alle nachfolgenden Diagramme.

2. Klicken Sie auf eine Farbe.

3. Klicken Sie auf OK.
Die Grafik ändert sich, um die Farbänderung widerzuspiegeln.

Dynamic Background Subtraction-Algorithmus
Der Dynamic Background Subtraction-Algorithmus verbessert die Detektion von Vorläufer-
Ionen in einem IDA-Experiment (Information Dependent Acquisition). Wenn der Algorithmus
aktiviert wird, verwendet IDA zur Auswahl des relevanten Vorläufer-Ions für eine MS/MS-
Analyse ein Spektrum, dessen Hintergrund subtrahiert wurde, anstatt den Vorläufer direkt
aus dem Übersichtsspektrum zu wählen. Da dieser Prozess während einer LC-Analyse
stattfindet, ermöglicht der Algorithmus den Nachweis von Spezies, wenn deren Signal an
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Intensität zunimmt. Daher konzentriert sich dieser Algorithmus auf die Detektion und Analyse
von Vorläufer-Ionen im ansteigenden Abschnitt bis hin zur Spitze eines LC-Peaks oder leicht
darüber hinaus.

Fragment Interpretation
Mit dem Fragment Interpretation Tool können Benutzer MS/MS-Daten interpretieren. Das
„Fragment Interpretation Tool“ generiert eine Liste der theoretischen Fragmentmassen aus
einzelnen, nicht-zyklischen Bindungsspaltungen einer molekularen Struktur. Die molekulare
Struktur kann im Zeichenprogramm eines Drittanbieters erstellt und anschließend als .mol-
Datei gespeichert werden. Das Tool kann dann theoretische Listen mit Peaks im aktuellen
Massenspektrum abgleichen. „Fragment Interpretation“ zeigt die theoretischen Fragmente in
der Fragmentliste und vergleicht die Fragmentmassen mit den Peaks im Massenspektrum.
Peaks oberhalb der Intensitätsschwelle und innerhalb der vom Benutzer definierten
Massentoleranz (maximal 2 Da) der Fragmentmassen gelten als passend und werden in
der Fragmentliste in Fettdruck angezeigt.

Hinweis: Das Fragment Interpretation Tool kann mit den folgenden Scantypen nicht
verwendet werden:

• Vorläufer-Ion

• Neutralverlust

• Q1 Multi-Ionen-Scan

• Q3 Multi-Ionen-Scan

• Multiple Reaction Monitoring (MRM)

Verbinden des Fragment Interpretation Tools
mit einem Spektrum
Wenn eine einzelne, nicht-zyklische Bindung in der molekularen Struktur ausgewählt ist,
markiert das Fragment Interpretation Tool die zwei Fragmente, die bei der Spaltung der
Bindung erzeugt werden und zeigt dann die passenden Peaks im damit verknüpften
Spektrum an.

Bei der Anzeige von Multi-Spektrum-Fenstern stellt das Fragment Interpretation Tool eine
Verbindung mit dem aktiven Spektrum her. Enthält die Datei mehr als eine Probe, dann stellt
das Fragment Interpretation Tool eine Verbindung mit dem aktiven Spektrum her.

Wenn ein Spektrum bei geöffnetem Fragment Interpretation Tool geöffnet wird, stellt das
aktive Teilfenster automatisch eine Verbindung mit dem offenen Spektrum her.

1. Klicken Sie auf Explore > Show > Show Fragment Interpretation Tool.

2. In der unteren rechten Ecke des Fragment Interpretation Teilfensters klicken Sie auf die
Schaltfläche „Connect“.
Der Zeiger ändert sich zum Verbindungs-Tool.
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3. Klicken Sie auf das Spektrumdiagramm, das mit dem Fragment Interpretation Tool
verbunden werden soll.
Die Anzeige für verknüpfte Diagramme in der unteren linken Ecke enthält den
Namen des Diagramms, mit dem das Teilfenster „Fragment Interpretation“ verknüpft
ist. Die Verbindung wird unterbrochen, wenn entweder die Grafik oder die Fragment
Interpretation geschlossen wird. Wenn die verknüpfte .wiff-Datei mehr als eine Probe
enthält, wird das Teilfenster „Fragment Interpretation“ automatisch aktualisiert, wenn
Benutzer durch die Proben blättern.

Zuordnen von Fragmenten zu Peaks
1. Klicken Sie auf Explore > Show > Show Fragment Interpretation Tool.

2. Wählen Sie mit einer im Teilfenster „Fragment Interpretation“ geöffneten .mol-Datei eine
Zelle in der Fragmentliste aus, die in Fettschrift dargestellt wird.
Im Spektrum markiert die Software den passenden spektralen Peak in der Farbe, die
in der Registerkarte „Options“ ausgewählt wurde. In der molekularen Struktur wird die
Bindung markiert.

3. Wenn eine Zeile angeklickt wird, die mehr als ein passendes Fragment enthält,
wird der Spektral-Peak, der seiner monoisotopischen Masse am nächsten ist, im
Massenspektrum in der Farbe markiert, die in der Registerkarte „Options“ festgelegt
wurde.

Auswählen einer Bindung in einer molekularen Struktur
1. Klicken Sie auf Explore > Show > Show Fragment Interpretation Tool.

2. Mit einer im Teilfenster „Fragment Interpretation“ geöffneten mol-Datei klicken Sie auf
eine einzelne nicht-zyklische Bindung in der molekularen Struktur.

Die beiden resultierenden Fragmente werden in der Fragmentliste markiert angezeigt.
Die Massen der beiden Fragmente werden auf beiden Seiten der Bindung angezeigt.

Wenn ein Spektrum angeschlossen ist, zeigt das Fragment Interpretation Tool alle
übereinstimmenden Peaks auf der Kurve. Wenn ein Fragment in der Liste auswählt
und das Fragment einem Peak zugeordnet wurde, vergrößert das Fenster „Fragment
Interpretation“ diesen Peak.

Anzeigen von Isotopen
Das Fragment Interpretation Tool kann die theoretische Isotopenverteilung für einen Peak
anzeigen, der einem Fragment in der Fragmentliste entspricht.

1. Klicken Sie auf Explore > Show > Show Fragment Interpretation Tool.

2. Im Teilfenster „Fragment Interpretation“ klicken Sie auf die Registerkarte Options.

3. Aktivieren Sie das Kontrollkästchen Show Isotopes.

4. Klicken Sie auf Apply.

5. Wählen Sie aus der Fragmentliste ein Fragment aus, das einem Peak entspricht.
Die Isotopenverteilung für passende Peaks wird im Spektrum angezeigt.
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Anzeigen einer Formeldifferenz in einem Spektrum
Zwischen zwei hypothetischen Fragmenten kann die Formel- und monoisotopische
Massendifferenz angezeigt werden. Die Formeldifferenz wird bei Auswahl von zwei Peaks
angezeigt. Die Formel- und monoisotopische Massendifferenz wird angezeigt, wenn zwei
Fragmente oder zwei einzelne nicht-zyklische Bindungen ausgewählt werden.

1. Klicken Sie auf einen Fragment-Peak.

2. Drücken Sie Shift und klicken Sie dann auf einen anderen Fragment-Peak.
Wenn die Formeldifferenz einem Fragment aus der Fragmentliste entspricht, wird das
Fragment in der Liste markiert. Andernfalls wird die Formeldifferenz zwischen den
passenden Fragmenten der Peaks in einem Meldungsfeld angezeigt.

Anzeigen einer Formeldifferenz in der Fragmentliste
1. Klicken Sie auf die Zeilennummer für ein Fragment.

2. Drücken Sie Ctrl und klicken Die dann auf ein weiteres Fragment.
Die Formel und monoisotopische Massendifferenz wird in einem Meldungsfeld
angezeigt, wenn die Fragmente verwandt sind.

Anzeigen einer Formeldifferenz in einer molekularen
Struktur
1. Klicken Sie auf eine einzelne nicht-zyklische Bindung. Das voreingestellte Fragment

(der beiden markierten Fragmente) wird ausgewählt. Um das andere Fragment der
gespaltenen Bindung auszuwählen, drücken Sie Ctrl und klicken dann auf die Bindung.

2. Wählen Sie eine zweite nicht-zyklische Bindung. Um das voreingestellte Fragment
auszuwählen, drücken Sie Shift und klicken dann auf die Bindung. Um das andere
Fragment der gespaltenen Bindung auszuwählen, drücken Sie Ctrl + Shift und klicken
Sie dann auf die Bindung.
„Fragment Interpretation“ berechnet die Formel und monoisotopische Massendifferenz
zwischen dem Fragment, das in Schritt 1 ausgewählt wurde, und dem Fragment, das
in Schritt 2 ausgewählt wurde, wenn die Fragmente verwandt sind. Die Formel- und
monoisotopische Massendifferenz wird in einem Meldungsfeld angezeigt.

IDA-Explorer
Der Information Dependent Acquisition (IDA)-Explorer wird verwendet, um Daten
anzuzeigen, die mit einer IDA-Methode erfasst wurden.

Auf der Registerkarte „IDA Explorer“ im Dialogfeld „Appearance Options“ können Sie den
IDA-Explorer aus- und einschalten. Außerdem können in dieser Registerkarte die Spalten
definiert werden.

Die linke Seite der Anzeige in der folgenden Abbildung zeigt die Massen, mit denen ein
Produkt-Ionen-Scan durchgeführt wurde. In diesem Bereich können Benutzer die Masse,
Intensität, Zeit und Stoßenergie von Ionen, mit denen Produkt-Ionen-Scans durchgeführt
wurden, in einer Listen- oder Strukturansicht untersuchen. In der Listenansicht haben Sie die
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Möglichkeit, die Liste durch Doppelklicken auf jede Spaltenüberschrift zu sortieren. Über das
Dialogfeld „Appearance Options“ können Sie die Spalten der Listenansicht anpassen.

Auf der rechten Seite ist die Anzeige in vier Fensterbereiche unterteilt. Im linken oberen
Teilfenster werden die Probe-TIC-Daten angezeigt. Im linken unteren Teilfenster wird der
XIC der Masse angezeigt. Das obere rechte Teilfenster zeigt das Experiment oder das
Experiment im Wechsel mit ER-Scans (Enhanced Resolution, erweiterte Auflösung) an. Im
unteren rechten Teilfenster wird der Produkt-Scan angezeigt.

Die IDA-Anzeige führt alle Massen auf, mit denen Scans des Typs EPI (Enhanced Product
Ion, Erweitertes Produkt-Ion) oder ER durchgeführt wurden. In der IDA-Anzeige können
Benutzer folgende Aktionen ausführen:

• Eine Masse in der Listen- oder Strukturansicht anzeigen, um für diese Masse relevante
Darstellungen anzuzeigen.

• Das Übersichtsspektrum, aus dem die Masse ermittelt wurde, und das Produktspektrum
dieser Masse anzeigen.

• Das TIC des Vorläuferscans und das XIC für jede Masse anzeigen.

Hinweis: Klammern um eine Masse zeigen an, dass die Masse zusammengefasst wurde.
Eine zusammengefasste Masse ist über eine Reihe von Zyklen fortlaufend. Wenn eine
zusammengefasste Masse angezeigt wird, wird ein durchschnittliches Spektrum angegeben,
das den Durchschnitt aller fortlaufender Spektren enthält.

Abbildung 5-5: IDA-Anzeige
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Bibliotheksdatenbanken
Die Funktion „Library Search“ vergleicht unbekannte Spektren mit bekannten MS-Spektren
in einer Bibliotheksdatenbank und erstellt eine Liste der möglichen Übereinstimmungen.
Verwenden Sie „Library Search“, um eine Massenspektren-Datenbank zu erstellen und zu
verwalten, die zum Suchen unbekannter Spektren und deren Abgleich mit in der Datenbank
gespeicherten Massenspektren dient.

Mit „Library Search“ können Benutzer Folgendes tun:

• Den Inhalt der Bibliothek mit unbekannten Spektren vergleichen.

• Datensätze zur Bibliothek hinzufügen.

• Vorhandene Datensätze bearbeiten.

Bibliothekdaten können an folgenden Orten gespeichert werden:

• MS Access auf einer lokalen Datenbank.

• MS SQL Server.

Bevor Sie die Funktion „Library Search“ verwenden, ermitteln Sie, wo die
Bibliotheksdatenbank gespeichert ist, und stellen Sie zwischen Ihrem Computer und diesem
Speicherort eine Verbindung her. Bibliotheksdatenbanken können lokal auf einem Computer
oder Server über ein Netzwerk abgerufen werden.

Verwenden Sie einen Aliasnamen, um die Verbindung zur Datenbank herzustellen. In diesem
Fall bezieht sich der Aliasname auf eine Verbindung zu einer bestimmten Datenbank
und kann den Benutzernamen und das Passwort, die für den Zugriff auf die Datenbank
erforderlich sind, beinhalten. So kann ein Benutzer beispielsweise auf seinem Computer
über eine kleine Bibliotheksdatenbank mit identifizierten Verbindungen verfügen, während
die Organisation über eine zentrale Datenbank verfügt, die gelegentlich von Benutzern
verwendet wird. Durch die Erstellung eines Aliasnamens für jede Datenbank kann der
Benutzer schnell zwischen den einzelnen Datenbanken umschalten. Klicken Sie auf
Hilfe, um weitere Informationen zum Erstellen von Aliasnamen und die Verbindung mit
Datenbanken zu erhalten.

Wechseln zwischen vorhandenen Bibliotheksdaten
Benutzer können sich mit jeder Datenbank verbinden, die über bereits eingerichtete
Aliasnamen verfügt.

1. Klicken Sie auf Tools > Settings > Optimization Options.
Das Dialogfeld „Optimization Options“ wird geöffnet.

2. Klicken Sie auf die Registerkarte Library Manager.
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Abbildung 5-6: Dialogfeld „Optimization Options“ – Registerkarte „Library
Manager“

3. Klicken Sie im Abschnitt Available Libraries auf das Alias der Datenbank, mit der Sie
eine Verbindung herstellen wollen und klicken dann auf Connect.

4. (Optional) Um anderen Benutzern Zugriff auf die Datenbank zu geben, aktivieren Sie
das Kontrollkästchen Available to all users of this machine.

5. Klicken Sie auf OK.

Erstellen einer lokalen Bibliotheksdatenbank
1. Klicken Sie auf Tools > Settings > Optimization Options.

Der Dialog „Optimization Options“ wird geöffnet.

2. Klicken Sie auf die Registerkarte Library Manager.
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Abbildung 5-7: Dialogfeld „Optimization Options“ – Registerkarte „Library
Manager“

3. Klicken Sie im Abschnitt Available Libraries auf New.

Das Dialogfeld „Add Library“ wird geöffnet.
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Abbildung 5-8: Dialogfeld „Add Library“

4. Geben Sie im Feld Enter a Name for the Library einen Namen für die Bibliothek ein.

5. Wählen Sie im Abschnitt Database Information die Option MS Access (local) aus.

6. Geben Sie den Speicherort der Datenbank ein.

7. Geben Sie im Abschnitt Security Information den Benutzernamen und das Passwort
ein, um bei Bedarf auf die Datenbank zuzugreifen.

8. Klicken Sie auf Save.

Herstellen einer Verbindung mit einer Server-
Bibliotheksdatenbank
1. Klicken Sie auf Tools > Settings > Optimization Options.

Der Dialog „Optimization Options“ wird geöffnet.
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2. Klicken Sie auf die Registerkarte Library Manager.

Abbildung 5-9: Dialog „Optimization Options“ – Registerkarte „Library Manager“

3. Im Abschnitt Available Libraries klicken Sie auf New.

Der Dialog „Add Library“ wird geöffnet.

4. Geben Sie im Feld Enter a Name for the Library einen Namen für die Bibliothek ein.

5. In Abschnitt Database Information wählen Sie MS SQL Server.
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Abbildung 5-10: Dialog „Add Library“

6. Geben Sie den Namen des Datenbank-Servers ein.

7. Geben Sie den Namen der Datenbank ein.

8. Führen Sie einen der folgenden Schritte aus:

• Geben Sie gegebenenfalls einen für den Zugriff auf die Datenbank notwendigen
Benutzernamen und das Kennwort ein.

• Zur Verwendung von Windows-Security klicken Sie in den Abschnitt „Security
Information“ und wählen Sie die Option Use Windows integrated security.

9. Klicken Sie auf Save.

Anzeigen aller Bibliotheksdatensätze
Klicken Sie auf Explore > Library Search > List.
Das Dialogfeld „Librarian“ wird mit allen Datensätzen in der Datenbank geöffnet.

Hinzufügen eines Datensatzes zur Bibliothek
1. Klicken Sie mit der rechten Maustaste auf ein aktives Spektrum und dann auf Add a

Record.
Das Spektrum wird automatisch als Strichspektrum berechnet. Das Dialogfeld „Add a
Record“ wird mit den Daten aus dem Spektrum geöffnet.
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2. Geben Sie auf der Registerkarte „Mass Spectral Information“ einen Namen im Feld
Compound Name ein.
Der Verbindungsname ist obligatorisch und muss die Verbindung in der Bibliothek
eindeutig identifizieren.

3. Bearbeiten Sie eines der anderen Felder. Viele der Felder werden automatisch mit den
Daten gefüllt, die dem Spektrum zugeordnet sind.

4. Klicken Sie auf die Registerkarte General Information.

5. Bearbeiten Sie die Felder nach Bedarf.

6. Klicken Sie auf OK.

Suchen nach Bibliotheksdatensätzen mit Einschränkungen
Verwenden Sie die „List with Constraints“, um die Ergebnisse einzuschränken. Nach
einmaliger Festlegung werden die Einschränkungen auf alle Suchen angewandt.

1. Klicken Sie auf Explore > Library Search > List With Constraints.

Abbildung 5-11: Dialogfeld „List Constraints“

Das Dialogfeld „List Constraints“ wird geöffnet.

2. In der Liste Field Name wählen Sie ein Feld, auf dem die Einschränkung basieren soll.

3. In der Liste Relation wählen Sie die Beziehung (den Operator), der für diesen
Feldnamen Anwendung findet.
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4. Im Feld Value geben Sie auf der Grundlage der Beziehung den Wert des Feldnamens
ein.

5. Um die ausgewählte Einschränkung zur Liste Conditions hinzuzufügen, klicken Sie auf
Add.

6. Fügen Sie gegebenenfalls weitere Einschränkungen zur Bedingungsliste hinzu.

7. Wenn man Einschränkungen mit der Liste Conditions kombiniert, entstehen
spezifischere Bedingungen, die die Suche verbessern. Zum Gruppieren der
Einschränkungen wählen Sie die Einschränkungen und klicken Sie dann auf Group. Um
gruppierte Einschränkungen wieder zu trennen, klicken Sie auf die Gruppe und klicken
Sie dann auf Ungroup.

8. Um Beziehung zwischen Einschränkungen zu ändern, klicken Sie auf die Beziehung und
klicken Sie dann auf And oder Or.

9. Um Verbindungen mit einer bestimmten Anzahl von Atomen bestimmter Elemente
einzuschließen, wählen Sie diese Elemente aus der Tabelle Elements Included oder
geben Sie diese darin ein und geben Sie dann eine minimale und maximale Atom-
Anzahl des Elements ein.

Hinweis: Bei Element-Symbolen muss die Groß- und Kleinschreibung beachtet werden.
Beispielsweise ist Wasserstoff „H“ und nicht „h“ und Natrium ist „Na“ und nicht „NA“ oder
„na“.

10. Um Verbindungen mit bestimmten Elemente auszuschließen, wählen Sie diese
Elemente aus der Tabelle Excluded.

11. Um nach den Verbindungen entsprechend den Kriterien zu suchen, klicken Sie auf List.
Datensätze, die allen Einschränkungen entsprechen, werden in der Tabelle Records
aufgeführt. Einschränkungen für Listen werden gespeichert.

Tipps zur Bibliothek-Suchfunktion
Ziel Aufgabe

Gruppieren von Bedingungen Wählen Sie die zu gruppierenden
Bedingungen aus und klicken Sie dann
auf Group. Diese Funktion hat die gleiche
Funktionsweise wie Klammern in Formeln.

Suchen ohne Einschränkungen Klicken Sie mit der rechten Maustaste auf
ein aktives Spektrum und dann auf Search
Library.

Das Dialogfeld „Search Results“ wird
geöffnet.

Suchen nach einem ähnlichen Spektrum
Der Benutzer kann die Bibliothek nach einem Spektrum (und seinen zugehörigen
Verbindungsinformationen) durchsuchen, das dem aktiven Spektrum entspricht (oder ähnlich
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ist). Es kann mit oder ohne Einschränkungen gesucht werden. Wenn der Benutzer
mit Einschränkungen sucht, werden nur diejenigen Datensätze aufgelistet, die alle
Einschränkungen erfüllen. Die Ergebnisse werden in einer Rangliste angezeigt. Der erste
Punkt auf der Liste passt am besten zum aktiven Spektrum. Einträge weiter unten in der
Liste passen nicht so gut.

Je mehr Einschränkungen gewählt werden, desto genauer wird die Liste und desto
weniger, relevantere Treffer werden aufgelistet. Nachdem eine Reihe von Einschränkungen
definiert wurde, gelten diese für alle nachfolgenden Suchvorgänge, es sei denn, sie werden
bearbeitet. Wenn ein Benutzer ohne Einschränkungen sucht, ist die Liste an möglichen
Spektren viel größer, weil die Bibliothek viel weniger spezifische Übereinstimmungen mit den
Spektraldaten findet.

Nur Peaks über dem Schwellwert werden in der Suche verwendet. Bei der Auswahl der
Sucheinschränkungen kann der Benutzer auch Peaks aus dem aktiven Spektrum addieren
oder subtrahieren.

Wenn ein Benutzer vermutet, dass ein Peak eigentlich eine Hintergrund- oder Rausch-Spitze
ist, dann sollte der Peak von der Suche ausgeschlossen werden, da dieser ungenaue
Ergebnisse produzieren könnte.

1. Klicken Sie mit der rechten Maustaste auf ein aktives Spektrum und dann auf Search
With Constraints.
Die Software berechnet automatisch das Strichspektrum.

2. Im Feld Maximum Number of Match geben Sie die maximale Anzahl von Verbindungen
ein, die eine Suche anzeigen soll.
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Abbildung 5-12: Dialogfeld „Search Constraints“

3. Im Abschnitt Preselect Constraints aktivieren Sie die Kontrollkästchen, die für die
Einschränkungen gelten sollen.

4. Für jede gewählte Einschränkung geben Sie im Abschnitt Preset Tolerance die Toleranz
ein.

5. Wählen Sie gegebenenfalls ein Verfahren zum Sortieren von Datensätzen aus der Liste
Result Sorted by.

6. Geben Sie gegebenenfalls einen Text in das Feld Comment Contains ein.

7. Geben Sie gegebenenfalls einen Text in das Feld Keyword Contains ein.

8. Um Peak-Einschränkungen durch das Hinzufügen und Entfernen von Peaks zu
übernehmen, klicken Sie auf Peak Constraints.
Die Tabelle „Peaks Included“ wird geöffnet.

9. Um Peaks zur Liste hinzuzufügen, die bei der Suche verwendet werden soll, klicken Sie
auf Add und geben dann die m/z-Werte und die entsprechende Intensität in der leeren
Zelle ein.

10. Um Peaks zu entfernen, damit sie nicht in die Suche einbezogen werden, wählen Sie die
entsprechenden Peaks aus und klicken Sie dann auf Remove.
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11. Klicken Sie auf Search, um die Einschränkungen zu speichern und die Suche zu
starten.

Anzeigen einer Verbindung aus den Suchergebnissen
Wenn mehrere Spektren mit dem unbekannten Spektrum übereinstimmen, können Benutzer
bedarfsweise die bekannten Spektren anzeigen und mit dem unbekannten vergleichen.

1. Wählen Sie im Dialog „Search Results“ in der Liste der Verbindungen die anzuzeigende
Zeilennummer der Verbindung aus.

2. Klicken Sie auf das Spektrum-Teilfenster einer der bekannten Verbindungen.
Das Spektrum der ausgewählten Verbindung wird angezeigt.

Verarbeitete Datendateien
Der Benutzer kann verarbeitete Daten, z. B. bestimmte Layouts und Beschriftungen,
speichern, die nur im „Explore“-Modus geöffnet werden können. Diese Dateien enthalten
auch Verlaufsinformationen und sind Datendateien ähnlich, enthalten aber nur Daten aus
dem aktiven „Explore“-Teilfenster. Diese Dateien haben die pdt-Erweiterung und werden im
Datenordner des aktuellen Projekts gespeichert.

Speichern verarbeiteter Dateien
1. Wählen Sie das zu speichernde Datenfenster aus.

2. Klicken Sie auf File > Save Processed Data File.

3. Geben Sie im Feld File name den Namen ein.

4. Klicken Sie auf Save.

Öffnen einer verarbeiteten Datei
1. Klicken Sie im Modus Explore auf File > Open Processed Data File.

Der Dialog „Load Processed Data File“ wird geöffnet.

2. Wählen Sie eine Datei und klicken Sie auf Open.

Qualitative Daten
Der Benutzer kann die in einer Datei enthaltenen Informationen als Tabelle oder Diagramm
anzeigen. Grafische Daten werden entweder als Chromatogramm oder als Spektrum
angezeigt. Die Daten in der Tabelle werden als Datenpunkte angezeigt. Der Benutzer kann
verschiedene Sortiervorgänge mit den Daten durchführen.

Wenn der Benutzer eine Datendatei öffnet, werden in Abhängigkeit von der Art des
durchgeführten Experiments verschiedene Teilfenster angezeigt.

Wird das Kontrollkästchen MCA im Tune Method Editor aktiviert, dann wird die Datendatei
für das MS (Massenspektrum) geöffnet. Wird das Kontrollkästchen MCA nicht aktiviert, dann
wird beim Öffnen der Datei der TIC angezeigt. Wählen Sie zunächst einen Bereich aus
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und doppelklicken Sie dann im TIC-Fenster auf eine bestimmte Zeit, um das MS für diesen
Bereich anzuzeigen.

Die Software speichert Daten in Dateien mit einer .wiff- oder wiff.scan-Erweiterung.
Datendateien können Daten für mehr als eine Probe enthalten. Zum Öffnen der Datendatei
benötigt die Software sowohl wiff- als auch wiff.scan-Dateien. Zusätzlich zu Datendateien
kann die Software txt-Dateien öffnen. .txt-Dateien enthalten nur Daten für eine Probe.

Signal-Rausch-Verhältnis
Das Signal-Rausch-Verhältnis ist die Peak-Höhe geteilt durch das Rauschen.

Für die Berechnung des Rauschens verwendet die Software die Standardabweichung (mit
einem Mittelwert von null) aller Datenpunkte im Chromatogramm vom Zeitpunkt Background
Start bis zum Zeitpunkt Background End (beide werden in den erweiterten Parametern für
den Quantitation Method Editor und das Fenster „Peak Review“ angezeigt). Diese Zeitpunkte
werden beim Definieren eines neuen Hintergrundbereichs eingestellt.

Wenn der Benutzer eine Methode erstellt, ohne einen neuen Hintergrundbereich festzulegen
(was möglich ist, wenn die voreingestellte Integration ohne Änderungen angenommen wird),
werden die Werte für Background Start und Background End als N/A angezeigt. Aus
diesem Grund wird das Signal-Rausch-Verhältnis nicht berechnet und das entsprechende
Feld in der „Results Table“ zeigt N/A an.

Glättungsalgorithmen
Der Benutzer kann den Glättungsalgorithmus oder den Gauß'schen Glättungsalgorithmus
als gewünschte Glättungsmethode einstellen. Bei der Glättung wird jeder Datenpunkt durch
den Mittelwert aus dem vorherigen und dem folgenden Datenpunkt ersetzt. Der geglättete
Datensatz ersetzt den alten Satz.

Daten können mehrmals geglättet werden, wobei die Software jeweils nur die letzte Glättung
rückgängig machen kann.

Glättung steht für Multiple Ion (MI)- oder MRM-Spektren nicht zur Verfügung.

Glättungsalgorithmus

Beim Glätten von Daten legt der Benutzer die Punkt-Gewichtungswerte für drei
Datenpunkte fest: den aktuellen Punkt, den vorhergehenden Punkt und den folgenden
Datenpunkt. Der Glättungsalgorithmus multipliziert die Datenpunkte mit den zugewiesenen
Gewichtungswerten, addiert diese Werte und teilt die Summe durch die Summe der Punkt-
Gewichtungswerte. Dies ist eine sanftere Glättung als der Gaußsche Algorithmus und es
dauert lange, bis sehr verrauschte Daten geglättet sind.

Gauß'scher Glättungsalgorithmus

Bei der Gauß'schen Glättung wird jeder Datenpunkt durch den gewichteten Durchschnitt
einer Anzahl von Datenpunkten ersetzt, die sich auf beiden Seiten des Datenpunktes
befinden. Die Gewichtung für jeden neuen Datenpunkt wird auf der Grundlage einer
Gauß'schen Kurve berechnet. Dies ist eine gröbere Glättung als beim Glättungsalgorithmus,
eignet sich aber gut für die Glättung stark verrauschter Daten.
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Verwenden Sie zwei Werte bei der Gauß'schen Glättungsmethode:

Gaussian filter width (% of minimal distance between points): Die Breite, die bei
der Berechnung der Gewichtung benachbarter Punkte verwendet wird. Die Breite wird
als Prozentsatz des Abstandes zwischen zwei Punkten im Scan angegeben, wobei die
vorgegebene Breite von 100 % eine Verteilung erreicht, die so breit wie der Abstand
zwischen den Datenpunkten ist.

Limit of Gaussian filter (number of minimal distance between points): Die Grenzen
der Gauß-Kurve, angezeigt als Vielfaches des Abstandes zwischen Punkten. Zum Beispiel
erzeugt der voreingestellte Wert von 10 eine Gauß-Kurve, welche die Breite auf 10
Datenpunkte beiderseits des Mittelpunkts beschränkt.

Glätten von Daten mit dem Glättungsalgorithmus
Tipp! Um eine Glättung rückgängig zu machen, klicken Sie auf Edit > Undo. Die Software
unterstützt einmaliges Rückgängigmachen.

1. Wählen Sie einen Bereich mit einem Chromatogramm oder Spektrum.

2. Klicken Sie auf Explore > Smooth.
Der Dialog „Smoothing Options“ wird geöffnet.

Abbildung 5-13: Dialog „Smoothing Options“

3. Im Feld Previous Point Weight geben Sie den Gewichtungsfaktor ein, der auf den
vorherigen Datenpunkt angewendet werden soll.

4. Im Feld Current Point Weight geben Sie den Gewichtungsfaktor ein, der auf den
mittleren Datenpunkt angewendet werden soll.

5. Im Feld Next Point Weight geben Sie den Gewichtungsfaktor ein, der auf den nächsten
Datenpunkt angewendet werden soll.

6. Klicken Sie auf OK.
Der Datensatz wird geglättet und ersetzt den aktuellen Datensatz im Teilfenster.
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Glätten von Daten mit der Gauß'schen Glättung
Tipp! Um die Glättung rückgängig zu machen, klicken Sie auf Edit > Undo. Die Software
ermöglicht es, einen Schritt rückgängig zu machen.

1. Wählen Sie einen Bereich mit einem Chromatogramm oder Spektrum.

2. Klicken Sie auf Explore > Gaussian Smooth.
Das Dialogfeld „Gaussian Smooth“ wird geöffnet.

Abbildung 5-14: Dialogfeld „Gaussian Smooth Options“

3. Im Feld Gaussian filter width (Gaußfilterbreite) geben Sie die Breite ein, die bei
der Gewichtung benachbarter Punkten als Prozentsatz des Abstandes zwischen zwei
Punkten verwendet werden soll.

4. Geben Sie im Feld Limit of gaussian filter die Grenze der Gaußkurve ein, die als
Vielfaches des Abstandes zwischen Punkten angegeben wird.

5. Klicken Sie auf OK.
Der Datensatz wird geglättet und ersetzt den aktuellen Datensatz im Teilfenster.

Systemprotokolle
Das Systemprotokoll enthält Berichte über Systemereignisse wie Fehlermeldungen,
Warnhinweise und Benachrichtigungen. Verwenden Sie den „Windows Event Viewer“,
um Informationen anzuzeigen, die bei der Fehlersuche und bei der Durchführung einer
Systemdiagnose hilfreich sein könnten. Um die Informationen aus dem Systemprotokoll
wirksam einzusetzen, filtern Sie diese Informationen so, dass nur die softwarerelevanten
Elemente angezeigt werden.

Um die Informationen in den Systemprotokollen zu verstehen und Fehler zu behandeln,
siehe das Windows-Anwendungsereignisprotokoll. Dieses enthält relevante Informationen
zur Problembehandlung.

Speichern des Systemprotokolls und Weiterleiten an den
Support
1. Klicken Sie auf View > Event Log.
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2. Klicken Sie auf das Pluszeichen rechts vom Ordner Windows Logs.

3. Klicken Sie mit der rechten Maustaste auf Application.

4. Klicken Sie auf Save All Events As.
Das Dialogfeld „Save As“ wird geöffnet.

5. Geben Sie einen Dateinamen ein und klicken dann auf Save.
Das Dialogfeld „Display Information“ wird geöffnet.

6. Klicken Sie auf Display information for these languages.

7. Stellen Sie sicher, dass English (United States) ausgewählt ist.

8. Klicken Sie auf OK.

9. Senden Sie die Datei als Anhang einer E-Mail an SCIEX.

Hinweis: Für zusätzliche Anmeldefunktionen zur Problembehandlung wenden Sie sich
an sciex.com/request-support.

Filtern des Systemprotokolls nach Informationen, die für
die Analyst MD Software relevant sind
1. Klicken Sie auf View > Event Log.

Das Dialogfeld „Event Viewer“ wird geöffnet.

2. Doppelklicken Sie auf den Ordner Windows Logs.

3. Klicken Sie auf Application.

4. Klicken Sie auf Action > Filter Current Log.
Das Dialogfeld „Filter Current Log“ wird geöffnet.

5. Wählen Sie Analyst im Feld Event Sources aus.

6. Klicken Sie auf OK.
Das Dialogfeld „Event Viewer“ zeigt jetzt nur die gefilterten Analyst MD Software-
Ereignisse an.
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Quantitative Datenanalyse 6
Kalibrierungsoptionen
Die Kalibrierungsoptionen definieren die Parameter für eine Kalibrierkurve, die zur
Bestimmung der berechneten Konzentration der Proben verwendet werden. Die Kurve ist
eine Abbildung der Konzentration des Standards in Abhängigkeit vom Bereich oder von
der Höhe des Standards, wenn kein interner Standard verwendet wird. Wenn ein interner
Standard verwendet wird, ist die Kurve eine Abbildung des Konzentrationsverhältnisses
in Abhängigkeit vom Bereichs- oder Höhenverhältnis. Die Kurve wird verwendet, um
gemeinsam mit dem Bereich (oder der Höhe) für die Unbekannten die berechnete
Konzentration zu interpolieren.

Ermitteln Sie die beste Regressionsart oder die beste Passung, die die Kurve an die Punkte
anpasst, und den besten Gewichtungsfaktor für das Projekt.

Über Kalibrierkurven
Eine Kalibrierkurve wird zur Bestimmung der berechneten Konzentration von Proben
verwendet, einschließlich QC (Qualitätskontroll)-Proben. Es handelt sich hierbei um eine
Kurve, die durch Darstellung der Konzentration eines Standards im Verhältnis zur Fläche
oder Höhe erzeugt wird, oder zu Verhältnissen, wenn ein interner Standard verwendet wird.
Um die Konzentration einer Probe zu finden, wird die Flächen- oder Höhe einer Probe
auf diese Kurve angewendet und in der Ergebnistabelle dargestellt. Mit der von dieser
Kalibrierkurve generierten Regressionsgleichung wird die Konzentration der unbekannten
Proben berechnet.

Die Software platziert die bekannten Konzentrationen (oder Verhältnisse) auf der x-Achse
und den berechneten Bereich oder die berechnete Höhe (oder Verhältnisse) auf der y-Achse.
Dann bildet sie die Punkte für alle Standards im Batch ab. Das System erstellt eine
Kurve mit der besten Passung für diese Punkte anhand der gewählten Regressions- und
Gewichtungsart. Die Kurve wird verwendet, um gemeinsam mit dem Bereich (oder der Höhe)
für die Unbekannten die Konzentration zu interpolieren.

Auswählen der besten Regressionsart
Nach Auswahl einer Regressionsart (Passung) können die Benutzer die Kalibrierkurve vom
Assistenten aus nicht sehen. Verwenden Sie stattdessen die voreingestellten Werte oder
nutzen Sie Ihre Erfahrung bzw. die Richtlinien Ihres Unternehmens zur Auswahl einer
Regressionsart.

Nachdem Sie die Passung geändert haben, müssen Sie die Spalte Accuracy in der
„Results Table“ auf Änderungen überprüfen. Je besser die Passung ist, umso besser fällt
die Genauigkeit der quantitativen Analyse aus.

Die Kalibrierkurve bildet die Konzentration des Standards im Verhältnis zu dessen Peak-
Fläche oder Höhe (oder Verhältnissen, wenn ein interner Standard verwendet wird) ab.
Wenn die Punkte für die Standards abgebildet sind, müssen Sie die beste Passung für
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die Kurve zu diesen Punkten festlegen und die Auswahl im Dialogfeld „Specify Calibration“
im Assistenten angeben. Die voreingestellte Passung ist linear, wobei davon ausgegangen
wird, dass alle Standards auf eine Gerade fallen. Treffen Sie eine Auswahl aus den
Passungstypen in der folgenden Tabelle.

Tabelle 6-1: Passungstypen

Passung Beschreibung

Linear Lineare Regression geht davon aus, dass die Standardpunkte eine
Gerade bilden.

Linear durch Null Die lineare Regression durch den Ursprung geht davon aus, dass die
Standardpunkte eine Gerade bilden und dass die Gerade der Punkte
durch den Nullpunkt auf der X- und Y-Achse verläuft. Verwenden Sie
diese Einstellung, um die Gerade dazu zu zwingen, durch den Nullpunkt
zu verlaufen.

Quadratisch Wenn die Standardpunkte keine Gerade bilden, dann verwenden Sie
die quadratische Regression, um eine quadratische Passung für die
Datenpunkte zu produzieren.

Mittlerer
Reaktionsfaktor

Wenn die Standardpunkte eine Gerade ergeben und Sie den
Durchschnitt der Punkte bilden möchten, verwenden Sie die
Regressionsart des durchschnittlichen Ansprechfaktors, um einen
Durchschnitt der Steigung für jeden Punkt auf der Kurve zu produzieren.

Betrieb Wenn die Linie der Punkte teils linear und teils gekrümmt ist,
verwenden Sie anstatt der linearen oder quadratischen Regression die
Potenzregression, um eine Linie zu produzieren, die sich irgendwo
zwischen diesen Passungen befindet.

Auswählen des besten Gewichtungsfaktors
Die Kalibrierkurve bildet die Konzentration des Standards im Verhältnis zu dessen Peak-
Fläche oder -Höhe ab. Wenn die Punkte für die Standards abgebildet sind, legen Sie den
besten Gewichtungsfaktor für diese Punkte fest und geben Sie Ihre Wahl im Dialogfeld
„Specify Calibration“ an. Die voreingestellte Passung ist None, damit wird angenommen,
dass alle Punkte auf der Kurve von gleicher Bedeutung sind. Treffen Sie eine Auswahl
aus den Gewichtungsarten in der folgenden Tabelle. Weitere Informationen finden Sie im
Abschnitt: Gewichtungsfaktoren.

Tabelle 6-2: Gewichtungsarten

Weighting Beschreibung

1/x Verwenden Sie einen Gewichtungsfaktor von 1/x, um Punkten mit
niedrigeren Werten eine zusätzliche Gewichtung zu verleihen.

1/x2 Verwenden Sie eine Gewichtung von 1/x2, um Punkten mit niedrigeren
Werten eine bedeutend höhere Gewichtung zu verleihen.
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Tabelle 6-2: Gewichtungsarten (Fortsetzung)

Weighting Beschreibung

1/y Verwenden Sie einen Gewichtungsfaktor von 1/y , wenn Sie eher
nach Bereich (y-Achse) als nach Konzentration (x-Achse) kalibrieren
und wenn Punkten mit niedrigeren Werten eine gewisse Gewichtung
zukommen muss. Eine Gewichtung von 1/y ist eine Variante von 1/x,
wobei y und x proportional zueinander sein sollten.

1/y2 Verwenden Sie einen Gewichtungsfaktor von 1/y2, wenn Sie eher nach
Bereich (y-Achse) als nach Konzentration (x-Achse) kalibrieren und
wenn Punkten mit niedrigeren Werten eine viel höhere Gewichtung
zukommen muss. Eine Gewichtung von 1/y im Quadrat ist eine Variante
von 1/x im Quadrat, wobei y und x proportional zueinander sein sollten.

In x Verwenden Sie den Logarithmus von x, um Punkten mit höheren Werten
eine stärkere Gewichtung zu verleihen.

In y Verwenden Sie den Logarithmus von y, um Punkten mit höheren Werten
eine stärkere Gewichtung zu verleihen. Zu verwenden, wenn Sie nach
Bereich (y-Achse) statt nach Konzentration (x-Achse) kalibrieren.

Integrationsalgorithmen
Die Analyst MD Software verfügt über zwei Integrationsalgorithmen: den ursprünglichen
Analyst Classic- und den IntelliQuan-Integrationsalgorithmus. Der IntelliQuan-Algorithmus
bietet eine konsistentere Peak-Suche und integrierte Funktionen, bei denen weniger
Parameter angepasst werden müssen.

Analyst Classic- und IntelliQuan-Integrationsalgorithmen
Der IntelliQuan-Algorithmus verwendet einen von zwei Peak-Suchparametern: Automatic
IQA II (Einstellung ohne Parameter) oder Specify Parameters MQ III. Nachdem Sie
die Peaks mithilfe des IntelliQuan-Algorithmus integriert haben, können Sie den Peak-
Suchparameter wählen, der für den Datensatz am besten geeignet ist. Hierfür nutzen Sie die
Peak-Integrationsparameter, die im Fensterbereich oder Fenster „Peak Review“ angezeigt
werden.

Die folgende Tabelle zeigt die Parameter, die mit dem Analyst Classic-Algorithmus verfügbar
sind.

Tabelle 6-3: Analyst Classic-Algorithmus

Parameter Definition

Default
Bunching
Factor

Die Anzahl der Punkte, deren Mittelwert gebildet wird und die zum
Zweck der Peak-Suche als ein Punkt betrachtet werden.
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Tabelle 6-3: Analyst Classic-Algorithmus (Fortsetzung)

Parameter Definition

Default Number
of Smooths

Die Anzahl der Glättungen des Chromatogramms.

Default Void
Volume
Retention Time

Alle Peaks, die vor diesem Zeitpunkt auftreten, werden ignoriert.

Default
Concentration
Units

Die Konzentrationseinheiten, die zur Beschreibung der
Probenkonzentration verwendet werden, z. B. pg/μl.

Default
Calculated
Concentration
Units

Die Konzentrationseinheiten, die zur Beschreibung der berechneten
Probenkonzentration verwendet werden, z. B. pg/μl.

Default RT
Window

Das Zeitfenster in der Mitte der erwarteten Retentionszeit für die
Peak-Suche. Beispiel: Ein 30-sekündiges Retentionszeitfenster enthält
zusätzliche 15 Sekunden vor und nach der erwarteten Retentionszeit.

Die folgende Tabelle zeigt die beim MQ III-Algorithmus, jedoch nicht beim IQA II-Algorithmus
verfügbaren Parameter.

Tabelle 6-4: MQ III-Algorithmus

Parameter Definition

Default Noise
Percentage

Der bei der Peak-Suche verwendete Schwellenwert. Es werden nur
Peaks festgestellt, die über diesem festgelegten Prozentsatz liegen.

Default
Baseline
Subtraction
Window

Ein Zeitfenster um jeden Datenpunkt, das verwendet wird, um die Höhe
der Basislinienkorrektur zu bestimmen, die für diesen Punkt angewendet
werden soll. Dieses Zeitfenster hilft dabei, starkes Rauschen aus dem
Chromatogramm zu entfernen. Die Basislinie wird definiert als Linie,
die den Punkt der geringsten Intensität auf der linken Seite eines
vorgegebenen Datenpunkts mit dem Punkt der geringsten Intensität auf
der rechten Seite innerhalb des jeweiligen Fensters verbindet.

Default Peak-
Splitting Factor

Kontrolliert, ob ein bestimmtes Peak-Cluster aus mehreren
zusammenhängenden Peaks oder aus einem (möglicherweise
verrauschten) Peak besteht. Wenn die Senke der Intensitätswerte
geringer als der angegebene Wert ist, wird ein einzelner Peak gemeldet.
Andernfalls teilt der Punkt mit der geringsten Intensität in der Senke
das Cluster in zwei separate Peaks. Durch das Einstellen eines hohen
Faktors wird vermieden, dass Cluster in mehr als einen Peak geteilt
werden.
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Tabelle 6-4: MQ III-Algorithmus (Fortsetzung)

Parameter Definition

Default Void
Volume
Retention Time

Alle Peaks, die vor diesem Zeitpunkt auftreten, werden ignoriert.

Report Largest
Peak

Durch die Auswahl dieses Parameters wird der höchste Peak
im Retentionszeitfenster ausgegeben. Wenn dieser Parameter nicht
ausgewählt wird, dann wird der Peak gefunden, der der erwarteten
Retentionszeit am nächsten ist. Die erwartete Retentionszeit wird im
Quantitation Wizard automatisch berechnet.

Die folgende Tabelle zeigt die Parameter, die für die Verwendung mit beiden IntelliQuan-
Algorithmen verfügbar sind.

Tabelle 6-5: IntelliQuan-Algorithmus sowohl für IQA II als auch für MQ III

Parameter Definition

Default Minimum
Peak Height

Die für die Peak-Integration erforderliche Mindesthöhe eines Peaks.

Default Minimum
Peak Width

Die für die Peak-Integration erforderliche Mindestbreite eines Peaks.

Default RT
Window
(Standard-RT-
Fenster)

Legt das Zeitfenster in der Mitte der erwarteten Retentionszeit für
die Peak-Suche fest. Beispiel: Ein 30-sekündiges Retentionszeitfenster
enthält zusätzliche 15 Sekunden vor und nach der erwarteten
Retentionszeit.

Default
Smoothing
Width

Die Anzahl der in der Datenglättung verwendeten Punkte.

Default
Concentration
Units

Die Konzentrationseinheiten, die zur Beschreibung der
Probenkonzentration verwendet werden, z. B. pg/μl.

Default
Calculated
Concentration
Units

Die Konzentrationseinheiten, die zur Beschreibung der berechneten
Probenkonzentration verwendet werden, z. B. pg/μl.

Werkzeuge zum Erstellen von
Quantifizierungsmethoden
Die Software stellt vier Werkzeuge zum Erstellen von Quantifizierungsmethoden zur
Verfügung, von denen jedes eine vollständig funktionale Methode erstellt. Die Auswahl des
am besten geeigneten Werkzeugs hängt davon ab, welche Aufgabe ausgeführt werden
muss.
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Es wird empfohlen, dass nur diejenigen Benutzer Erfassungs- und Quantifizierungsmethoden
erstellen oder ändern, die mit der Methodenentwicklung vertraut sind.

Weitere Informationen über Rollen und Sicherheit finden Sie im Abschnitt: Über Benutzer
und Rollen im Dokument: Handbuch für Laborleiter.

Assistenten
Die verfügbaren Assistenten zur Erstellung von Methoden sind der Standard Quantitation-
Assistent und der Automatic Quantitation-Assistent. Mit beiden Assistenten hat der Benutzer
die Möglichkeit, die Charge bzw. die Chargen zu wählen, die quantifiziert werden sollen,
eine Quantifizierungsmethode zu erstellen oder auszuwählen und dann die Probendaten zu
integrieren.

Der Unterschied zwischen den Assistenten besteht in der Art der erstellten Methode.
Der Standard Quantitation-Assistent erstellt eine Standardmethode, während der Automatic
Quantitation-Assistent eine Methode erstellt und automatisch eine „Results Table“ generiert.
Bei dem Automatic Quantitation-Assistenten ist die Verifizierung der Peaks nicht Bestandteil
der Methodenerstellung. Die Peaks können jedoch nach durchgeführter Integration überprüft
werden.

Eine Überprüfung der Peaks ist nur in einer Situation nicht erforderlich: Wenn die
Quantifizierung ausschließlich zum Zwecke der Integration durchführt wird und nicht,
um Konzentrationen zu finden. Dies kann beispielsweise nötig sein, wenn eine Charge
vorhanden ist, der unterschiedliche Verbindungen in jeder Probe enthält, oder wenn die
Masse jeder Probe unterschiedlich ist. In diesem Fall sollten Sie den automatischen
Assistenten verwenden. Andernfalls verwenden Sie den Standard Quantitation-Assistenten
zur Durchführung der Quantifizierung.

Verwenden Sie den Standard Quantitation Wizard, nachdem Sie die Probe erfasst haben,
um Folgendes zu tun:

• eine repräsentative Probe auswählen

• die Peaks von Analyten und internem Standard auswählen

• die Parameter für Peak-Suche und Integration anpassen

• Peaks während der Methodenerstellung überprüfen

• die Kalibrierung auswählen.

Verwenden Sie den automatischen Quantifizierungsassistenten, um eine Charge
auszuwählen, eine Methode zu erstellen (ohne Peak-Bestätigung) und dann die
Probendaten zu integrieren. Dieser Assistent ist schneller als der Standard Quantitation-
Assistent und erfordert nicht, dass die gescannten Massen für alle Proben gleich sind.
Er bietet jedoch nicht die Möglichkeit, einen internen Standard auszuwählen – alle Ionen
werden als Analyten behandelt.

Verwenden Sie den Automatic Quantitation Wizard, nachdem Sie die Probe erfasst haben,
wenn Sie:

• die Kalibrierung auswählen möchten

• keine Parameter für die Peak-Suche und Integration anpassen möchten
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• keine Analyten-Peak-Namen auswählen möchten

• keine internen Standards verwenden möchten

• die Peaks während der Methodenerstellung nicht überprüfen möchten oder wenn Sie
verschiedene Verbindungen in jeder Probe haben

Wenn die Peaks nur integriert werden, müssen sie nicht überprüft werden, da keine
Konzentrationsberechnung erforderlich ist. Verwenden Sie in diesem Fall den Automatic
Quantitation-Assistenten, der es ermöglicht, die Peaks nach durchgeführter Integration zu
überprüfen.

Peak-Suche mit einer automatischen Methode
Die Software verwendet den Standardprozess zur Peak-Erkennung, mit den folgenden
Ausnahmen:

• Sie verwendet den Bündelungsfaktor und die Anzahl der Glättungen (aus dem
Assistenten) unverändert.

• Sie berechnet die erwartete Retentionszeit und die Schwellenwerte für Rauschen und
Bereich für jeden Peak einzeln.

Quantitation Method Editor
Verwenden Sie diese Option, nachdem Sie die Probe erfasst haben, um Folgendes zu tun:

• die Parameter für Peak-Suche und Integration anpassen

• die Peaks von Analyten und internem Standard auswählen

• die Kalibrierung auswählen.

Verwenden Sie den Quantitation Method Editor für die folgenden drei Aufgaben:

• Summieren von Ionen für die Integration

• Verwenden eines internen Standards aus einem anderen Zeitraum oder Experiment (falls
der interne Standard in einem anderen Zeitraum oder Experiment als der Analyt erfasst
wurde)

• Bearbeiten einer vorliegenden Methode.

Der halbautomatische Method Editor
Der Semi-Automatic Quantitation Method Editor ist Bestandteil des Batch Editors.
Verwenden Sie den Semi-Automatic Quantitation Method Editor vor der Datenerfassung zur
Auswahl von Quantifizierungsinformationen wie Probentyp und Probenkonzentration. Durch
diese Vorbereitung werden nachfolgende quantitative Analysen einfacher. Alternativ kann
eine vollständige Methode im Batch Editor ausgewählt werden, die dann automatisch am
Ende der Batch-Ausführung angewandt wird, um die Ergebnistabelle der Quantifizierung zu
generieren.

Verwenden Sie nicht die automatisch generierte Quick Quant-Methode zur Quantifizierung,
wenn die Quick Quant-Funktion dazu verwendet wird, Probentypen und Konzentrationen in
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der Datei zu speichern. Diese Quantifizierungsmethode verwendet keine verbindungs- und
probenspezifischen Integrationsparameter, die für die Peak-Auswahl optimiert wurden.

Verwenden Sie diese Option in den folgenden Szenarien, wenn Sie:

• noch keine Proben mit derselben Erfassungsmethode erfasst haben

• Namen und Massen für die Peaks von Analyten und internem Standard auswählen
möchten

• Konzentrationen und Probentypen auf der Registerkarte „Quantitation“ im Batch Editor
auswählen möchten, jedoch keine andere Quantifizierungsmethode haben

• die Quantifizierungsmethode gegebenenfalls zu einem späteren Zeitpunkt bearbeiten
möchten.

Peak-Suche mit einer halbautomatischen Methode
Die Software verwendet den Standardprozess zur Peak-Erkennung, mit den folgenden
Ausnahmen:

• Sie verwendet den Bündelungsfaktor (aus dem Dialog „Quantitation Method Options“)
und die Anzahl der Glättungen (aus dem Dialog „Create Semi-Automatic Quantitation
Method“) unverändert.

• Sie verwendet den Standard mit der höchsten Konzentration als repräsentative Probe.
Für die Festlegung der Retentionszeit verwendet sie den höchsten Peak des jeweiligen
Chromatogramms.

• Für die Einstellung von Rausch- und Bereichsschwellenwerten verwendet sie das
resultierende Grundrauschen. (Dieser Prozess ist identisch mit der Vorgehensweise, mit
der die voreingestellten Werte für Peaks in normalen Methoden festgelegt werden.) Diese
Integrationsparameter werden auf alle anderen Proben angewandt.

• Wenn der untersuchte Batch nicht die Quantifizierungsinformationen (Probentyp und
Konzentrationen) enthält, werden die Retentionszeit und Schwellenwerte für jeden Peak
einzeln berechnet (wie bei vollautomatischen Methoden).

Metrische Kurven
Eine metrische Kurve bildet graphisch die Daten der Spalte einer „Results Table“ gegenüber
der X- oder Y-Achse ab, oder sie bildet gegenüberstellend die Daten zweier Spalten ab.
Dieser Abschnitt beschreibt, wie man metrische Kurven generiert und mit ihnen arbeitet.

Einige vordefinierte metrische Kurven sind ebenfalls enthalten:

• Int_Std_Response (zum Finden von problematischen Proben)

• Analyte_Area gegenüber Höhe (zum Überprüfen des chromatographischen Verhaltens)

• PK-Profil (Konz. gegenüber Zeitpunkt, wird nach Beispielabfragen durchgeführt)

Mit metrischen Kurven kann man aus einer „Results Table“ eine bestimmte Spalte abbilden,
z. B. Analyte Peak Area, Accuracy oder Calculated Concentration. Es können auch
zwei Ergebnistabellen-Felder gegeneinander abgebildet werden. Es können dann Punkte
untersucht werden, die außerhalb des normalen Bereichs angezeigt werden. Metrische
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Kurven werden oft mit Abfragen verwendet. Weitere Informationen über Abfragen finden Sie
im Dokument: Hilfe.

So können metrische Kurven erzeugt werden:

• Mit der Schaltfläche Plot stellen Sie eine oder mehrere Spalten der aktuellen „Results
Table“ dar, speichern aber die Darstellungskriterien nicht.

• Erstellen Sie eine tabellenspezifische Darstellung, damit Sie die Darstellungskriterien mit
der aktuellen Tabelle speichern können.

• Erstellen Sie globale Darstellungskriterien und speichern Sie diese für die Verwendung
mit zukünftigen Ergebnistabellen.

Proben des Typs QC, Unbekannt, Leerproben, Doppelleerproben und Lösungsmittelproben
können nicht auf der Kalibrierkurve angezeigt werden. Es können jedoch metrische Kurven
aus ihnen erzeugt werden.

Abbildung 6-1: Beispiel einer metrischen Kurve für die Peak-Fläche des internen
Standards in Abhängigkeit des Probenindex

Element Beschreibung

1 Doppelte Blindproben

Generieren einer temporären metrischen Kurve
1. Bei geöffneter Ergebnistabelle führen Sie einen der folgenden Schritte aus:

• Um die Daten der y-Achse mit der x-Achse als Index zu zeichnen, klicken Sie auf die
Spaltenüberschrift der zu zeichnenden Daten.

• Um die Daten der ersten ausgewählten Spalte auf der x-Achse und die Daten der
zweiten ausgewählten Spalte auf der y-Achse zu zeichnen, wählen Sie zwei Spalten,
indem Sie die Strg-Taste gedrückt halten und gleichzeitig auf die Spaltenüberschriften
klicken.
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2. Oberhalb der Ergebnistabelle klicken Sie auf das Symbol Metric Plot by Selection.
Die metrische Kurve wird geöffnet.

3. Klicken Sie mit der rechten Maustaste in das Kurven-Teilfenster und klicken Sie dann auf
„Data Legend“, um eine Erklärung der in der Kurve verwendeten Farben zu erhalten.

4. Klicken Sie mit der rechten Maustaste in das Kurven-Teilfenster und klicken Sie dann auf
„Point Legend“, um eine Erklärung der in der Kurve verwendeten Symbole zu erhalten.

Generieren einer metrischen Kurve und Speichern der
Darstellungskriterien
1. Öffnen Sie eine entsprechende Ergebnistabelle.

2. Klicken Sie mit der rechten Maustaste in die „Results Table“ und dann auf Metric Plot >
New.

Abbildung 6-2: Dialogfeld „Metric Plot“

3. Geben Sie in das Feld Name den Namen für das neue Darstellungskriterium ein.

4. Wählen Sie in der „X-Axis“-Gruppe in der Liste Group die Option Index aus und lassen
Sie dann die Liste Column leer, um ein Feld in der Y-Achse mithilfe der X-Achse als
Index abzubilden.
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5. Wählen Sie bei Bedarf in der „Y-axis“-Gruppe in der Liste Group die Option Internal
Standard aus und wählen Sie dann in der Liste Column die Option IS Peak Area aus,
um zwei Spalten in Abhängigkeit voneinander aufzuzeichnen.

6. Wählen Sie falls erforderlich in der Liste Regression den zu verwendenden
Regressionstyp und wählen Sie dann die entsprechenden Regressionseinstellungen.

7. Um die Kurve zu generieren und die Darstellungskriterien zu speichern, klicken Sie auf
Save/Execute.
Die metrische Kurve wird geöffnet. Für weitere Informationen siehe die Abbildung:
Abbildung 6-1.

8. Klicken Sie mit der rechten Maustaste in das Kurven-Teilfenster und klicken Sie dann auf
Data Legend und Sie erhalten eine Erklärung der in der Kurve verwendeten Farben.

9. Klicken Sie mit der rechten Maustaste in das Kurven-Teilfenster und klicken Sie dann auf
Point Legend und Sie erhalten eine Erklärung der in der Kurve verwendeten Symbole.
Dieser Kriteriensatz ist ab sofort für zukünftige Darstellungen dieser Ergebnistabelle
verfügbar. Klicken Sie mit der rechten Maustaste in die Ergebnistabelle, um auf die
Kriterien zuzugreifen. Die Darstellungskriterien können ebenfalls bearbeitet werden.

10. Zur Anzeige der problematischen Probe versuchen Sie die Konzentration der
Unbekannten gegen die Zeit oder die Fläche des internen Standards gegen den Index
zu zeichnen.

Speichern von Standard-Darstellungskriterien für
zukünftige Ergebnistabellen
1. Klicken Sie mit der rechten Maustaste in die Ergebnistabelle und klicken Sie dann auf

Table Settings > Export To New Table Settings.
Dadurch werden die Tabelleneinstellungen aus der rdb-Datei exportiert, damit sie
in anderen Quantifizierungsläufen innerhalb des Projekts erneut verwendet werden
können.

2. Um die Tabelleneinstellungen in ein anderes Projekt zu exportieren, klicken Sie auf
Tools > Project > Copy Data.
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Abbildung 6-3: Dialog „Copy Data“

Rausch- und Bereichsschwellenwert-Parameter
Zum Erkennen von Peaks benötigt die Software eine Reihe von Rausch- und
Bereichsschwellenwert-Parametern. Die Software stellt diese Parameter zu Beginn ein,
Benutzer können sie jedoch zu einem späteren Zeitpunkt verändern. Die Software legt die
Parameter wie folgt fest:

1. Die Software berechnet die höchste Intensitätsdifferenz zwischen zwei
aufeinanderfolgenden Datenpunkten. Diese Zahl stellt die Differenz zwischen zwei
Intensitäten dar, nicht die Intensität an sich.

2. Für jedes aufeinanderfolgende Paar, dessen Intensitätsdifferenz niedriger ist als 5 %
des in Schritt 1 berechneten Wertes, berechnet die Software die Standardabweichung
(mit einem Mittelwert von null) der Intensitätsdifferenzen. Die Software verwendet
nicht diejenigen Punktpaare, bei denen die Intensitätsdifferenz größer ist als 5 % des
Höchstwertes.

• Der Rausch-Schwellenwert entspricht der in Schritt 2 berechneten
Standardabweichung.

• Der Bereichsschwellenwert entspricht dem Fünffachen des Rausch-Schwellenwertes.
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Hinweis: Der Mindestwert für Rausch- und Bereichsschwellenwert liegt bei 0,000001.
Wenn die vorherigen Berechnungen einen Wert ergeben, der unter diesem
Mindestwert liegt, setzt die Software diesen Schwellenwert auf 0,000001 zurück.

Erneute Berechnung von Rausch- und
Bereichsschwellenwert
Wenn ein neuer Hintergrundbereich definiert wird, berechnet die Software die Rausch- und
Bereichsschwellenwerte neu und wie nachfolgend beschrieben.

Für jedes aufeinanderfolgende Datenpunkt-Paar berechnet die Software die
Standardabweichung (mit einem Mittelwert von null) der Intensitätsdifferenz. Die Analyst MD
Software verwendet alle Punkte im ausgewählten Bereich, da die Software ausdrücklich
darüber informiert ist, dass der ausgewählte Bereich Hintergrundrauschen ist.

• Der Rausch-Schwellenwert entspricht der aus dem ausgewählten Bereich berechneten
Standardabweichung.

• Der Bereichsschwellenwert entspricht dem Fünffachen des Rausch-Schwellenwertes.

Hinweis: Der Mindestwert für Rausch- und Bereichsschwellenwert liegt bei 0,000001.
Wenn die vorherigen Berechnungen einen Wert ergeben, der unter diesem Mindestwert
liegt, setzt die Software diesen Schwellenwert auf 0,000001 zurück.

Peak-Integration
Die Folgenden sind Integrationsarten, anhand derer die Basislinie nach der Peak-Suche
gefunden und integriert wurde.

• Manual: Der Peak wurde manuell vom Benutzer integriert.

• Automatic: Der Peak wurde automatisch folgendermaßen integriert:

• Baseline-to-baseline: Die Peak-Fläche wird durch Lotfällung am Anfang und am
Ende des Peaks definiert, wobei die senkrechte Linie bis zur Basislinie reicht. Dieser
Integrationstyp ist ausschließlich für Peaks geeignet, in deren unmittelbarer Umgebung
sich kein anderer Peak befindet.

• Valley: Ebenso wie Baseline-to-Baseline, abgesehen von der Tatsache, dass diese
Integrationsart ausschließlich für Peaks geeignet ist, in deren unmittelbarer Umgebung
sich ein anderer Peak befindet.

• Exponential Skim: Die Peak-Fläche ist der Haupt- oder übergeordnete Peak in einer
exponentiellen Abtrennung.

• Exponential Child: Die Peak-Fläche ist der untergeordnete Peak in einer
exponentiellen Abtrennung.

Peak-Bewertung
Während der Peak-Bewertung können Benutzer die Peaks, die die Software ausgewählt hat,
untersuchen und dann den Peak oder die Start- und Endpunkte ggf. neu definieren.
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Im Allgemeinen ist die Software sehr gut dazu in der Lage, die Peaks von Analyten
und internen Standards genau zu identifizieren. Aus einer Vielzahl an Gründen, zu denen
die Probenerfassung und die Definition der Quantifizierungsmethode zählen, verfehlt die
Software jedoch manchmal den korrekten Peak, wählt den falschen oder ist gar nicht in der
Lage, einen Peak zu finden. In anderen Fällen kann es vorkommen, dass die Software den
Peak zwar richtig identifiziert, Benutzer jedoch mit den ausgewählten Start- und Endpunkten
nicht einverstanden sind.

Tipps zur Peak-Bewertung
Ziel Aufgabe

Peak Integration: um Peaks zu überprüfen Um alle Peaks zu überprüfen, stellen
Sie sicher, dass alle Proben in der
Ergebnistabelle aufgelistet sind.

Das Fenster „Peak Review“ enthält die in der
„Results Table“ aufgeführten Peaks. Wenn
einige Proben in der Tabelle ausgeblendet
sind (z. B. bei einer Abfrage), dann werden
sie auch im „Peak Review“ ausgeblendet.

Peak Integration: um den ersten Peak in
einer Charge zu finden

Klicken Sie mit der rechten Maustaste
irgendwo in das Teilfenster „Peak Review“
und klicken Sie dann auf Show First Page.
Um den letzten Peak in einer Charge zu
finden, klicken Sie mit der rechten Maustaste
irgendwo in das Teilfenster „Peak Review“
und klicken Sie dann auf Show Last Page.

Feststellen von Peaks
Die Software stellt Peaks in vier Stufen fest.

1. Sie findet den potenziellen Peak-Start, indem sie den Abstand zwischen jedem
gebündelten Punkt und dem vorherigen untersucht. Wenn der Abstand größer ist als
der aktuelle Rausch-Schwellenwert, ist ein potenzieller Peak-Start gefunden.

2. Sie bestätigt den Peak-Start, indem sie überprüft, dass genügend Punkte in einer Reihe
vorhanden sind, damit der Bereichsschwellenwert überstiegen wird.

3. Sie findet die Peak-Spitze, indem sie einen Punkt sucht, der niedriger ist als der
vorherige Punkt.

4. Sie findet das Ende des Peaks, indem sie den Ort sucht, an dem der Abstand zwischen
einem gebündelten Punkt und dem nächsten unter dem Rausch-Schwellenwert liegt.
Gegebenenfalls separiert sie dann Peaks.

Suchen des potenziellen Peak-Starts
Um den potenziellen Start eines Peaks zu finden, misst die Software die Intensitätsdifferenz
zwischen aufeinander folgenden Paaren gebündelter Punkte, beginnend mit dem ersten
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Punkt. Wenn sie eine Differenz findet, die den aktuellen Rausch-Schwellenwert übersteigt,
erklärt die Software diesen ersten Punkt zum potenziellen Peak-Start.

Abbildung 6-4: Suchen des potenziellen Peak-Starts

Element Beschreibung

1 Übersteigt Rausch-Schwellenwert

2 Potenzieller Peak-Start

3 Übersteigt Rausch-Schwellenwert nicht

Bestätigen des Peak-Starts
Um sicherzustellen, dass sie einen echten Peak gefunden hat, bewegt sich die
Software an der Kurve entlang, wobei sie die Intensitätsdifferenz zwischen jedem
gebündelten Datenpunkt und der Intensität am potenziellen Peak-Start zum Berechnen einer
Gesamtsumme hinzufügt. Dieser Prozess wird angehalten, wenn die Intensitätsdifferenz
zwischen den nachfolgenden Punkten geringer ist als der Rausch-Schwellenwert. Diese
Summe ist der geschätzte Bereich des vorderen Peak-Rands. Wenn diese Summe den
Bereichsschwellenwert übersteigt, bestätigt die Software den Peak-Start.

Dann bestimmt die Software den tatsächlichen Start des Peaks, indem sie vom potenziellen
Peak-Start rückwärts geht, bis sie den niedrigsten Punkt des Peaks findet. Sie geht durch
fünf Rohdaten-Bündel zurück. Dieser Punkt ist der tatsächliche Peak-Start.
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Abbildung 6-5: Bestätigen des Peak-Starts

Element Beschreibung

1 Summe der Bereichsanteile, die den Bereichsschwellenwert übersteigen

Abbildung 6-6: Bestätigen des tatsächlichen Peak-Starts

Element Beschreibung

1 Durchsicht der Datenpunkte in dieser Region

2 Minimaler Datenpunkt

3 Potenzieller Peak-Start
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Suchen der Peak-Spitze
Um die Peak-Spitze zu finden, sucht die Software zunächst einen Punkt, der niedriger ist
als der vorherige Punkt. Um zu bestätigen, dass sie die Spitze tatsächlich gefunden hat,
bildet sie danach die Summe der Intensitätsdifferenzen zwischen der potenziellen Spitze und
den folgenden gebündelten Punkten, bis sie das Ende des Peaks erreicht hat. Wenn der
Gesamtabstand zwischen den Punkten zwei Drittel des Bereichsschwellenwerts übersteigt,
ist die Peak-Spitze bestätigt. Das heißt, die Software vergewissert sich zunächst, dass sie
den Peak gefunden hat, und geht dann zurück, um dessen Spitze zu finden.

Wenn die Software jedoch einen höheren gebündelten Punkt findet, bevor der Bereichstest
bestanden ist, identifiziert sie eine neue Spitze und startet den Bereichstest erneut.

Hinweis: Die tatsächliche Retentionszeit für einen Peak ist nicht einfach der Punkt, der
anhand der zuvor beschriebenen Vorgehensweise identifiziert wird. Stattdessen wird sie
durch eine quadratische Passung anhand der drei höchsten Datenpunkte bestimmt.

Abbildung 6-7: Suchen der Peak-Spitze

Element Beschreibung

1 Die Summe der Bereichsanteile ist größer als zwei Drittel des
Bereichsschwellenwerts.
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Abbildung 6-8: Identifizieren einer neuen Peak-Spitze

Element Beschreibung

1 Die Schulter hat einen Höchstwert, aber der kumulative Kuppenbereich ist
nicht größer als zwei Drittel des Bereichsschwellenwerts.
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Finden des Peak-Endes
Die Software sieht einen Punkt als Peak-Endpunkt an, wenn eine der folgenden Aussagen
zutrifft:

• Die Differenz zwischen zwei aufeinander folgenden Punkten besteht den Rausch-
Schwellenwerttest nicht.

• Die Software erkennt den Start eines neuen Peaks.

In beiden Fällen wird der niedrigste gebündelte Punkt der letzten fünf Bündel als
tatsächlicher Endpunkt des Peaks betrachtet.

Für gewöhnlich findet die Software mehrere Peaks für jedes Chromatogramm. Sie
wählt den Peak aus, dessen Retentionszeit der erwarteten, in der Methode festgelegten
Retentionszeit am nächsten ist. Wenn kein Peak eine Retentionszeit aufweist, die innerhalb
der Spezifikationen liegt, dann markiert die Software den Peak als nicht gefunden.

Abbildung 6-9: Suchen von Peaks

Element Beschreibung

1 Die Schulter hat keinen separaten Höchstpunkt
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Abbildung 6-10: Suchen des Peak-Endes: Fall 1

Element Beschreibung

1 Übersteigt Rausch-Schwellenwert

2 Peak-Ende

3 Übersteigt Rausch-Schwellenwert nicht

Abbildung 6-11: Suchen des Peak-Endes: Fall 2

Element Beschreibung

1 Peak-Ende

Quantitative Datenanalyse

Analyst MD Software
90/124

Handbuch für fortgeschrittene Benutzer
IVD-IDV-05-1320-DE-C



Separate Peaks
Wenn ein neuer Peak beginnt, bevor der aktuelle Peak die Basislinie erreicht, entscheidet
die Software nach den folgenden Kriterien, ob die Basislinie mithilfe von exponentiellen
Abtrennungen aufzulösen ist. Die Abtrennung passiert den Bereich unterhalb eines oder
mehrerer Peaks, die hinter dem Vorläufer liegen. Diese Peaks werden als Produkt-Peaks
bezeichnet.

Wenn die Software eine exponentielle Abtrennung durchführt, subtrahiert sie den Bereich
unterhalb der Abtrennung eines Produkt-Peaks und fügt diesen dem Vorläufer-Peak hinzu.
Sie subtrahiert dann den kleinen Bereich über der Abtrennung vom Vorläufer-Peak und fügt
ihn dem ersten Produkt-Peak hinzu.

Die Software entscheidet anhand der folgenden Kriterien, ob sie die exponentielle
Abtrennung verwendet:

• Exponentielles Peak-Verhältnis

• Exponentiell angepasstes Verhältnis

• Exponentielles Valley-Verhältnis

Abbildung 6-12: Separate Peaks: exponentielle Abtrennung

Element Beschreibung

1 Dieser Bereich wird vom Vorläufer-Peak subtrahiert und dem ersten Produkt-
Peak hinzugefügt.

2 Exponentielle Abtrennung

3 Cluster-Basislinie

4 Diese Bereiche werden von den Produkt-Peaks subtrahiert und den
Vorläufer-Peaks hinzugefügt.
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Abfragen
Eine Abfrage ist ein Verfahren, um nur diejenigen Datensätze auszuwählen, die bestimmte
Kriterien erfüllen. Benutzer können Abfragen verwenden, um bestimmte Teile der Daten in
der Ergebnistabelle, die für sie von Interesse sind, anzusehen. Hierfür wird eine textbasierte
oder mathematische Auswahl getroffen. Eine in einem Projekt abgespeicherte Abfrage ist in
allen Ergebnistabellen dieses Projekts verfügbar.

Wenn eine Abfrage durchgeführt wird, zeigt die Tabelle nur die Datenreihen an, die die
ausgewählten Kriterien erfüllen. Alle Spalten werden angezeigt. Die Auswahl kann weiter
verfeinert werden, indem eine zweite Abfrage für die Reihen durchgeführt wird, die nach der
ersten Abfrage angezeigt werden.

Sie können vordefinierte Auswahlen und manuelle Eingaben verwenden, um eine Abfrage zu
erstellen, die ausgeführt, gespeichert oder verändert werden kann. Jede Zeile der Abfrage
funktioniert wie eine Boole'sche Suche, die für die Spalten der Ergebnistabelle durchgeführt
wird, um festzulegen, welche Datensätze angezeigt werden sollen. Jede Zeile der Abfrage
wählt nur diejenigen Datensätze zum Anzeigen aus, die ihre Kriterien erfüllen. Es kann eine
voreingestellte oder tabellenspezifische Abfrage definiert werden.

Wir empfehlen, dass der Benutzer alle Abfragen validiert, mit denen Daten in einer
Ergebnistabelle analysiert werden.

Abfragen nach Probentyp
Bei einer Abfrage, die ausschließlich zur Auswahl des Standardprobentyps entworfen wurde,
zeigt die Ergebnistabelle nur die Datenreihen an, die „Standard“ in der Spalte „Sample Type“
enthalten.

Standardabfragen und tabellenspezifische Abfragen
Eine Standardabfrage wird im Allgemeinen zur Identifizierung von Proben verwendet, die
gewisse Kriterien nicht erfüllen. Eine tabellenspezifische Abfrage wird im Allgemeinen zur
Identifizierung von Datensätzen verwendet, die gewisse Kriterien erfüllen.

Die Standardabfrage wird im Allgemeinen verwendet, um Probleme bei der Qualitätskontrolle
oder bei Standards zu finden. Wenn eine Konzentration und eine maximale Variation
der Qualitätskontrollen und Standards im Quantitation Method Wizard auswählt werden,
dann zeigt die Ergebnistabelle nur die Proben an, die außerhalb dieses Bereichs liegen.
Wenn die Ergebnistabelle nichts anzeigt, sind alle Proben in Ordnung. Wenn das
Kontrollkästchen „Execute Query as Standard Query“ aktiviert wurde, werden alle Proben
in der Ergebnistabelle angezeigt, jedoch zudem mit den Status „Fail“ oder „Pass“ in der
Spalte „Standard Query Status“, je nachdem, ob die Proben die Abfrage bestanden haben
oder nicht.

Tabellenspezifische Abfragen werden an einer geöffneten Ergebnistabelle durchgeführt,
wobei die Datensätze ausgewählt werden, die bestimmte Kriterien erfüllen. Zum Entwerfen
dieser Abfragen verwenden Sie das Menü, das verfügbar wird, wenn Sie mit der rechten
Maustaste auf die Tabelle klicken. Speichern und exportieren Sie die Abfrage, um sie für
zukünftige Ergebnistabellen verfügbar zu machen.
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Tabellenspezifische oder globale Einstellungen

Bei der Arbeit mit Tabelleneinstellungsoptionen können die Verfahren tabellenspezifisch oder
global sein.

• Table-specific settings: Beim Bearbeiten von Tabelleneinstellungen an der Tabelle
selbst sind die vorgenommenen Einstellungsänderungen ausschließlich für diese Tabelle
verfügbar. Diese können jedoch als globale Einstellungen exportiert werden.

• Global settings: Beim Bearbeiten globaler Einstellungen werden Änderungen an einer
Gruppe von Einstellungen vorgenommen, die auf zukünftige Ergebnistabellen angewandt
werden können. Um eine gerade erstellte Ergebnistabelle individuell anzupassen, wählen
Sie eine Gruppe von Einstellungen auf der Seite „Create Quantitation Set: Select Settings
& Query“. Wenn keine Gruppe von Einstellungen ausgewählt ist, verwendet die Software
automatisch die Voreinstellungen.

Wie Genauigkeitsvariationen die Ergebnisse beeinflussen
Bei voreingestellten Abfragen wird die Genauigkeit als Prozentzahl angegeben und als
+/- diese Zahl implementiert. Beispiel: Wenn die Maximum Variation for standards im
Dialogfeld „Create Default Query“ mit 10 eingeben wird, dann werden alle Datensätze mit
Standards, deren Variation außerhalb von 90 % und 110 % liegen, in der „Results Table“
angezeigt. Wenn 5 eingegeben wird, werden nur die Standards in der „Results Table“
angezeigt, deren Genauigkeit unter 95 % und über 105 % liegt. Siehe Abschnitt: „Results
Tables“.

Regressionsgleichungen
Dieser Abschnitt beschreibt die Gleichungen, die zur Berechnung der Regressionskurven
verwendet werden. In den folgenden Gleichungen stellt x die Analytenkonzentration für
Standardproben und y die entsprechende Peak-Fläche oder -Höhe dar. Die genauen
Variablen für die Regression hängen davon ab, ob der interne Standard verwendet wird
oder ob die Peak-Fläche oder -Höhe wie in der folgenden Tabelle gezeigt verwendet wird.

Tabelle 6-6: Regressionsvariablen

Interner
Standard

verwendet?

Fläche
verwendet?

x y

Ja Ja Ca / Cist / DF  Aa / Aist

Ja No Ca / Cist / DF Ha / Hist

No Ja Ca/ DF  Aa

No No Ca/ DF Ha

wobei Folgendes gilt:

• Ca = Ist-Konzentration des Analyten

• Cist = Konzentration des internen Standards
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• DF = Verdünnungsfaktor

•  Aa = Peak-Fläche des Analyten

•  Aist = Peak-Fläche des internen Standards

• Ha = Peak-Höhe des Analyten

• Hist = Peak-Höhe des internen Standards

Anpassen der Optionen
Die Passung gibt die Art der Regressionsanalyse an, die auf die Daten angewendet
werden soll. Die verschiedenen Passungsoptionen sind „Linear“, „Linear durch Ursprung“,
„Durchschnittlicher Ansprechfaktor“, „Potenz“ und „Quadratisch“.

Linear Regression
Die lineare Regression geht davon aus, dass die Punkte des Standards eine Gerade bilden.

Die lineare Kalibrierungsgleichung lautet:

y = mx + b

Steigung und Achsenabschnitt werden wie folgt berechnet:

wobei Folgendes gilt:

Linear durch den Ursprung
Die lineare Regression durch den Ursprung geht davon aus, dass die Punkte des Standards
eine Gerade bilden und dass die Punkte durch den Nullpunkt auf der x- und y-Achse
verlaufen. Verwenden Sie diese Einstellung, um die Gerade dazu zu zwingen, durch den
Nullpunkt zu verlaufen.

Die Kalibrierungsgleichung für lineare Regression durch den Ursprung lautet:

y = mx

Die Steigung wird wie folgt berechnet:

Mittlerer Reaktionsfaktor
Der mittlere Reaktionsfaktor beträgt:
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y = mx

Dies ist die gleiche Gleichung wie bei der linearen Nullpunktkalibrierung. Die Steigung wird
jedoch anders berechnet:

und die Standardabweichung des Reaktionsfaktors:

wobei Folgendes gilt:

Hinweis: Punkte, deren x-Wert gleich null ist, werden nicht summiert.

Wenn die Linie der Punkte teils linear und teils gekrümmt ist, verwenden Sie anstatt der
linearen oder quadratischen Regression die Potenzregression, um eine Linie irgendwo
zwischen diesen Passungen zu erzeugen.

Potenz
Die Potenzfunktionskalibrierungsgleichung lautet:

y = axp

Die Gleichungen für die lineare Kalibrierung werden wie oben beschrieben für die
Berechnung von Steigung (m) und Achsenabschnitt (b) verwendet. Der Unterschied besteht
jedoch darin, dass x in diesen Gleichungen ersetzt wird durch ln x und y durch ln y. In diesem
Fall werden a und p wie folgt berechnet:

a = eb

p = m

Wenn einer der x- oder y-Werte negativ oder null ist, wird ein Fehler gemeldet.

Quadratisch
Die quadratische Kalibrierungsgleichung lautet:

y = a2x2 + a1x + a0

Die Polynomkoeffizienten werden wie folgt berechnet:

a2 = (b2/b0 - b5/b3) / (b1/b0 - b4/b3)

a1 =b5/b3 - a2b4/b3
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wobei Folgendes gilt:

Gewichtungsfaktoren
Die folgende Tabelle zeigt, wie der Gewichtungsfaktor (w) für jede der sieben
Gewichtungsarten berechnet wird.

Tabelle 6-7: Gewichtungsfaktoren

Weighting Type Gewicht (w)

Keine immer 1,0

1/x Wenn |x| < 10-5, dann w = 105, andernfalls w = 1/|x|.

1/x2 Wenn |x| < 10-5, dann w = 1010, andernfalls w = 1/x2.

1/y Wenn |y| < 10-8, dann w = 108, andernfalls w = 1/|y|.

1/y2 Wenn |y| < 10-8, dann w = 1016, andernfalls w = 1/y2.

ln (x) Wenn x < 0, dann wird ein Fehler generiert. Wenn x < 10–5, dann w = ln
105. Andernfalls w = |ln x)|.

ln (y) Wenn y < 0, dann wird ein Fehler generiert. Wenn y < 10-8, dann w = ln
108. Andernfalls w = |ln y)|.

Berichtsvorlagen
In diesem Abschnitt werden die verschiedenen Elemente der Berichtsvorlagen beschrieben,
die mit dem Report Template Editor im Abschnitt Configure auf der Navigationsleiste in der
Analyst MD Software erstellt werden.

Die folgenden Informationen können zu den Kopf- und Fußzeilen der Dokumente hinzugefügt
werden.

Hinweis: Erstellen Sie eine Sicherungskopie der vorliegenden Berichtsvorlagen, bevor Sie
diese bearbeiten.
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Tabelle 6-8: Grundlegende Entwurfselemente

Element Definition

Printing Date (Druckdatum) Das Datum, an dem das Dokument
gedruckt wurde.

Printing Time (Druckzeit) Die Uhrzeit, zu der das Dokument
gedruckt wurde.

Operator (Bediener) Der Bediener, der das Dokument gedruckt
hat.

Workstation (Workstation) Die Workstation, an der das Dokument
gedruckt wurde.

Page n of N (Seite n von N) Seitennummer der Gesamtseitenzahl.

Custom Field (Benutzerdefiniertes Feld) Erstellen Sie hier einen
benutzerdefinierten Text.

Analyst Version (Analyst-Version) Version der Analyst MD Software.

User Type (Benutzertyp) Benutzertyp (Sicherheit).

Electronic Signature (Elektronische Signatur)Gibt an, ob die Funktion der
elektronischen Signatur (Sicherheit) aktiviert oder
deaktiviert ist.

Tabelle 6-9: Erfassungselemente

Element Definition

Acquisition File Der Name der Datendatei mit den Probenerfassungs-
Informationen.

Acquisition Date Datum der Probenerfassung.

Acquisition Time Uhrzeit der Probenerfassung.

Operator Name des Bedieners, der die Proben-Charge
durchgeführt hat.

Batch Name Name der Charge.

Sample Number Nummer der Probe.

Sample Name Bezeichnung der Probe.

Sample Comment Kommentar zur Probe, die mit dem Acquisition Method
Editor eingegeben wurde.

Sample ID Identifikationsnummer der Probe.

Scan Mode Die Methode, mit der das System die
Massenpunkte für einen Scan für einen vollständigen
Massenbereichs-Scan berechnet.
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Tabelle 6-9: Erfassungselemente (Fortsetzung)

Element Definition

Scan Type and Polarity Scan-Methode der Erfassung (Q1, Q3, MRM,
Produkt-Ion, Vorläufer-Ion, Neutralverlust/Gewinn)
und Polarität der Erfassungsmethode (positiv oder
negativ).

Scan Mass(es) Die zu scannenden Ionen oder Ionenfragmente.

Dwell Time Die Zeit, die das System für den Scan einer
bestimmten Masse benötigt.

Pause Time Pause zwischen dem Scannen von Massenbereichen
oder zwischen Experimenten.

Ion Energy Die Ionenenergie kommt von der Erfassungsmethode
und steht im Zusammenhang mit der Spannung der
IonSpray-Ionenquelle oder der Stoßenergie.

Collision Energy Die Stoßenergie kommt von der Erfassungsmethode
und steht im Zusammenhang mit der Spannung der
IonSpray-Ionenquelle.

Period and Experiment Ein Zeitraum umfasst eine Reihe von Experimenten.
Ein Experiment umfasst eine Vielzahl von
Eigenschaften wie Scan Type, Scan Mode,
Resolution, Ion Source Parameters und eine Reihe
von Massenbereichen oder Massen.

State Table Parameters Die im Experiment verwendeten Massenspektrometer-
Parameter.

Pumpe Name der für das Experiment verwendeten Pumpe.

Autosampler Name des für das Experiment verwendeten
Probengebers.

Custom Annotation Im „Batch Editor“ eingegebener benutzerdefinierter
Text.

Collected By Name der Person, die die Daten erfasst hat.

Tabelle 6-10: Quantifizierungselemente

Element Definition

Results Table Name Name der „Results Table“

Results Table Path Speicherort der „Results Table“

Method Name Name der Quantifizierungsmethode.

Method Path Speicherort der Methoden-Datei.
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Tabelle 6-10: Quantifizierungselemente (Fortsetzung)

Element Definition

Project Name Name des Projekts.

Anpassen von Berichten
Der Report Template Editor bietet die Möglichkeit, Berichte nach Wunsch des Benutzers
mit angepassten Kopfzeilen, Fußzeilen und Seitenlayouts zu erstellen. Verwenden Sie
Berichtsvorlagen sowohl bei Druckausgabe als auch bei Datenexport nach einer anderen
Anwendung.

Die Druckausgabe umfasst verschiedene Elementarten.

• Fenster: Fenster werden im Arbeitsbereich des Softwarefensters, unterhalb der
Werkzeugleiste und rechts von der Navigationsleiste, geöffnet. Beim Drucken eines
Fensters wird der gesamte in diesem Bereich angezeigte Inhalt gedruckt.

• Teilfenster: Teilfenster sind Teile von Fenstern, die so angeordnet sind, dass sie sich
nicht überlappen und jederzeit vollständig sichtbar sind. Das Fenster „Method Editor“
beispielsweise enthält zwei Teilfenster: Das Teilfenster „Browser“ und das Teilfenster
„Method Editor“. Benutzer können Informationen aus jedem im Fenster angezeigten
Teilfenster drucken.

• Bericht: Berichte sind ein strukturierter Satz an Informationen, die in der Software erstellt
werden. Einige Berichte können direkt gedruckt werden, z. B. Kalibrierungsberichte.
Andere Informationen müssen exportiert werden, z. B. Batches und Quantifizierungs-
Ergebnistabellen.

Vorschau, Drucken und Exportieren von Berichten
Erfassungsmethoden, Chargen, Quantifizierungs-„Results Tables“ und Diagramm-„Results
Tables“ können als Berichte exportiert werden. Andere Informationsformen wie
Rechnerdaten können exportiert werden, es besteht jedoch nicht die Möglichkeit, diese mit
einer Berichtsvorlage anzupassen.

Die meisten auf dem Bildschirm angezeigten Bereiche können gedruckt werden. Anhand
der Funktion „Print Preview“ haben Benutzer die Möglichkeit, eine Druckvorschau von
Diagrammen anzuzeigen und Diagramme zu skalieren oder zu kopieren.

Ein exportierter Bericht wird in einem Dateiformat gespeichert, das für Programme wie
Notepad, Microsoft Word, Excel oder für LIMS (Laboratory Information Management
System)-Softwareanwendungen geeignet ist.

Berichte in folgenden Formaten exportieren:

• csv

• doc

• pdf

• txt
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Die verfügbaren Formate hängen von den zu exportierenden Informationen ab. Ein
Diagramm kann zum Beispiel als pdf exportiert werden. Und eine Datentabelle als txt-Datei.

Um zusätzliche Informationen in die Kopf- und Fußzeile des Berichts einzufügen, drucken
Sie den Bericht unter Verwendung einer entsprechenden Berichtsvorlage aus.

Tabelle 6-11: Vorschau, Drucken und Exportieren von Berichten

Ziel Aufgabe

Anzeigen einer
Diagramm-Vorschau

Klicken Sie auf File > Print Preview > Pane.

Drucken eines
Berichts ohne
Vorlage

Klicken Sie auf File > Print und dann auf den zu druckenden
Bericht.

Drucken eines
Berichts mit Vorlage

1. Klicken Sie auf File > Print & Report Setup.

2. Im Abschnitt Report Template wählen Sie die zu verwendende
Vorlage und klicken Sie dann auf OK.

Exportieren eines
Berichts

1. Klicken Sie auf File > Export.

2. Geben Sie im Feld File den Namen der Datei ein.

3. Wählen Sie in der Liste Save as type den Dateityp aus.

4. Wenn Sie einen Bericht im „Quantitate“-Modus exportieren,
wählen Sie entweder All Columns oder Visible Columns im
Abschnitt Export und klicken Sie dann auf Save.

„Results Tables“
Ergebnistabellen fassen die berechnete Konzentration eines Analyten in jeder unbekannten
Probe basierend auf der Kalibrierkurve zusammen. Sie enthalten auch die Kalibrierkurven
und Statistiken zu den Ergebnissen.

Exportieren Sie Daten aus Ergebnistabellen als txt-Datei zur Verwendung in anderen
Anwendungen, z. B. Microsoft Excel. Es können entweder alle möglichen Daten in einer
Tabelle oder nur die Daten in den sichtbaren Spalten exportiert werden.

Hinweis: Wir empfehlen, dass Benutzer nur kontrollierte Methoden, z. B. das Exportieren
von „Results Tables“ und die Berichterstellung, verwenden, um Daten aus der Analyst MD
Software auszugeben. Andere Methoden zur Datenausgabe wie Kopieren aus „Results
Tables“ und Einfügen sind unkontrolliert und dürfen nicht verwendet werden.

Es gibt drei verschiedene Sortierungsmöglichkeiten für Daten in einer Ergebnistabelle:

• Mit einer der Sort-Schaltflächen können Sie eine Tabelle schnell sortieren. Diese
Sortierkriterien können nicht gespeichert werden.

• Erstellen Sie eine tabellenspezifische Sortierung, damit Sie die Sortierkriterien mit der
aktuellen Tabelle speichern können. Mit tabellenspezifischen Sortierungen können 1 bis

Quantitative Datenanalyse

Analyst MD Software
100/124

Handbuch für fortgeschrittene Benutzer
IVD-IDV-05-1320-DE-C



3 Spalten der aktuellen Tabelle sortiert und das Sortierkriterium für die Verwendung mit
dieser Tabelle gespeichert werden.

• Verwenden Sie ein zuvor erstelltes Sortierkriterium. Erstellen und speichern Sie ein
Sortierkriterium, um es später auf eine Ergebnistabelle anzuwenden.

Tipp! Zum Speichern neuer Sortierkriterien oder Tabelleneinstellungen klicken Sie mit der
rechten Maustaste in die Tabelle und klicken Sie dann auf Table Settings > Export To New
Table Settings. Das Sortierkriterium und andere Parameter können im aktuellen Projekt
verwendet werden. Um Tabelleneinstellungen in einem anderen Projekt zu verwenden,
kopieren Sie diese in ein anderes Projekt durch Klicken auf Tools > Project > Copy Data.
Wählen Sie den Source Project Name und den Target Project Name, aktivieren Sie das
Kontrollkästchen für Table Settings unter „Directories“ und klicken Sie dann auf Copy.
Wenn die Table Settings in einem neuen Projekt verwendet werden sollen, dann muss vor
dem Kopieren der Table Settings zunächst das neue Projekt erstellt werden.

Anzeigen eines spezifischen Layouts für „Results Tables“
Die Standardansicht für „Results Tables“ ist das „Full Layout“ oder das „Summary Layout“.
Falls mehrere Analyten pro Probe vorhanden sind, kann jeder Analyt im „Analyte Layout“
angezeigt werden.

Klicken Sie bei geöffneter und aktiver „Results Table“ mit der rechten Maustaste und klicken
Sie dann auf eines der folgenden Felder:

Tabelle 6-12: „Results Table“-Layouts

Feld Beschreibung

Full Klicken Sie darauf, um das „Full Layout“ anzuzeigen.

Summary Klicken Sie auf einen Feldnamen.

Analyte Klicken Sie auf einen einzelnen Analyten, um das „Analyte Layout“
anzuzeigen. Bei der Anzeige der MRM- oder Scheduled MRM-
Algorithmus-Ergebnisse können Benutzer auf Analyte klicken, um eine
Liste der Verbindungs-IDs anzuzeigen.

Analyte Group Klicken Sie auf eine Analyt-Gruppe, um das „Analyte Group Layout“
anzuzeigen.

Tipp! Eine neue Analyten-Gruppe muss zuerst angelegt werden. In
einer „Results Table“ klicken Sie dazu mit der rechten Maustaste und
klicken dann auf Analyte Group > New..

Sample Type Klicken Sie darauf, um einen bestimmten Probentyp anzuzeigen.

Sortieren von Daten in einer Ergebnistabelle
1. Wählen Sie bis zu drei Spalten in der Ergebnistabelle in der Reihenfolge, in der diese

sortiert werden sollen.
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2. Führen Sie einen der folgenden Schritte aus:

• Um in aufsteigender Reihenfolge zu sortieren, klicken Sie auf A-Z.

• Um in absteigender Reihenfolge zu sortieren, klicken Sie auf Z-A.

Sortieren einer Ergebnistabelle und Speichern der
Sortierkriterien
1. Klicken Sie dazu mit der rechten Maustaste in eine Ergebnistabelle und klicken Sie dann

auf Sort > New.

Abbildung 6-13: Dialog „Sort“

2. Geben Sie in das Feld Name den Namen für das neue Sortierkriterium ein.

3. Für jedes Sortierkriterium gehen Sie in den Abschnitten Sort By und Then By wie folgt
vor:

• Wählen Sie in der Liste Group die Spaltenart aus, nach der sortiert werden soll.

• In der Liste Column wählen Sie die Spalte aus, nach der sortiert werden soll.

• Wählen Sie die Sortierrichtung: Ascending oder Descending.

4. Führen Sie einen der folgenden Schritte aus:

• Um die Sortierung durchzuführen, speichern Sie die Sortierkriterien, schließen das
Dialogfeld Sort und klicken auf Save/Execute.

• Um die Sortierung durchzuführen und das Dialogfeld Sort ohne Speichern der
Sortierkriterien zu schließen, klicken Sie auf Execute.
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Speichern von Standard-Sortierkriterien für zukünftige
Ergebnistabellen
1. Klicken Sie auf Tools > Settings > New Quantitation Results Table Settings.

Abbildung 6-14: Dialog „Table Settings“

2. Erweitern Sie den Ordner Table Settings und doppelklicken Sie dann auf den Ordner
Default.

3. Im erweiterten Ordner Default wählen Sie den Ordner Sorts aus.

4. Klicken Sie auf New.
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Abbildung 6-15: Dialog „Sort“

5. Geben Sie einen Namen im Feld Name ein.

6. Führen Sie im Abschnitt „Sort By“ für jedes gewünschte Sortierkriterium Folgendes
durch:

a. In der Liste Group wählen Sie die Spaltenart aus.

b. In der Liste Column wählen Sie die Spalte aus.

c. Wählen Sie die Sortierrichtung: Ascending oder Descending.

7. Um die Sortierung zu speichern, schließen Sie das Dialogfeld „Sort“ und klicken Sie auf
OK.

8. Klicken Sie auf Done.

Sortieren einer Ergebnistabelle mit voreingestellten
Sortierkriterien
Klicken Sie mit der rechten Maustaste in die Ergebnistabelle, klicken Sie auf Sort und
wählen Sie dann den Namen des Sortierkriteriums.

Informationen über die Verwendung von Abfragen bei
Ergebnistabellen
Eine Abfrage ist eine Suche nach Datensätzen in einer Ergebnistabelle, die bestimmte
Bedingungen erfüllen, die mithilfe von textbasierten oder mathematischen Auswahlkriterien
festgelegt werden. Nehmen Sie eine Abfrage entweder während der Erstellung einer
Ergebnistabelle oder nach deren Erstellung vor. Diese beiden Arten von Abfragen
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werden bezeichnet als Standard- und tabellenspezifische Abfragen. Siehe Abschnitt:
Standardabfragen und tabellenspezifische Abfragen.

Wir empfehlen, dass der Benutzer alle Abfragen validiert, mit denen Daten in einer „Results
Table“ analysiert werden.

Vergleichen von Ergebnissen zwischen Chargen
Damit Daten im Fenster „Statistics“ zusammengefasst werden können, müssen die Anzahl
der Analyten und die Analyten-Namen übereinstimmen.

1. Öffnen Sie eine „Results Table“.

2. Klicken Sie auf Tools > Statistics.

3. Führen Sie einen der folgenden Schritte aus:

• Um die Ergebnisse nach der Results Table zu ordnen, wählen Sie Group By Batch
in der Liste Conc. as Rows aus.

• Um die Ergebnisse nach der Konzentration zu ordnen, wählen Sie Group By
Concentration in der Liste Conc. as Rows aus.

• Um die Ergebnisse nach Konzentration zu ordnen, aber ohne die Zeile, in der die
Statistik für jede Gruppe oder jede Charge angezeigt wird, wählen Sie Group By
Concentration (no All) in der Liste Conc. as Rows aus.

Die Software sortiert die Ergebnisse. Am Ende jeder Charge oder Gruppe erscheinen
ein oder zwei zusätzliche Zeilen: All (Statistik für alle „Results Tables“ in dieser Gruppe)
und Average (Statistik über die Statistiken dieser Charge oder Gruppe).

Wie Konzentrationen die Ergebnisse beeinflussen
Die Konzentration wird für alle QCs und Standards definiert. Wenn die Schwankung der
Konzentrationsgenauigkeit den im Feld „Max. Variation“ im Dialog „Create Default Query“
angegebenen Wert übersteigt, dann wird diese Information in der Ergebnistabelle angezeigt.

„Results Table“-Layouts
Die Software verfügt über die folgenden vordefinierte Ansichten für die „Results Table“.

• Ansicht „Full Layout“

• Ansicht „Summary Layout“

• Ansicht „Analyte Layout“

• Ansicht „Analyte Group Layout“

• Probentyp-Layout-Ansicht

Jeder Analyt aus einer Probe mit mehreren Analyten wird in der Ansicht „Analyt Layout“
angezeigt. Die voreingestellte Ansicht ist „Full Layout“.
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Ansicht „Full Layout“
Die voreingestellte Ansicht „Full Layout“ zeigt die Daten für alle Analyten im Quantifizierungs-
Batch. Welche Spalten angezeigt werden, hängt davon ab, welche Spalten im Dialog
„Results Table Columns“ ausgewählt wurden, sowie von den gewählten Einstellungen auf
der zweiten Seite des Quantitation Method Wizard.

Abbildung 6-16: Probenansicht „Full Layout“

Ansicht „Summary Layout“
Die Ansicht „Summary Layout“ enthält die gesperrten Spalten und das für jeden Analyten
gewählte Feld in den verbleibenden Spalten. Beispiel: Wenn „Analyte Peak Area“ für zwei
Analyten im Menü ausgewählt wird, sieht man die Spalten „Sample Name“ und „Analyt Peak
Area“ für diese Analytennamen. Die Ansicht „Summary Layout“ enthält auch die Spalten
„Formula“ und „Custom“, falls diese vorhanden sind.
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Abbildung 6-17: Probenansicht „Summary Layout“

Ansicht „Analyte Layout“
Die Ansicht „Analyte Layout“ enthält die Daten eines bestimmten Analyten. Alle anderen
Analyten sind ausgeblendet. Wenn zum Beispiel Analyt A ausgewählt wurde, werden
alle Daten für Analyt A angezeigt. Welche Spalten angezeigt werden, hängt davon ab,
welche Spalten im Dialogfeld „Results Table Columns“ ausgewählt wurden, sowie von den
gewählten Einstellungen auf der zweiten Seite des Quantitation Method Wizard.

Eine Ansicht „Analyte Layout“, bei der Peak 1 ausgewählt wurde, könnte aussehen wie
die folgende Abbildung. In dieser Ansicht wird jede andere in der Ansicht „Full Layout“
angezeigte Zeile ausgeschlossen.

Abbildung 6-18: Probenansicht „Analyte Layout“
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Ansicht „Analyte Group Layout“
Die Ansicht „Analyte Group Layout“ enthält die Daten der Analyten, die zu einer bestimmten
Gruppe gehören. Die Spalten, die im Dialogfeld „Results Table Columns“ zur Ansicht
ausgewählt werden, werden in der „Results Table“ angezeigt. Siehe die folgende Abbildung.
Zeigen Sie die Spalte Analyte Peak Name in der Results Table an, um die Namen der
Analyten anzuzeigen, die zur Gruppe gehören.

Abbildung 6-19: Probenansicht „Analyte Group Layout“

Probentyp-Layout-Ansicht
Das Probentyp-Layout ermöglicht es dem Benutzer, die „ Results Table“ nach Probentyp zu
filtern.

Abbildung 6-20: Probentyp-Layout-Ansicht
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Felder der Ergebnistabelle
Fügen Sie der Standard-Ergebnistabelle Spalten hinzu, um DAD (Diode Array Detector)-
Daten für die Felder „Analyt“, „Internal Standard“ und „Record“ anzuzeigen.

Formelfelder
In den Feldern „Formula“ wird das Ergebnis einer durch den Benutzer per Tabellenkalkulation
definierten Formel angezeigt. Das im oberen Bereich der Ergebnistabelle befindliche Feld
„Formula“ wird nur dann angezeigt, wenn die Ergebnistabelle mindestens eine Spalte
„Formula“ enthält. Das Feld „Formula“ wird aktiviert, wenn die Zellen in der Spalte „Formula“
ausgewählt werden. Auch die Schaltfläche „Delete Formula Column“ unterhalb des Feldes
„Formula“ wird verfügbar, wenn die Spalte „Formula“ ausgewählt wird.

Wir empfehlen, dass der Benutzer die Ergebnisse validiert, wenn eine Formelspalte
verwendet wird.

Benutzerdefinierte Felder
Benutzerdefinierte Felder enthalten Informationen, die während der Erfassung definiert
werden. Bei der Erfassung von Proben können Benutzer benutzerdefinierte Spalten erstellen
und den dazugehörigen Datentyp definieren. Sobald eine benutzerdefinierte Spalte in die
Ergebnistabelle aufgenommen wurde, kann sie wie jede andere Spalte verwendet werden
(Sie können sie beispielsweise verschieben, ausblenden oder eine auf der Spalte basierende
Formel erstellen).

Felder der Spalte „Internal Standards“
Die Spalten des internen Standards in der „Results Table“ zeigen Informationen über den
internen Standard nach der Analyse an. Die folgende Tabelle zeigt die verfügbaren Felder.

Tabelle 6-13: Spalten „Internal Standards“

Spalten Beschreibung

IS Peak Name Der Name des Peaks des internen Standards.

IS Units Die Einheiten, in denen der interne Standard angegeben wird.

IS Peak Area Die Fläche des Peaks des internen Standards.

IS Peak Height Die Höhe des Peaks des internen Standards.

IS
Concentration

Die bekannte Konzentration des internen Standards. Dies gilt für
Standard- und Qualitätskontrollprobentypen. Für die Probentypen
Lösungsmittel, Leer- und Doppelleerprobe werden Nullen angezeigt. N/A
Für Unbekannte wird angezeigt.

IS Retention
Time

Die von der Software festgelegte chromatographische Retentionszeit.

IS Expected
Retention Time

Die Retentionszeit der repräsentativen Probe. Stammt aus der
Quantifizierungsmethode.
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Tabelle 6-13: Spalten „Internal Standards“ (Fortsetzung)

Spalten Beschreibung

IS Retention
Time Window

Das in der Quantifizierungsmethode angegebene Retentionszeitfenster.

IS Centroid
Location

Die intensitätsgewichtete durchschnittliche Retentionszeit des Analyten.
Die Peakflächen bis zu und nach diesem Zeitpunkt werden identifiziert.

IS Start Scan Die Zyklusnummer der Zeitraum- oder Experimentenkombination, an der
der Peak beginnt.

IS Start Time Der Zeitpunkt der Zeitraum- oder Experimentenkombination, an der der
Peak beginnt.

IS Stop Scan Die Zyklusnummer der Zeitraum- oder Experimentenkombination, an der
der Peak endet.

IS Stop Time Der Zeitpunkt der Zeitraum- oder Experimentenkombination, an der der
Peak endet.

IS Integration
Type

Die Methode, anhand der die Basislinie gefunden und nach der Peak-
Suche integriert wurde. Die Typen sind manuell und automatisch
(Baseline-to-Baseline, Valley, Exponential Skim und Exponential
Child).

IS Signal to
Noise

Das Signal-Rausch-Verhältnis des Peaks.

IS Peak Width Das Verhältnis der Peak-Höhe zu dessen Breite.

IS UV Range Der UV-Bereich des internen Standards.

IS UV Channel Der UV-Kanal des internen Standards.

IS Peak Width
at 50 Percent
(min.)

(Schreibgeschützt) Die Peakbreite bei 50 % der Peakhöhe.

IS Baseline
Slope (%/min.)

(Schreibgeschützt) Die Spalte, in der die Steigung der Basislinie
angezeigt wird.

IS Peak
Asymmetry

(Schreibgeschützt) Die Spalte, in der die mit der folgenden Formel
berechnete Peak-Asymmetrie angezeigt wird:

[(Zeitpunkt Peak-Ende) – (Retentionszeit)] / [(Retentionszeit) – (Zeitpunkt
Peak-Start)]

Werte um 1,0 geben symmetrische Peaks an, Werte über 1,0 geben
„Tailing“-Peaks an und Werte unter 1,0 geben „Fronting“-Peaks an.

IS Processing
Alg

(Schreibgeschützt) Eine Spalte, in der der verwendete
Verarbeitungsalgorithmus angezeigt wird.
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Tabelle 6-13: Spalten „Internal Standards“ (Fortsetzung)

Spalten Beschreibung

IS Integration
Quality

Der Integration Quality Index zeigt an, wie gut der Peak integriert wurde.
Werte näher an 1 weisen auf gut integrierte Peaks hin und Werte näher
an 0 weisen auf schlecht integrierte Peaks hin.

Datensatzfelder
Die Record-Spalten in der „Results Table“ enthalten zusätzliche Informationen über jeden
Probendatensatz (Informationen, die ausschließlich für den Analyten gelten, nicht für den
internen Standard). Die folgende Tabelle zeigt die verfügbaren Felder.

Tabelle 6-14: Record-Spalten

Spalten Beschreibung

Use Record Gibt an, ob dieser Datensatz für die Kalibrierung verwendet werden
sollte. Gilt für Standards und QCs. Wenn das Kontrollkästchen
deaktiviert wurde, werden die nicht verwendeten Standards und QCs in
der Statistiktabelle ausgestrichen.

Record
Modified

Gibt an, ob die für den Datensatz verwendete Quantifizierungsmethode
verändert wurde und in irgendeiner Weise von der ursprünglichen Form
abweicht.

Calculated
Concentration

Die berechnete Konzentration des Analyten, gemäß Berechnung mit der
Kalibrierkurve.

Relative
Retention Time

Das Verhältnis der Retentionszeiten von internem Standard und
Analyten.

Accuracy Die berechnete Konzentration geteilt durch die bekannte Konzentration
(in Prozent).

Response
Factor

Peak-Fläche oder -Höhe (in Abhängigkeit von der Regressionsoption)
geteilt durch die Analyt-Konzentration.

Analyt-Spalten
Die Analyt-Spalten in der Results Table enthalten Informationen über jeden Analyten und
internen Standard (falls einer verwendet wurde) nach der Analyse. Die folgende Tabelle zeigt
die verfügbaren Felder.

Tabelle 6-15: Results Tables: Analyt-Spalten

Spalte Beschreibung

Analyte Peak
Name

Der Name des Analyten.

Analyte Units Die Einheiten, in denen die Analyt-Konzentrationen angegeben werden.
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Tabelle 6-15: Results Tables: Analyt-Spalten (Fortsetzung)

Spalte Beschreibung

Analyte Peak
Area

Die Fläche des Analyten.

Analyte Peak
Height

Die Höhe des Analyt-Peaks.

Analyte
Concentration

Die tatsächliche, bekannte Konzentration des Analyten. Dies gilt
für Standard- und Qualitätskontrollprobentypen. Für die Probentypen
Lösungsmittel, Leer- und Doppelleerprobe werden Nullen angezeigt. Für
Unbekannte wird N/A angezeigt.

Analyte
Retention Time

Die von der Software festgelegte chromatographische Retentionszeit.

Analyte
Expected
Retention Time

Die Retentionszeit der repräsentativen Probe gemäß
Quantifizierungsmethode.

Analyte
Retention Time
Window

Das in der Quantifizierungsmethode angegebene Retentionszeitfenster.

Analyte
Centroid
Location

Die intensitätsgewichtete durchschnittliche Retentionszeit des Analyten.
Die Peakflächen bis zu und nach diesem Zeitpunkt werden identifiziert.

Analyte Start
Scan

Die Zyklusnummer der Zeitraum- oder Experimentenkombination, an der
der Peak beginnt.

Analyte Start
Time

Der Zeitpunkt der Zeitraum- oder Experimentenkombination, an der der
Peak beginnt.

Analyte Stop
Scan

Die Zyklusnummer der Zeitraum- oder Experimentenkombination, an der
der Peak endet.

Analyte Stop
Time

Der Zeitpunkt der Zeitraum- oder Experimentenkombination, an der der
Peak endet.

Analyte
Integration
Type

Die Methode, anhand der die Basislinie gefunden und nach der Peak-
Suche integriert wurde. Die Typen sind manuell und automatisch
(„Baseline-to-Baseline“, „Valley“, „Exponential Skim“ und „Exponential
Child“).

Analyte Signal
to Noise

Das Signal-Rausch-Verhältnis des Peaks im Vergleich zur Basislinie.

Analyte Peak
Width

Das Verhältnis der Peak-Höhe zu dessen Breite.

Analyte UV
Range

Der UV-Bereich des Analyten.
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Tabelle 6-15: Results Tables: Analyt-Spalten (Fortsetzung)

Spalte Beschreibung

Analyte UV
Channel

Der UV-Kanal des Analyten.

Analyte Peak
Width at 50
Percent (min.)

(Schreibgeschützt) Die Spalte, in der die Peakbreite bei 50 % der
Peakhöhe angezeigt wird.

Analyte
Baseline Slope
(%/min.)

(Schreibgeschützt) Die Spalte, in der die Steigung der Basislinie
angezeigt wird.

Analyte Peak
Asymmetry

(Schreibgeschützt) Die Spalte, in der die mit der folgenden Formel
berechnete Peak-Asymmetrie angezeigt wird:

[(Zeitpunkt Peak-Ende) – (Retentionszeit)] / [(Retentionszeit) – (Zeitpunkt
Peak-Start)]

Werte um 1,0 geben symmetrische Peaks an, Werte über 1,0 geben
„Tailing“-Peaks an und Werte unter 1,0 geben „Fronting“-Peaks an.

Analyte
Processing Alg

Eine schreibgeschützte Spalte, in der der Verarbeitungs-Algorithmus
angezeigt wird.

Analyte
Integration
Quality

Der Integration Quality Index zeigt an, wie gut der Peak integriert
wurde. Werte näher an 1 weisen auf gut integrierte Peaks hin und
Werte näher an 0 weisen auf schlecht integrierte Peaks hin. Dies
erleichtert die Peak-Bewertung, weil Benutzer die Peaks mit niedrigen
Analyt-Integrationsqualitätswerten anzeigen können, um sie manuell zu
überprüfen. Darüber hinaus können Benutzer diese Daten nach Analyt-
Integrationsqualitätswerten durchsuchen, die unter den als akzeptabel
geltenden Werten liegen, um diese anzuzeigen und dann manuell eine
Teilmenge der Daten zu überprüfen.

Proben-Spalten
Die Proben-Spalten in der „Results Table“ zeigen Informationen über die Probe, die für alle
Analyten gelten. Leerprobe und doppelte Leerprobe können in den einzelnen Laboratorien
unterschiedlich definiert werden. Die folgenden Tabellen zeigen die verfügbaren Felder.

Tabelle 6-16: Proben-Spalten

Spalte Beschreibung

Sample Name Der Name, den der Benutzer der Probe zum Zeitpunkt der Erfassung
zugewiesen hat.

Sample ID Eine benutzerdefinierte Kennung der Probe.
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Tabelle 6-16: Proben-Spalten (Fortsetzung)

Spalte Beschreibung

Sample Type Der Probentyp aller Analyten innerhalb einer Probe muss gleich sein.
Einer der folgenden Probentypen wird angezeigt:

Unknown: Enthält Analyten, deren Konzentrationen noch bestimmt
werden müssen.

Standard: Eine Probe, deren Analyt-Konzentration bekannt ist. Wird zu
Kalibrierungszwecken verwendet.

Quality Control: Eine Probe, deren Analyt-Konzentration bekannt ist.
Wird verwendet, um die Genauigkeit der Standardkurve zu überprüfen.

Solvent: Bestätigt, dass das Massenspektrometer sauber ist.
Lösungsmittel laufen während der Probenvorbereitung nicht durch.

Blank: Eine Probe, deren Konzentration null beträgt und die nicht in der
Regression verwendet wird.

Double Blank: Eine Probe, die ohne internen Standard oder
Probenanalyten vorbereitet wird. Bestätigt, dass bei der Extraktion nichts
hinzugefügt wurde.

Sample
Comment

Ein Kommentar, der die Probe beschreibt.

Set Number Eine Nummer, die eine Teilmenge einer gesamten Charge identifiziert.

Acquisition
Method

Die Bezeichnung der für die Probenerfassung verwendeten Methode.

Acquisition
Date

Datum und Uhrzeit, zu der die Erfassung durchgeführt wurde.

Rack Type Eine Kennung, mit der die Art des verwendeten Autosampler-Racks (falls
verwendet) angegeben wird.

Rack Number Die Rack-Position, in der die Probe bei der Erfassung platziert wurde.
(Für Probengeber mit einem Rack beträgt diese Zahl immer 1.)

Vial Position Die Position in der Autosampler-Platte, in die das Fläschchen platziert
wurde.

Plate Type Eine Kennung, mit der die Art der verwendeten Platte (gilt nur für Racks
mit mehreren Platten) angegeben wird.

Plate Number Die Position der Platte im Rack (gilt nur für Racks mit mehreren Platten).

File Name Der Name der Rohdatendatei. Der Name ist nicht eindeutig, da in einer
Datendatei die Daten von vielen Proben enthalten sein können.

Dilution Factor Die Menge, mit der die Probe verdünnt wurde. Wird zur Ermittlung der
berechneten Konzentration verwendet.
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Tabelle 6-16: Proben-Spalten (Fortsetzung)

Spalte Beschreibung

Sample
Annotation

Zusätzliche Kommentare, mit denen die Probe beschrieben wird.

Weight-to-
Volume Ratio

Das Verhältnis von Gewicht zu Volumen für die Probe.

Tabelle 6-17: DAD-Spalten

Spalte Beschreibung

Analyte Peak
Area for DAD

Die Fläche des Analyt-Peaks (mAU/min).

Analyte Peak
Height for DAD

Die Höhe des Analyt-Peaks (mAu).

Analyte
Wavelength
Ranges

Der Bereich der Wellenlängen (nm).

IS Peak Area
for DAD

Die Fläche des Peaks des internen Standards (mAu/min).

IS Wavelength
Ranges

Der Bereich der Wellenlängen (nm).

IS Peak Height
for DAD

Die Höhe des Peaks des internen Standards (mAu). Berechnete
Konzentration für DAD.

Die folgende Tabelle zeigt die Felder, die der „Results Table“ für Daten hinzugefügt werden
können, die mit einem ADC (Analog-Digital-Umwandler) erfasst wurden.

Tabelle 6-18: ADC-Spalten

Spalte Beschreibung

Analyte
Channel

Der ADC-Kanal, von dem der Analyt erfasst wurde.

Analyte
Wavelength
Ranges

Der Bereich der Wellenlängen (nm).

IS Channel Der ADC-Kanal, von dem der interne Standard erfasst wurde.

IS Wavelength
Ranges

Der Bereich der Wellenlängen (nm).
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Tipps zu Ergebnistabellen
Aufgabe ... gehen Sie wie folgt vor

Tabellenspezifi-
sche Abfragen:
um die gesamte
Tabelle erneut
anzuzeigen

Klicken Sie mit der rechten Maustaste irgendwo in die „Results Table“
und klicken Sie dann auf Query > Show All. Die Abfrage kann entweder
erneut gestellt oder bearbeitet werden.

Um
Kalibrierkurven
zu untersuchen

Klicken Sie mit der rechten Maustaste irgendwo in die Kurve, klicken
Sie auf Active Plot und wählen Sie die Kurve aus, die im Vordergrund
gezeichnet werden soll.

Bewertung von
Probenstatisti-
ken: um einen
einzelnen Peak
zu prüfen

Aktivieren Sie das Kontrollkästchen Display the Data Set(s) und
doppelklicken dann in der Spalte Data Point auf den Datenpunkt, der
dem Peak entspricht. Die Software zeigt das Fenster „Peak Review“ mit
dem vom Benutzer ausgewählten Peak an.

„Results Tables“:
um die „Results
Table“ wieder in
ihre
ursprüngliche
Reihenfolge
zurückzuführen

Klicken Sie mit der rechten Maustaste in eine „Results Table“ und klicken
Sie dann auf Sort > Sort By Index.
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Symbole der Werkzeugleisten A
Symbol Name Funktion

Hintergrundsubstraktion Führt eine Hintergrundsubtraktion
aus, nachdem die
Hintergrundbereiche ausgewählt
wurden.

Hintergrundbereich gesperrt Sperrt die ausgewählten
Hintergrundbereiche. Wenn die
Hintergrundbereiche nicht gesperrt
sind, können Benutzer jeden
Bereich einzeln verschieben.

Strichspektrum Berechnet das Strichspektrum der
Daten.

Ursprüngliches Diagramm Setzt das Diagramm wieder auf
den ursprünglichen Maßstab.

Überlagerung Überlagert Diagramme.

Zwischen Überlagerungen
wechseln

Wechselt zwischen überlagerten
Diagrammen.

Überlagerungen addieren Fügt die Diagramme zusammen.

Fragment Interpretation Tool
anzeigen

Öffnet das Fragment
Interpretation Tool, das
die einzelnen, nicht-zyklischen
Bindungsspaltungsfragmente aus
einer .mol-Datei berechnet.

Glättung Glättet Daten mit dem
Glättungsalgorithmus.

Gauß'sche Glättung Glättet Daten mit der Gauß'schen
Glättung.
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Tabelle der exakten PPG-Massen B
Die folgende Tabelle führt die exakten monoisotopischen Massen und geladenen Spezies (positiv und negativ) auf, die bei den PPG
(Polypropylenglykol)-Kalibrierungslösungen beobachtet wurden. Die Massen und Ionen wurden mit der Formel M = H[OC3H6]nOH, berechnet,
während für die MS/MS-Fragmente der positiven Ionen die Formel [OC3H6]n(H+) verwendet wurde. In allen Berechnungen war H = 1,007825,
O = 15,99491, C = 12,00000 und N = 14,00307.

Hinweis: Achten Sie darauf, dass bei der Kalibrierung mit den PPG-Lösungen der richtige Isotopen-Peak verwendet wird.

Tabelle B-1: Exakte PPG-Massen

n Exakte Masse (M) (M + NH4)+ MS/MS-Fragmente (M + 2NH4)2+ (M + COOH)–

1 76,052 94,087 59,0 56,061 121,050

2 134,094 152,129 117,1 85,082 179,092

3 192,136 210,171 175,1 114,102 237,134

4 250,178 268,212 233,2 143,123 295,176

5 308,220 326,254 291,2 172,144 353,218

6 366,262 384,296 349,2 201,165 411,259

7 424,304 442,338 407,3 230,186 469,301

8 482,346 500,380 465,3 259,207 527,343

9 540,388 558,422 523,4 288,228 585,385

10 598,430 616,464 581,4 317,249 643,427
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Tabelle B-1: Exakte PPG-Massen (Fortsetzung)

n Exakte Masse (M) (M + NH4)+ MS/MS-Fragmente (M + 2NH4)2+ (M + COOH)–

11 656,471 674,506 639,4 346,270 701,469

12 714,513 732,548 697,5 375,291 759,511

13 772,555 790,590 755,5 404,312 817,552

14 830,597 848,631 813,6 433,333 875,594

15 888,639 906,673 871,6 462,354 933,636

16 946,681 964,715 929,7 491,373 991,678

17 1004,723 1022,757 987,7 520,396 1049,720

18 1062,765 1080,799 1045,7 549,417 1107,762

19 1120,807 1138,841 1103,8 578,438 1165,804

20 1178,849 1196,883 1161,8 607,459 1223,845

21 1236,890 1254,925 1219,9 636,480 1281,887

22 1294,932 1312,967 1277,9 665,501 1339,929

23 1352,974 1371,009 1335,9 694,521 1397,971

24 1411,016 1429,050 1394,0 723,542 1456,013

25 1469,058 1487,092 1452,0 752,563 1514,055

26 1527,100 1545,134 1510,1 781,584 1572,097

27 1585,142 1603,176 1568,1 810,605 1630,138
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Tabelle B-1: Exakte PPG-Massen (Fortsetzung)

n Exakte Masse (M) (M + NH4)+ MS/MS-Fragmente (M + 2NH4)2+ (M + COOH)–

28 1643,184 1661,218 1626,2 839,626 1688,180

29 1701,226 1719,260 1684,2 868,647 1746,222

30 1759,268 1777,302 1742,2 897,668 1804,264

31 1817,309 1835,344 1800,3 926,689 1862,306

32 1875,351 1893,386 1858,3 955,710 1920,348

33 1933,393 1951,428 1916,4 984,731 1978,390

34 1991,435 2009,469 1974,4 1013,752 2036,431

35 2049,477 2067,511 2032,5 1042,773 2094,473

36 2107,519 2125,553 2090,5 1071,794 2152,515

37 2165,561 2183,595 2148,5 1100,815 2210,557

38 2223,603 2241,637 2206,6 1129,836 2268,599

39 2281,645 2299,679 2264,6 1158,857 2326,641

40 2339,687 2357,721 2322,7 1187,878 2384,683

41 2397,728 2415,783 2380,7 1216,899 2442,724

42 2455,770 2473,805 2438,7 1245,920 2500,766

43 2513,812 2531,847 2496,8 1274,940 2558,808

44 2571,854 2589,888 2554,8 1303,961 2616,850
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Tabelle B-1: Exakte PPG-Massen (Fortsetzung)

n Exakte Masse (M) (M + NH4)+ MS/MS-Fragmente (M + 2NH4)2+ (M + COOH)–

45 2629,896 2647,930 2612,9 1332,982 2674,892

46 2687,938 2705,972 2670,9 1362,003 2732,934

47 2745,980 2764,014 2729,0 1391,024 2790,976

48 2804,022 2822,056 2787,0 1420,045 2849,017

49 2862,064 2880,098 2845,0 1449,066 2907,059

50 2920,106 2938,140 2903,1 1478,087 2965,101

51 2978,147 2996,182 2961,1 1507,108 3023,143

52 3036,189 3054,224 3019,2 1536,129 3081,185

53 3094,231 3112,266 3077,2 1565,150 3139,227

54 3152,273 3170,307 3135,2 1594,171 3197,269

55 3210,315 3228,349 3193,3 1623,192 3255,311

56 3268,357 3286,391 3251,3 1652,213 3313,352

57 3326,399 3344,433 3309,4 1681,234 3371,394

58 3384,441 3402,475 3367,4 1710,255 3429,436

59 3442,483 3460,517 3425,5 1739,276 3487,478

60 3500,525 3518,559 3483,5 1768,297 3545,5202

61 3558,566 3576,601 3541,5 1797,318 3603,562
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Tabelle B-1: Exakte PPG-Massen (Fortsetzung)

n Exakte Masse (M) (M + NH4)+ MS/MS-Fragmente (M + 2NH4)2+ (M + COOH)–

62 3616,608 3634,643 3599,6 1826,339 3661,604

63 3674,650 3692,685 3657,6 1855,359 3719,645

64 3732,692 3750,726 3715,7 1884,380 3777,687

65 3790,734 3808,768 3773,7 1913,401 3835,729

66 3848,776 3866,810 3831,7 1942,422 3893,771

67 3906,818 3924,852 3889,8 1971,443 3951,813

68 3964,860 3982,894 3947,8 2000,464 4009,855

69 4022,902 4040,936 4005,9 2029,485 4067,897

70 4080,944 4098,978 4063,9 2058,506 4125,938

71 4138,985 4157,020 4122,0 2087,527 4183,980

72 4197,027 4215,062 4180,0 2116,548 4242,022

73 4255,069 4273,104 4238,0 2145,569 4300,064

74 4313,111 4331,145 4296,1 2174,590 4358,106

75 4371,153 4389,187 4354,1 2203,611 4416,148

76 4429,195 4447,229 4412,2 2232,632 4474,190

77 4487,237 4505,271 4470,2 2261,653 4532,231

78 4545,279 4563,313 4528,3 2290,674 4590,273
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Tabelle B-1: Exakte PPG-Massen (Fortsetzung)

n Exakte Masse (M) (M + NH4)+ MS/MS-Fragmente (M + 2NH4)2+ (M + COOH)–

79 4603,321 4621,355 4586,3 2319,695 4648,315

80 4661,363 4679,397 4644,3 2348,716 4706,357

81 4719,404 4737,439 4702,4 2377,737 4764,399

82 4777,446 4795,481 4760,4 2406,758 4822,441
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Kontaktangaben

Kundenschulung
• In Nordamerika: NA.CustomerTraining@sciex.com

• In Europa: Europe.CustomerTraining@sciex.com

• Die Kontaktinformationen für Länder außerhalb der EU und Nordamerikas finden Sie
unter sciex.com/education.

Online-Lernzentrum
• SCIEX Now Learning Hub

SCIEX Support
SCIEX und seine Vertretungen beschäftigen weltweit einen Stab an ausgebildeten
Servicekräften und technischen Spezialisten. Der Support kann Fragen zum System oder
anderen auftretenden, technischen Problemen beantworten. Weitere Informationen finden
Sie auf der SCIEX-Website unter sciex.com, oder kontaktieren Sie uns unter:

• sciex.com/contact-us

• sciex.com/request-support

Cybersicherheit
Die aktuellsten Hinweise zur Cybersicherheit von SCIEX-Produkten finden Sie unter
sciex.com/productsecurity.

Dokumentation
Diese Version des Dokuments ersetzt alle vorherigen Versionen.

Für die Anzeige des Dokuments wird der Adobe Acrobat Reader benötigt. Um sich die
neueste Version herunterzuladen, besuchen Sie https://get.adobe.com/reader.

Softwareproduktdokumentationen entnehmen Sie den Versionshinweisen oder dem mit der
Software mitgelieferten Software-Installationshandbuch.

Informationen zur Hardware-Produktdokumentation finden Sie auf der mit dem System oder
der Komponente gelieferten Customer Reference-DVD.

Hinweis: Wenn Sie eine kostenlose gedruckte Ausgabe dieses Dokuments wünschen,
wenden Sie sich bitte an sciex.com/contact-us.
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